
adaptsupport@risa.com   www.risa.com 
RISA, Tech., 26632 Towne Centre Dr. Ste210, Foothill Ranch, California, USA 

Tel: +1 (949) 951-5815, Toll Free: +1 (800) 332-RISA 

 
STRUCTURAL CONCRETE SOFTWARE SYSTEM 

 

 

 

 

 

 

 

ADAPT-PT/RC 20 
USER MANUAL 

 

 

 

 

 

  

 

 

Copyright© 2020

http://www.risa.com/




   

  i 

 

LIST OF CONTENTS 

1 Overview .................................................................................................................................... 5 

2 Sign Convention ....................................................................................................................... 11 

3 Workspace Overview ............................................................................................................... 13 

3.1 The Main Program Window ........................................................................................... 14 

3.2 Main Program Window Menu Items and Corresponding Tools .................................... 15 

3.2.1 File Menu .......................................................................................................................... 15 

3.2.2 Action Menu ..................................................................................................................... 16 

3.2.3 View Menu ....................................................................................................................... 16 

3.2.4 Options Menu ................................................................................................................... 16 

3.2.5 Window Menu .................................................................................................................. 17 

3.2.6 Help Menu ........................................................................................................................ 17 

3.3 ADAPT-PT/RC Input screen ............................................................................................ 18 

3.4 ADAPT PT/RC-Input Menu Items and Tools ................................................................... 20 

3.4.1 File Menu .......................................................................................................................... 20 

3.4.2 Project Menu .................................................................................................................... 20 

3.4.3 Geometry Menu ............................................................................................................... 20 

3.4.4 Loads Menu ...................................................................................................................... 20 

3.4.5 Material Menu .................................................................................................................. 20 

3.4.6 Criteria Menu ................................................................................................................... 21 

3.4.7 Execute Menu ................................................................................................................... 21 

3.4.8 Tools Menu ....................................................................................................................... 21 

3.4.9 Window Menu .................................................................................................................. 21 

3.4.10 Structure View Menu ....................................................................................................... 22 

3.4.11 View Tools Toolbar ........................................................................................................... 22 

4 Basic Program Operations ....................................................................................................... 25 

4.1 Start a New project ........................................................................................................ 25 

4.2 Open an Existing Project ................................................................................................ 25 

4.3 Save Input Data .............................................................................................................. 25 

4.4 Save Input Data as Default ............................................................................................. 26 

4.5 Select System of Units ................................................................................................... 26 

4.6 Convert System of Units ................................................................................................ 27 



 

ii 

4.7 Program mode ............................................................................................................... 27 

5 Structural Modeling Overview ................................................................................................ 29 

5.1 Project Information ....................................................................................................... 29 

5.1.1 Specify General Project Information ................................................................................ 29 

5.1.2 Specify Analysis and Design Options ................................................................................ 30 

5.2 Geometry ....................................................................................................................... 34 

5.2.1 Specify Span Geometry .................................................................................................... 34 

5.2.1.1 Prismatic (Uniform) Spans ................................................................................. 35 

5.2.1.2 Non-prismatic (non-uniform) spans ................................................................... 39 

5.2.2 Specify Effective Flange Width ......................................................................................... 42 

5.2.3 Specify Geometry of Drop Cap and/or Transverse Beam ................................................ 43 

5.2.4 Specify Geometry of a Drop Panel ................................................................................... 44 

5.2.5 Specify Support Geometry and Stiffness .......................................................................... 44 

5.2.6 Specify Support Boundary Conditions .............................................................................. 46 

5.3 Loads .............................................................................................................................. 47 

5.3.1 Specify Dead, Live and Other loads .................................................................................. 47 

5.3.2 Specify Lateral Loads ........................................................................................................ 51 

5.4 Material ......................................................................................................................... 52 

5.4.1 Specify Concrete Material ................................................................................................ 52 

5.4.2 Specify Reinforcement Material ....................................................................................... 52 

5.4.2.1 Critical Section Outside the Reinforced Zone .................................................... 55 

5.4.2.2 Minimum Reinforcement for Drift ..................................................................... 57 

5.4.3 Specify Post-Tensioning Material (PT mode only) ............................................................ 58 

5.5 Criteria ........................................................................................................................... 59 

5.5.1 Specify the Design Code ................................................................................................... 59 

5.5.2 Specify Base Non-Prestressed Reinforcement ................................................................. 60 

5.5.3 Specify Allowable Stresses (PT mode only) ...................................................................... 62 

5.5.3.1 PT Crack Design Mode/Allowable Crack Width ................................................. 63 

5.5.4 Specify Recommended Post-Tensioning Values (PT mode only) ..................................... 65 

5.5.5 Specify Calculation Options (PT mode only) .................................................................... 65 

5.5.6 Specify Tendon Profile (PT mode only) ............................................................................ 66 

5.5.7 Specify Minimum Covers .................................................................................................. 67 

5.5.8 Specify Minimum Bar Length ........................................................................................... 68 

5.5.9 Specify Reinforcement Curtailment ................................................................................. 69 

5.5.10 Specify Load Combinations .............................................................................................. 72 

6 Program execution Overview .................................................................................................. 75 



   

  iii 

6.1 PT Recycling Window Tabs ............................................................................................ 76 

6.2 Design Indicator Box ...................................................................................................... 82 

6.3 Recycle Window Control Buttons .................................................................................. 84 

6.4 PT Selection Method ...................................................................................................... 86 

6.4.1 Force Selection Method ................................................................................................... 87 

6.4.2 Tendon Selection Method ................................................................................................ 87 

6.4.2.1 Description of Features ...................................................................................... 88 

6.4.2.2 Description of Execution .................................................................................... 90 

7 View/Validate Results .............................................................................................................. 93 

7.1 ADAPT-BuilderSum Screen ............................................................................................ 93 

7.2 ADAPT-BuilderSum Menu Items and Corresponding Tools ........................................... 94 

7.2.1 File Menu .......................................................................................................................... 94 

7.2.2 Graphs Menu .................................................................................................................... 95 

7.2.3 Options Menu ................................................................................................................... 97 

7.2.4 Window Menu .................................................................................................................. 98 

7.2.5 Help Menu ........................................................................................................................ 98 

7.3 PT Summary Report ....................................................................................................... 98 

7.3.1 Span Selection Toolbar ..................................................................................................... 99 

7.4 Export to DXF File ......................................................................................................... 107 

8 Reports Overview .................................................................................................................. 109 

8.1 Report Generator Screen ............................................................................................. 109 

8.2 How to Create A Report ............................................................................................... 111 

8.3 Description of Report Sections .................................................................................... 112 

8.3.1 Report Cover Page .......................................................................................................... 112 

8.3.2 Table of Contents ........................................................................................................... 113 

8.3.3 Concise Report ............................................................................................................... 116 

8.3.4 Compact Report.............................................................................................................. 124 

8.3.4.1 Section 1- User Specified General Analysis and Design Parameters ................ 124 

8.3.4.2 Section 2: Input Geometry ............................................................................... 126 

8.3.4.3 Section 3: Input Applied Loading ..................................................................... 131 

8.3.4.4 Section 4: Calculated Section Properties ......................................................... 134 

8.3.4.5 Section 5: Moments, Shears and Reactions ..................................................... 135 

8.3.4.6 Section 6: Moments Reduced to Face of Support ............................................ 138 

8.3.4.7 Section 7: Selected Post-tensioning Forces and Tendon Profiles                          

(PT mode only) ................................................................................................. 139 

8.3.4.8 Section 8: Factored Moments and Reactions Envelope ................................... 144 



 

iv 

8.3.4.9 Section 9: Factored Lateral Moments Envelope .............................................. 146 

8.3.4.10 Section10: Mild Steel - No Redistribution ........................................................ 147 

8.3.4.11 Section11: Mild Steel –Redistributed ............................................................... 149 

8.3.4.12 Section 12: Shear Reinforcement..................................................................... 149 

8.3.4.13 Section 13: Punching Shear Reinforcement ..................................................... 151 

8.3.4.14 Section 14: Deflections .................................................................................... 153 

8.3.4.15 Section15: Friction, Elongation and Long-Term Stresses                                        

(PT mode only) ................................................................................................. 156 

8.3.5 Detailed Report .............................................................................................................. 162 

8.3.5.1 Section 21: Tendon Heights (PT mode only) .................................................... 162 

8.3.5.2 Section 22: Post-tensioning Balanced Loading (PT mode only) ....................... 162 

8.3.5.3 Section 23: Detailed Moments ......................................................................... 163 

8.3.5.4 Section 24: Detailed Shears ............................................................................. 164 

8.3.5.5 Section 25: Factored Moments and Reactions ................................................ 164 

8.3.5.6 Section 26: Factored Lateral Moments ............................................................ 165 

8.3.5.7 Section 27: Detailed Stresses (PT mode only) .................................................. 166 

8.3.5.8 Section 28: Required Post-tensioning (PT mode only) ..................................... 167 

8.3.5.9 Section 29: Detailed Rebar ............................................................................... 167 

8.3.5.10 Section 30: Punching Shear Reinforcement ..................................................... 168 

8.3.5.11 Section 32: Detailed Friction and Long-Term Stress Losses                                   

(PT mode only) ................................................................................................. 169 

8.3.5.12 Section 32: Unbalanced Moment Reinforcement ........................................... 169 

8.3.5.13 Section 34: Demand Moment and Moment Capacity ..................................... 170 

8.3.5.14 Section 35: Detailed Deflections ...................................................................... 171 

8.3.5.15 Section 36: Detailed Deflections Live Load ...................................................... 171 

8.3.6 Graphical Report ............................................................................................................ 173 

8.3.6.1 PT Force............................................................................................................ 173 

8.3.6.2 PT-Profile .......................................................................................................... 173 

8.3.6.3 Deflection ......................................................................................................... 174 

8.3.6.4 Load Cases ........................................................................................................ 174 

8.3.6.5 Load Combination ............................................................................................ 175 

 



   

  5  

1 Overview 

ADAPT-PT/RC is the state-of-the-art industry standard computer program for the 

analysis and design of one-way or two-way conventional reinforced and post-tensioned 

floor systems and beams. It is based on a single-story frame analysis with upper and 

lower columns. For two-way floor systems, the equivalent frame modeling of ACI can be 

used as an option. ADAPT-PT/RC is a Windows-based program. ADAPT-PT/RC treats 

multi-span continuous slab/plate and beam frames with or without cantilevers. 

ADAPT-PT/RC can be launched in a PT mode or RC mode for an applicable design.  Saved 

files are interchangeable and can be opened in either mode once they are created.  This 

dual functionality allows the user to easily navigate between reinforced concrete and 

post-tensioned design and determine the most suitable and economical design. 

• In addition to drop caps, ADAPT-PT/RC allows drop panels of different sizes to 

be specified for different supports. Having a general frame analysis module for 

variable sections, ADAPT-PT/RC can accurately model a wide range of drop 

cap/panel geometries. Also, special modeling features implemented in the 

program facilitate the modeling of local thickening in the slab along the line of 

columns, generally referred to as slab bands.  

• The slab/beam frame may be supported by walls, beams, or columns with 

different connection details such as clamped, rotational, free, and more. 

• ADAPT-PT/RC fully incorporates the equivalent frame option as described in ACI-

318 with no simplifications. In addition to the capability to handle the 

conventional configurations of column capitals and drop panels, the program 

allows the user to define a wide range of cross-sectional shapes. The software 

allows for the cross-section of the member to change along the length of a span, 

with abrupt steps, at the top, bottom, or both. 

• Box girder bridge sections can be readily modeled as equivalent I-sections.  For 

post-tensioned designs, ADAPT-PT/RC is well suited for a first design of box 

girder bridges, where an initial estimate of the amount and location of 

prestressing is sought to achieve given stress levels and design criteria. 

• For flanged beams, you can either select the software’s built-in effective width 

computation, based on ACI-318 or EC2, or input a user-defined alternative 

effective width.  The computations used are identical for RC and PT modes.   

• The program recognizes and accounts for the difference between the effective 

width in bending and pure compression. 

• Using the geometry of the structural model input by the user, the program 

calculates the self-weight loading of the structure for combination with other 
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loads based on the selected concrete weight type. The user has the option to 

override the program defined material density. The calculated values of the self-

weight are reported in the program’s output. 

• The program includes a slab recommendation feature for one- and two-way slab 

systems relative to recommended slab thicknesses without consideration of 

deflections per ACI318 for RC slab systems and recommendations given in 

“Post-Tensioned Buildings – Design and Construction,” Bijan O. Aalami for PT 

slab systems.   

• All the three systems of units—the American customary units (ft-lb), SI units 

(mm, Newton), and the MKS units (m, kg)—can be executed from the same copy 

of the software. Also, all the different codes are integrated into a single version. 

• You can either edit the factory-set or define your own default values for input of 

data, while retaining the option to revert to factory-set default values if you so 

choose. 

• Input to ADAPT-PT/RC is by means of a user-friendly, free-format, context-

sensitive, full-screen input editor. The user may freely browse through, view, 

and modify the input prior to execution or saving of data.  

• ADAPT-PT/RC includes an option for input of base (i.e. existing) reinforcement 

at any location along any span.  The user can enter isolated or mesh flexural 

reinforcement and/or shear stirrups as base rebar.   This functionality is ideal for 

investigative models.  The program gives the option to report design capacity 

and demand/capacity ratios relative to base or calculated reinforcement.  For PT 

mode only, prestressed reinforcement is considered as base reinforcement. 

When shear reinforcement is modeled, the one-way shear reinforcement report 

provides design checks considering base stirrups.  

• The program contains a new Rebar Curtailment input module.  This module can 

be invoked in post-processing of reinforcement output to customize and make 

real time modifications to longitudinal reinforcement results.  User-defined or 

code-prescribed customization for longitudinal bar arrangements in beams and 

slabs for top and bottom reinforcement at cantilever, exterior and interior 

conditions can be input to reflect conditions on final drawings and documents.  

This tool can be active for top and bottom bar conditions or turned off. 

Curtailment templates allows the user to save specific bar arrangement 

configurations for crossover use among multiple users.  The tool applies to both 

PT and RC modes. 

• Reinforcement schedule output includes data transferred from the rebar 

curtailment input including the bar mark, bar size, bar diameter, quantity, bar 
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length, shape codes, bar area and weight of bar.  The schedule can be saved as 

.XLS format for ease of customization. 

• The program includes an automatic rebar spacing check for minimum spacing 

between longitudinal bars.  Design code minimum requirements are checked, 

and the program reports the number of layers required to fit the quantity of 

bars.  

• For PT designs, a library of tendon profiles allows the user to select a suitable 

tendon layout for each case. Common profiles included are the simple parabola, 

reversed parabola, simple parabola with straight portions over the supports, 

harped, strait and extended reversed parabola tendons. Low relaxation and 

stress-relieved strands, as well as unbonded and grouted post-tensioning 

systems, are also supported by ADAPT-PT/RC. 

• Uniform, line, partial, concentrated loads and moment, triangle, variable and 

trapezoidal loads may be specified in practically unlimited numbers and 

variations.  Loading types are identical between PT and RC modes. 

• ADAPT-PT/RC accounts for the shift in the location of the neutral axis of a 

member at changes in cross-section along the member length. Thus, the 

program can correctly handle steps along a member. 

• ADAPT-PT/RC executes either automatically or interactively.  This option is 

active when in PT mode and does not apply to RC mode.   In its automatic mode, 

based on user’s specifications, the software determines the required post-

tensioning and the associated reinforcement. In its interactive mode, the 

program displays the calculated required post-tensioning on the screen to the 

user. You have the option to modify both the forces and the drapes during the 

program execution and recycle the selection until a satisfactory design is 

obtained, or you can input the conditions of an existing design. You can select 

the actual number and position of strands along a member. Also, in the 

interactive mode, you can graphically view the distribution of stresses, tendon 

profile and the required post-tensioning. This provides a good guide for you to 

achieve an optimum design.  

• For PT mode only, stresses are computed and reported using the actual forces 

and drapes selected. This feature distinguishes ADAPT-PT/RC from simple 

programs, where a single-pass analysis is performed, in which the option of the 

user-initiated changes in post-tensioning are not reflected in the subsequent 

calculations. ADAPT-PT/RC has a multi-pass processor. It updates all the design 

values based on changes made in the tendon profile and force before it 

concludes its report of design values. 
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• For PT mode only, serviceability design of the slab/beam is achieved through 

detailed stress control.   For both modes, the program carries out 

comprehensive deflection calculations for both instantaneous and long-term 

deflections. Where the cracking limits of concrete are exceeded, a cracked 

section deflection estimate is carried out using an equivalent moment of inertia. 

• A thorough strength analysis and design is conducted to determine any 

reinforcement that may be necessary to meet the ultimate strength limit 

conditions.  In PT mode, this calculated reinforcement is in addition to the 

prestressing steel.  For RC mode, the calculated  reinforcement is the total 

amount of reinforcement necessary to meet the demand actions for the entire 

strip width.  The user specifies allocation percentages (%) for column and 

middle strips which result in reported reinforcement for each strip type.   

• Other code requirements for reinforcement, such as the minimum requirements 

of the building codes, are also checked and a listing of the reinforcement based 

on different criteria is reported. 

• The program recognizes mixed/hybrid models that include design sections that 

are not intersected by post-tensioning.  The program can determine proper 

amounts of reinforcement relative to differentiating requirements of RC and PT 

design sections.  

• Bar sizes and lengths are selected and reported both in a graphical and 

tabulator format, ready to be entered on the structural drawings. 

• Base (user-defined) reinforcement can be modeled for flexural reinforcement in 

beams and slabs and for shear reinforcement for beams and one-way slabs.  The 

program considers base reinforcement in determining required reinforcement 

necessary to meet minimum and strength level demand actions.   

• The punching shear option checks the adequacy of the column caps as well as 

the immediate slab/drop panel region beyond the cap and provides punching 

shear reinforcements if required. For one-way slabs and beams, a one-way 

shear analysis is carried out. Shear reinforcement is calculated, and the stirrup 

requirements are given. 

• For PT designs, ADAPT-PT/RC can handle both the effective force and the 

variable force methods.  

• For PT mode the variable force method ADAPT-PT/RC calculates the change of 

tendon force along its length and can use the force at each location along the 

length of a member to perform a code check for that location. In addition to the 

immediate losses due to friction, and seating loss, and at user’s option, the 

software accounts for the long-term stress losses along the length of the 
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structure. Since long-term losses for grouted tendons are functions of local 

strain, an iterative non-linear capability is built into the program. The non-

linearity in the solution is with increments of load. 

• For PT mode when the effective force method is used, the force along each 

tendon is assumed constant. In this case, the design is based on a non-iterative 

linear solution in terms of the effective force. 

• For PT mode another execution option is the computation only of immediate 

losses resulting from the friction and seating of strands. The long-term losses in 

prestressing are then affected through a user defined lump sum stress loss. 

• The geometry of the structural model can be viewed on the screen in a three-

dimensional space. The capability to rotate, pan, zoom and view the model 

allows the user to examine the structure in detail prior to the execution of the 

program. Errors in data entry or modeling are readily detected when user’s 

input is displayed on the computer screen. Hard copies of the graphical display 

of the structural model can be readily obtained. 

• ADAPT-PT/RC uses the detailed scheme throughout its operation. This scheme is 

based on 1/20th point values along each span. However, to retain the simplicity 

of presentation of the report, in addition to the optional 1/20th point reports, a 

summary of the solution is compiled for the left, center and right of each span. 

• In addition to graphical reports, the outcome of the analysis and design is 

composed into a clear text file that can be viewed, edited, and printed by you.  

The text file can be produced in Word (.RTF) or as an Excel (.XLS) file. The 

content and extent of the report can be controlled by you through a user-

friendly menu.   

• It is also possible to generate a one-page graphical summary report that extracts 

and incorporates all important design information in an easy-to-interpret 

format. The report may also be exported as a DXF file for incorporation into 

construction documents. The DXF feature includes options to customize the 

name and scale of the drawing file. For PT mode, up to three distinct tendon 

profiles can be shown, with respect to the datum line or the soffit of the 

structure if they differ.  Tendon heights can be exported in the format of the 

tendon CGS heights or tendon support heights.  Further details of exporting to 

DXF include the customization of visualization of the tendon profile, anchor 

points and control points, as well displaying information at 20th interval points 

or user-specified intervals.  The visualization of longitudinal and one-way shear 

reinforcement can also be generated through the DXF import option.  This 

applies to both RC and PT modes of operation.  The user has the option to 

overlay the reinforcement graphical output in one drawing or create separate 

drawings for each. 
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• The graphical display option of ADAPT-PT/RC provides a vivid exposition of the 

distribution of calculated values along the entire structure or for its selected 

members. The displays relative to RC and PT mode include moments, shears, 

deflections, and reinforcement required/provided.  The displays relative to PT 

mode only includes stresses, post-tensioning required, post-tensioning provided 

and tendon profile. Each graph may be printed or exported as a .bmp or a 

metafile.  

• ADAPT-PT/RC input data is stored in a single file with the .ADB extension. 

However, the program is also backward compatible with input generated by 

earlier Windows versions of the program.  The program best operates in a local 

machine environment, but the user can also execute models to network drive 

locations so long as the drive is mapped to the local machine with a pre-

designated drive.  The program is compatible with 32- and 64-bit versions of 

Windows 7, Windows 8 and Windows 10.   

• ADAPT-PT/RC is integrated into the ADAPT-Builder software suite.  Structural 

models generated using the Modeler module of the Builder suite can 

automatically be transferred to ADAPT-PT/RC for analysis and design. This 

capability provides a seamless link between the Finite Element Method of 

ADAPT-Builder and ADAPT-PT/RC.   
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2 Sign Convention 

The following is the sign convention used in ADAPT-PT/RC.  

Applied Loads 

Downward loads and counterclockwise moments are considered positive (Fig. 2.1 (a)). 

Span Actions 

Counterclockwise shear is considered positive. 

Bending moment is considered positive if it causes tension at the bottom  (Fig. 2.1 (b)). 

Column actions 

Counterclockwise column moments are considered positive (Fig. 2.1 (d)). 

Positive direction of frame as well as definition of right and left tributary region is 

defined as shown in Figure 2.1 (c). 

 

Figure 2-1: Sign Convention
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3 Workspace Overview 

This chapter describes Graphical User Interface (GUI) for the main program screen and 

data input module of ADAPT-PT/RC program. 

All program functions, including data entry and program execution are accessed through 

the Main Program window. The data entry is done through separate program modules 

called ADAPT-PT or ADAPT-RC Input.  

When ADAPT-PT/RC is opened, the user has the option of selecting the initial design 

type by selecting the ADAPT-RC or ADAPT-PT button.   

 

Figure 3.1 

At any time before creating a model or after a design selection and model have been 

made, the user can switch to the other design mode by selecting Actions>Convert 

Project to ADAPT-RC or ADAPT-PT.  If a model has not yet been generated or saved, the 

user can also go to Options>Program Mode and  make a selection of ADAPT-RC or 
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ADAPT-PT.  Once a model has been saved, this option is grayed out, inactive and shows 

the current mode of operation.   

3.1 The Main Program Window  

Figure 3.1-1 shows the main ADAPT-PT/RC program screen as it appears once a 

project has been opened.  

 

 

 

 

Figure 3.1-1 Main Program Window  

Main Program Title Bar. Contains the program name and name and location of 

the opened file. 

Main Menu Bar. Lists all available menus in main program window. Menu 

options will be grayed out when they are not applicable. For example, if there is 

no project open, the Save As, Close and Print options on the File menu will be 

grayed out. 

Main Toolbar. Main Toolbar contains all available tools in the main program 

window. The tools will not be available when they are not applicable. For 

example: 

Status Bar 

Main Program Title Bar 

Main Menu Bar 
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• If you open the ADAPT-PT/RC program the available tools are:   

 

• If you open an existing file, the main toolbar contains the following 

options:           

 

Status Bar. Status bar gives you information about project name, selected 

design code, units, execution mode, key type, current date, and time. To turn 

Status Bar on or off go to View→Status Bar. 

Hint Window. Hint window gives you information on how to proceed if you 

want to edit, execute, or view your structure. To close the Hint Window, right 

click anywhere on the screen. 

3.2 Main Program Window Menu Items and Corresponding Tools  

All options that can be accessed by the main program menus are listed below. 

For the commands that might be activated using the toolbar, the appropriate 

icon is displayed next to the feature. 

3.2.1 File Menu  

The File Menu operations are: 

• New - Starts a new project.  The project will be initiated in the 

active design type that was selected in the Start screen.  

• Open - Opens an existing project.  The project will be opened 

for the design type which it was last saved as.  

• Save As - Saves both the input files and the results report file 

under a user-specified filename as the active design type (RC or 

PT).  

• Save As Default Values - Once you save data using this option, 

the program will open all the new projects in the future using 

the values you saved. To change the default values, open a new 

file, modify the parameters of your choice, and re-save it using 

Save As Default Values. 

• Close - Closes the currently open project. 

• Delete Intermediate Files - Deletes all intermediate calculation 

files from the current project directory. 
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• Export Graph - Allows the user to export the currently active 

graph as either a bitmap (.BMP) or a Windows metafile (.WMF). 

• Print - Prints the currently active report or graph window.  

• Page/ Print Setup - Sets the paper size, report margins, paper 

orientation and printer. 

• Exit - Closes all windows and exits the program. 

3.2.2 Action Menu 

The Action menu operations are: 

• Enter/Edit Data - Opens the data input editor.  

• Execute Analysis - Executes the program calculations.  

• Recycle Window - Opens the recycling window. Used when re-

running a project to adjust the post-tensioning force or profile. 

 

• Convert project to RC or PT - Converts the active project type to 

the alternate design type of RC or PT.  This activates necessary 

input windows required for the specific design type.  

3.2.3 View Menu 

The View menu operations are: 

• Status Bar - Turns the status bar at the bottom of the main 

window on and off. 

• Graphs - The Graphs menu item opens a submenu, which allows 

any or all the Results Graphs to be viewed. The Show Graphs 

button on the main toolbar displays all graphs.  

• RC or PT Summary - Allows you to see result graphs for 

moments, forces, reinforcement, and stresses (PT mode only) 

for each load combination and envelope. Also, it displays the 

report summary sheet  and DXF export option . 

3.2.4 Options Menu 

The Options menu operations are: 

• System of Units - Allows the user to select the default units 

(American, SI, MKS).  
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• Design Code - Allows the user to select the default code. 

• Remember Printer Selection - If this option is checked, the 

program uses the latest printer settings for all future runs, 

regardless of the default printer selected in the Windows 

settings. 

• Report Setup - Opens a Report Generator window where the 

report contents may be set.   

• Compress Report Bitmaps - Compresses the size of bitmap files 

created after executing a model.  This significantly reduces the 

.BMP file and program solution folder size. 

• Graph Properties - Configures the graphs generated by the 

program. Options include whether to include X and Y gridlines, 

min/max data points and a legend. 

• Spreadsheet Options - Configures the action of the ENTER key 

in the data entry spreadsheets. The key may be set to move the 

cursor right, down or stay in the same field. 

3.2.5 Window Menu 

This menu lists which of the windows are open. The windows may be 

stacked vertically, horizontally, or the windows may be cascaded. 

3.2.6 Help Menu 

The Help menu operations are: 

• Documentation - Opens folder with product documentation. 

• About ADAPT - Company address, phone, fax, and e-mail 

information. 

• About ADAPT-PT/RC - Program information such as version. 

• Support Programs - Information on how to obtain program 

support. 

• Disclaimer - Defines responsibility of the software user. 

• Calculator - Invokes the standard windows calculation. 
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3.3 ADAPT-PT/RC Input screen 

Project input data is created/edited through a separate program module called 

ADAPT-PT or ADAPT-RC Input, depending on what the active mode is. The input 

editor is used both to enter new projects and edit existing files. 

• To enter a new project either click New on the File menu or click the 

New icon, , on the Main Menu bar.  

• To edit existing file either click on Enter/Edit Data on the Actions menu 

on the Input Menu bar, or click the Edit Data button, , on the Input 

Toolbar.  

Figure 3.3-1 shows the ADAPT-PT/RC Input screen as it appears once the input 

editor is opened.  Note that the main input screen is similar for both PT and RC 

modes.  

 

 

 

Figure 3.3-1 ADAPT-PT/RC Input Screen 

PT/RC Input Title Bar. Contains program name, and  name and  location of the 

opened file. 

PT/RC Input Menu Bar. Menu bar lists all available menus in ADAPT-PT/RC 

Input. 

Input Title Bar 
Input Menu Bar 

Input Toolbar 

3D Structure View 

Input Form 
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PT/RC Input Toolbar. This toolbar contains all available tools in the ADAPT-PT 

Input.  

Input Form. Each input form is the dialog box that will prompt you to select 

options or enter required information. When first entering data for a project, 

you would typically go through the screens in order by clicking on the Next and 

Back buttons or pressing ALT-N and ALT-B. In subsequent editing, specific 

screens may be selected from the PT/RC Input menu.  

If the input form contains a table (Fig. 3.3-2) the right mouse click will give you 

the following options: 

• Insert a new line. 

• Delete line. 

• Copy selected lines. 

• Paste lines. 

 

Figure 3.3-2 Span Geometry Input Screen 

Each table contains a Typical row for fast input of data. The typical input row 

(top row) can be used if several rows in a column have same data. To enter 

typical values, type the value into the appropriate cell in the top row and then 

press ENTER. The typical value will be copied to all rows in the column. The 

value of any field initialized in this manner can be subsequently changed, as 

necessary. Data can be entered in the typical row at random; it is not necessary 

to enter values in all fields of the typical row. 
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3D Structure View. Structure View window allows you to view the structure, 

loads, tendons, and rebar in 3D as you enter the data. You can also display the 

properties of each component if you bring the mouse pointer over it and right 

click. You can change the display in 3D window with View Tools toolbar.  

3.4 ADAPT PT/RC-Input Menu Items and Tools 

All options that can be accessed by the PT and RC Input menus are listed below.  

Only the set of input forms will appear to the user for the active design mode.  

3.4.1 File Menu 

The menu items have the same function as File menu in the main 

program screen.  

3.4.2 Project Menu 

This menu enables you to specify the project title, structural system and 

select analysis and design options through General Settings and Design 

settings input forms.  

3.4.3 Geometry Menu 

This menu enables you to access input forms that you use to define 

geometry of a model. The input forms included in this menu are: 

• Span Geometry 

• Effective Flange Width  

• Drop Cap/Transverse Beam 

• Drop Panel 

• Support Geometry 

• Boundary Conditions 

3.4.4 Loads Menu 

This menu opens the Loads input form where you can specify the loads.  

3.4.5 Material Menu 

This menu enables you to access input forms where you can specify 

material properties for:  
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• Concrete 

• Reinforcement  

• Post-Tensioning (PT mode only)  

3.4.6 Criteria Menu 

Criteria menu contains all input screens that you use to specify project 

criteria. The Criteria menu input forms are: 

• Base Non-Prestressed Reinforcement 

• Allowable Stresses (PT mode only) 

• Post-Tensioning (PT mode only) 

• Calculation Options (PT mode only) 

• Tendon Profile (PT mode only) 

• Minimum Covers 

• Minimum Bar Extensions 

• Rebar Curtailment 

• Load Combinations 

• Design Code 

3.4.7 Execute Menu 

If you click on the Execute menu the program will initiate an analysis. 

The corresponding tool is Save & Execute Analysis, , in the Common 

toolbar. 

3.4.8 Tools Menu 

The Tools menu allows you to convert units and change color settings. 

The menu items are: 

• Convert units.  

• Color selection. 

3.4.9 Window Menu 

This menu lists the graphical windows that are currently active. The 

windows may be stacked vertically for scrolling, or the windows may be 

cascaded. 



 

22 

3.4.10 Structure View Menu 

If you click on this menu it will open the 3D structure view. 

3.4.11 View Tools Toolbar 

 

This toolbar contains tools for selecting the entities that you want to be 

visible on the screen, as well as for creating rendered or shaded views of 

structural models. It is used to zoom in or out, pan, increase scale, or 

create a screen shot and print.  

 Plan View. It will show structure in plan view.  

 Elevation View. It will show structure in elevation view. 

 Isometric View. It will show structure in 3D isometric view. 

 Free Rotate Perspective View.  

 Wire Frame.  

 Transparent Shader.  

 Solid Shader.  

 Outline Shader. 

 Show/Hide Gridlines. Displays or hides gridlines and reference 

line. 

 Show/Hide Spans. Displays or hides spans of the structural 

model. 

  Show/Hide Supports. Displays or hides columns and walls of 

the structural model. 

 Show/Hide Drops/Beam. Displays or hides drop caps and 

beams of the structural model. 
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  Show/Hide Loads. Displays or hides all loads that have been 

identified as “visible” in the Select/Set View Items window. 

 Show/Hide Rebar. Displays or hides the entire user defined 

(base) reinforcement.  

 Show/Hide Tendons. Displays or hides the entire tendons of the 

structural model. 

 Show/Hide Fixity. Displays or hides all fixity symbols of the 

supports. 

 Increase Scale Factor. This tool provides you with the option of 

distorting the dimension of the model in one or more direction, 

in order to obtain a better view of its details, such as magnifying 

the profile of a tendon within a slab thickness. 

 Select/Set View Items (Fig. 3.4-1). This button is used to set the 

display of the project items on the screen. Depending on which 

boxes you select, you can display additional information about 

each entity.  

 Dynamic Pan.  

 Rotate.  

  Zoom In.  

 Zoom Out.  

 Zoom Extents.  

 Dynamic Zoom.  

 Screen Capture. Takes a screen shot of the Structure View 

window. 

 Print. Prints currently active window. 

 Add or Remove Buttons.  This option is used to add or remove 

buttons from the Input Toolbar.  
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Figure 3.4-1 3D Display Settings Dialog Box 
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4 Basic Program Operations 

This chapter explains the basic program operations. 

4.1 Start a New project 

When starting a new project, you should specify design code and system of 

units. 

To start a new project: 

• Double-click on the ADAPT-PT/RC icon of your desktop to open the 

program.   

• Select File→New, or click on the New Input Session icon, . 

4.2 Open an Existing Project 

To open an existing project: 

• In the Main program window select File→Open, or click on the Open 

Project button, . 

• Select the .ADB file that you want to open.  Note that the program will 

open in the design mode which was exited from when the project was 

last saved.  

Note: The four most recently accessed files will be recorded in File menu for 

easy access.  

4.3 Save Input Data  

To save the input data and execute the analysis, either select Execute from the 

Input Editor menu or click on the Save & Execute Analysis button, .  

• If you are entering a new project, you will be prompted for a file name 

and directory in which to save the file. Once the file is saved, the 

program will automatically execute the analysis.  

• If you opened an existing project, it will be saved to the same directory, 

under the same filename. The program will then automatically execute 

the analysis.  
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To save the input data and return to the Main Program window, select either 

Save or Save As from the Input Editor File menu or select the Save icon, , on 

the Input Editor Toolbar.  

• If you have opened an existing file, Save will save the file under the 

same name, in the same directory.  

• Save As will allow you to change the file name and/or directory. 

Once the file is saved, select Exit to return to the Main Program window. 

4.4 Save Input Data as Default 

Note that it is often not necessary to go through all the input screens, even 

when entering a new project. Much of the information on the Materials and 

Criteria input screens will be the same on many projects. The program is set up 

with ADAPT defaults for all screens.  The program includes separate default 

settings depending on which design mode the program is opened in.   

To change the default values installed with ADAPT-PTRC: 

• Open the file with the data you would like to save as default and use in 

other files.  

• Choose File→Save as Default. The program will save the file as 

“default” ADB file. Once you saved data using this option, the program 

will open all the future new projects using the values in the data you 

saved. To change the default values, open a new file, and re-save it 

using Save As Default Values. 

4.5 Select System of Units 

ADAPT PT/RC features three systems of units: SI, MKS and American (known as 

Imperial).  

To select system of units for the new project: 

• Double-click on the ADAPT-PT/RC icon on your desktop to open the 

main program window. 

• Select Options→ System of Units. 

• Check one of the options: SI, MKS or American. The program will 

automatically close the Options menu. 
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Note:  If a file which has been previously created is opened, and the System of 

Units option is selected, the program will gray out the options and show a check 

mark by the system in use for that model.   

4.6 Convert System of Units 

To convert system of units: 

• Open an existing project. 

• Click on Edit Data icon, , to open Input Editor.  

• Select Tools→Convert Units. The Convert-Units dialog box opens (Fig. 

4.6-1). 

• Select New Unit and click Convert. 

Note: The Convert Unit option is available only if the design code is ACI.  

 

Figure 4.6-1 Convert Units Dialog Box 

4.7 Program mode 

To select the design mode to work in (PT or RC mode):  

• Select Options→ Program Mode. 

• Check one of the options: ADAPT-PT or ADAPT-RC. 

Note:  If a file which has been previously created is opened, and the Program 

Mode option is selected, the program will gray out the options and show a 

check mark by the active mode. To switch modes, the user must go to 

Actions→Convert Project to ADAPT-RC or ADAPT-PT. 
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5 Structural Modeling Overview 

During the structural modeling step, the user defines the basic analysis and design 

parameters, i.e. the structural system (beam, one-way or two-way slab), the span 

lengths, cross-sectional geometries, tributary widths, supports and boundary conditions. 

The user also defines the loading, material properties, base (existing) reinforcement, 

allowable stresses (PT mode only), post-tensioning criteria (PT mode only), calculation 

method and tendon profile (PT mode only), reinforcement covers and load 

combinations. This is the most critical stage of the modeling process. The user’s 

experience and engineering judgment play a major role in the selection of suitable 

design parameters. This stage of the modeling should be performed, or at least 

reviewed, by a senior engineer. A structure that is not modeled correctly is not likely to 

yield reasonable results using ADAPT-PT/RC or any other software.  

Data entry in ADAPT-PT/RC is independent from the execution of the analysis. Data for a 

particular project may be entered at any time for later execution. Data is entered 

through ADAPT-PT and RC Input screens described in Section 4.2.  

5.1 Project Information 

Project information includes specification of general information and analysis 

and design options. 

5.1.1 Specify General Project Information 

The General Settings window automatically opens when a new project 

is started, or an existing project is opened. This screen is also available 

through menu option Project→General Settings. 

 

Figure 5.1-1 General Settings Input Screen 

Input information as follows: 



 

30 

1. Type in General and Specific title. Note that the General title and 

Specific title of the project will appear at the cover page of a report 

and in the header of each page of a report. 

2. Select Geometry input option. 

• If you model spans with uniform geometry where the tributary 

width, section type and/or section depth do not change within a 

span, select Conventional input. This will also give you an 

option to include drop caps, drop panels, and/or transverse 

beams.  

• If you model spans with non-uniform geometry within a span, 

select Segmental input. 

3. Select a type of a Structural System. 

• If you select Two-Way slab you will have an option to include 

drop caps, drop panels and/or transverse beams. 

• If you select One-Way Slab you will have an option to include 

transverse beams only. 

• When a Two- or One-Way Slab is selected, you will have the 

option to have the program recommend a slab thickness in the 

Geometry input window.  When the span length is entered, the   

program will auto-fill the thickness ‘h’ value.  The value can be 

overwritten.  Values given by the program are taken from 

ACI318 and PTI recommend slab thicknesses for geometrical 

considerations and span locations.  

• If you select Beam you will have an option to include an 

effective flange width in the calculations.  Note that if effective 

flange with is considered, the options for ‘I’ and Extended ‘T’ 

sections in the geometry input are grayed out. See Section 

5.2.1.  

4. Click Next. This will save input data and open next input screen 

Criteria – Design Code where you can select design code. 

5.1.2 Specify Analysis and Design Options 

You can select various analysis and design options through the Design 

Settings dialog box (Fig. 5.1-2).  Note that some settings are applicable 

only to PT mode.   

To specify analysis and design options: 
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1. Click on Project→Design Settings. The Design Settings input screen 

opens. 

 

Figure 5.1-2 Design Setting Input Screen – PT Mode 

2. Select Analysis options 

• Automatic (PT mode only). In the automatic mode, the 

program attempts to select a post-tensioning force and profile 

based on the parameters specified by the user. If a solution is 

possible, the program will complete all calculations and return 

to the Main Program window. The results can then be viewed 

and/or printed. If a satisfactory solution is not possible, the 

program will display a message box, which describes the 

problem and will switch to the interactive mode. The user can 

then decide whether it is possible to overwrite the original 

design criteria and continue with the design. 

• Interactive (PT mode only). The interactive mode gives the user 

an opportunity to optimize the design by adjusting the tendon 

forces and tendon drapes in each span.  

• If you select “Yes” for Moment reduced to face-of-support, the 

calculated moment at the support centerline will be adjusted to 

face-of-support and used in design. 

• If you select “Yes” for Redistribute moments (post-elastic), the 

program will perform redistribution of moments and readjust 
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elastic moments based on the provisions of the selected design 

code.  

• If you select “Yes” for Use Equivalent Frame Method, the 

program models the structure using the Equivalent Frame 

Method (EFM). This option is available only for two-way 

systems.  

• If you select “Yes” for Increase Moment of Inertia Over 

Supports, the program will internally model the structure with 

increased moment of inertia over supports. This option affects 

the relative stiffness of the beam and column members. It also, 

in turn, affects the relative distribution of the moments and 

may affect the amount of post-tensioning required. The option 

is available for one-way systems and two-way systems where 

the Equivalent Frame Method is not used. 

3. Select Design options 

• If you select Use all provisions of the code the program will 

consider all provisions of the selected design code including 

calculation of minimum rebar for serviceability, check for 

cracking capacity (PT mode only) and add reinforcement if 

needed, considering the contribution of post-tensioning in 

strength check (PT mode only).  

• If you select Disregard the following provisions you will have an 

option to choose which of the following provisions you would 

like to disregard in design:  

• If you choose to disregard Minimum rebar for 

serviceability the program will not report minimum 

rebar.  This applies to PT and RC modes.  

• If you choose to disregard Design capacity exceeding 

cracking moment the program will not report the rebar 

due to design capacity exceeding cracking moment 

capacity. This applies to PT mode only. 

• If you choose to disregard Contribution of prestressing 

in strength check the program will not consider post-

tensioning in strength check. This scenario applies when 

a user adds tendons to a project for deflection or crack 

control.  This applies to PT mode only. 

• If you choose to Auto Increase Allowable Tension 

Stress, the program will increase the allowable tensile 

stress per code requirements for BS, Indian and Hong 
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Kong codes when the calculated tensile stress exceeds 

the user-defined allowable tensile stress.  If this option 

is not selected, the program will optimize a design 

based on the user-defined allowable stress without the 

automatic increase.   

• If data is being entered for a beam you will have an option to 

Include the (DL + 25% LL) case of UBC. This is a UBC (Uniform 

Building Code) requirement used to determine the amount of 

mild steel reinforcement required. If this is answered “Yes,” the 

ratio of reduced live load to actual live load must be entered. 

This option allows a reduced live load to be used for the post-

tensioning if so desired but provides the full live load for the 

25% UBC design loading. Live load reduction is optional; if the 

live load entered on the Loading screen was not reduced, the 

ratio of reduced to actual live load would be 1. Note that the 

(DL +25%LL) provision is not required by ACI-318, nor is it 

included in the IBC-2000 (International Building Code).  This 

applies to PT mode only.   

• If you select the checkbox for Consider for calculation of 

minimum moment, the program will use the drop panel / drop 

cap / transverse beam / support segment for the calculation of 

the area of the section at support when calculating minimum 

reinforcement over supports for two-way slabs or one-way 

slabs (with Transverse Beams).  

• The program calculates and reports the moment capacity in 

both graphical and tabular format, based on the user selection. 

• If you select Design values, the moment capacity will be 

calculated using the rebar and PT required (PT mode 

only) for the design, including user defined base 

reinforcement. 

• If you select User entered values, the moment capacity 

will be calculated only with user entered rebar (base 

rebar) and PT (PT mode only). 

The moment capacity for the 1/20th points can be observed in 

the appropriate tabular report (Tabular Report-Detailed/ 34- 

Demand Moment and Moment capacity). The moment capacity 

graph is plotted together with the moment envelope (Fig. 5.1-

3). To see the graph Open BuilderSum, select Envelope from the 

drop-down list and click on Moment Diagram. Click on the 

Design Moment Capacity frame and select positive or negative 

moment capacities.   
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Figure 5.1-3 

4. Specify the percentage of top and bottom reinforcement and post-

tensioning (PT mode only) that will participate in resisting 

unbalanced moment. This option is available only for two-way 

systems. 

5. Click Next. This will save input data and open a new input screen 

Span geometry where you can specify geometry of spans.  

5.2 Geometry 

The geometry of the problem is defined via a series of input screens that can be 

accessed through the Geometry menu. The screens will vary depending on 

which structural system has been specified. There are three basic screens: Span 

Geometry, Support-Geometry, and Support-Boundary conditions. Additional 

screens are used to enter effective flange widths, segmental data, drop caps, 

drop panels and transverse beams. 

5.2.1 Specify Span Geometry 

The span geometry can be modeled as prismatic (uniform) or non-

prismatic (non-uniform).  

• The geometry without changes in cross-section along the span 

excluding geometry of drop cap, drop panels or transverse 

beams is called prismatic (uniform) geometry.  

• Geometry of a cross-section that changes along the span is 

called non-prismatic (non-uniform) geometry. You will have to 
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model span geometry as non-uniform if at least one span is not 

uniform. 

5.2.1.1 Prismatic (Uniform) Spans 

The Span Geometry screen is used to enter the 

cross-sectional geometry of the slab or beam at mid-span (Fig. 

5.2-1).  

To input data for uniform spans, do the following: 

1. Open Span Geometry. 

2. To set the number of spans, use CTRL+/- or click on the 

up/down arrow at the left of the screen. If there are 

cantilevers on the right and/or left ends of the frame, add 

them by clicking on the appropriate check box. This will 

activate the input fields for the corresponding cantilever.  

Spans other than cantilevers can include overwritten with 

customized names.   

3. Select section type by clicking on the button in the Sec. 

column. Section type can be set to Rectangular, T section, I 

or L section, and Extended T section. 

4. Enter the dimensions of the span sections. All dimensions 

are defined in the legend at the top of the screen and/or 

illustrated in the appropriate section figure.  

• Span lengths are measured from support centerline to 

support centerline. 

 

Figure 5.2-1 Span Geometry Input Screen 
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• The tributary width (dimension b) is composed of left 

tributary (the portion of the tributary width that falls to 

the left of the frame line) and the right tributary (the 

portion that falls to the right of the frame line). The 

tributary width can vary from span to span but is 

assumed to be constant within a single span unless 

segmental input is used. 

There are two methods of modeling tributary width: 

Unit Strip input and Tributary input. Both methods 

produce the same results, which method to use is a 

matter of user preference. Once a method is selected 

however, it should be used consistently throughout a 

given project to avoid confusion. Note that the 

calculations and results are always shown in terms of 

the total tributary width, regardless of the way the slab 

was modeled during data entry. 

Unit strip modeling (Fig 5.2-1A). It is typically easiest to 

model slabs with the unit strip method. A unit strip is a 

strip parallel to the span with a width equal to or less 

than the total tributary width. Although the unit strip 

width is typically 12 in. or 1000 mm, any reasonable 

value may be used. The unit width has no effect on the 

analysis if the total tributary width is modeled correctly. 

The tributary is modeled by specifying a unit strip width 

along with left and right multipliers. The left and right 

multipliers (−  and −) indicate the number of 

times the unit strip needs to be multiplied to cover the 

left and right tributaries. The multipliers need not be 

whole numbers.  
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Figure 5.2-1A 

Tributary Modeling . In tributary modeling, the total 

tributary width is entered as the ‘b’ dimension. The 

width multipliers (<-M  and M->) are used to indicate 

how much of the tributary falls on either side of the 

frame line. The sum of the left and right multipliers 

should be one. 

Example: Model the following tributary using A) unit 

strip method B) tributary method. 

Total tributary  = 300 in.  

Left tributary    = 180 in.  

Right tributary  = 120 in.  

A) Unit strip method: 

b = 12 in. <-M = 15  M-> = 10 

Total width = Left tributary + Right tributary = 12*15 
+12*10 = 180 + 120 = 300 in.  

B) Tributary method: 

b = 300 in. <-M = 0.60  M-> = 0.40 

Total width = Left tributary + Right tributary = 
300*0.60 +300*0.40 = 180 + 120 = 300 in  



 

38 

5. Enter reference height (Rh). The reference height identifies 

the position of a reference line that is used in determination 

how to display tendon heights. The Rh indicates the 

distance from the reference line to the top of the slab with 

positive being measured upwards. Typically, the reference 

height is set equal to the slab depth.  

Figure 5.2-2 shows several different reference height 

configurations. Typically, the same reference height is used 

for all spans. The reference height can thus be set via the 

typical row. If the slab or beam depth changes, the same 

reference height can still be used if the resulting tendon 

heights are adjusted accordingly when transferred to the 

structural drawings for PT designs. Alternatively, the 

reference height can be entered as zero, which will set the 

reference line at the top of the slab. If the reference line is at 

the top of the slab, tendon heights will be shown as negative 

numbers indicating distance below the top of the slab.  
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Figure 5.2-2 

The reference height can be changed from span to span to 

model steps at the top of the slab. If this is done, however, it 

will be necessary to adjust the tendon profiles, so they match 

at the supports for designs performed using PT mode. In 

general, it is best to use the same reference height for all 

spans. Changes in the slab depth should be modeled 

accurately, however, to ensure that the calculations are done 

correctly. 

5.2.1.2 Non-prismatic (non-uniform) spans 

The following example illustrates data entry for a non-

prismatic section using the segmental option. The example is 
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a four-span beam, which is made up of three segments of 

varying cross-section for the two interior spans (Fig. 5.2-3). 

                

Figure 5.2-3 

To model a non-prismatic span, do the following: 

1. Select Segmental in the General Settings input form.  

2. Open Span Geometry (Fig. 5.2-4). 

 

Figure 5.2-4 Span Geometry 

3. To set the number of spans, use CTRL+/- or click on the 

up/down arrow at the left of the screen. If there are 

cantilevers on the right and/or left ends of the frame, add 

them by clicking on the appropriate check box. This will 

activate the input fields for the corresponding cantilever.  

4. Select section type by clicking on the button in the Sec. 

column.  

5. Enter the dimensions of the span sections. All dimensions 

are defined in the legend at the top of the screen and/or 

illustrated in the appropriate section figure. The dimensions 

specified in the Span Geometry screen including reference 

height and left and right multipliers define the geometry of 

a mid-segment of the span. All other segments of the span 
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are defined in the Geometry-Span (More) screen as 

explained in the following.  Note that any span set to non-

prismatic, NP, will be grayed out in the Span Geometry 

screen and can only be modified in the segmental input 

described below.  

6. Change prismatic column PR to NP. Changing a span to NP 

activates the  button in the Seg. column. 

7. Click on the  button in the Seg. column to open 

the Geometry-Span (More) window for that span (Fig. 5.2-

5).  

 

Figure 5.2-5 Geometry – Span (More) Screen 

8. To set the number of segments in the spans, use CTRL+/- or 

click on the up/down arrow at the left of the screen. Up to 

seven segments may be entered per span. The parameters 

are input in the same manner as general span geometry 

data except the XL column is used to specify the distance 

from the left support centerline to the start of the segment. 

The length of each segment is calculated automatically 

based on the distance to the start of the next segment and 

reported in the L column. The start of the first segment is 

always zero.  

Note that if either the Use Equivalent Frame Method or 

Increase Moment of Inertia Over Support option was 

selected, the program will automatically generate additional 

segments over each support using the geometry entered for 

the first and last segments. If the first and last segments are 

generated before the support dimensions are entered, their 

XL values will be initialized with values of zero and the span 

length, respectively. These values will be updated when the 

support dimensions are entered.  
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9. Click OK to save input data and close Geometry-Span 

(More) window.  

10. When the user completes data input for all spans click Next 

to save the data and open next input screen Support 

Geometry and Stiffness.  

5.2.2 Specify Effective Flange Width  

If you enter a beam and you answer ‘Yes’ to Consider Effective Flange 

Width on the General Settings screen, the Span Geometry screen will 

be followed by the Effective Flange Width screen (Fig. 5.2-6). This 

screen is also available through menu Geometry→Effective Flange 

Width. 

 

Figure 5.2-6 Effective Flange Width Input Screen 

1. Open Effective Flange Width input screen. 

2. Select Effective width calculation method.  

• If you choose to use the ACI-318 or European-EC2 method of 

effective flange width calculation, the resulting flange widths 

will be displayed, but you will not be able to edit them.  

• If you select User Input calculation, the effective width column 

be will default to the ACI calculated values, but you will be able 

to change them.  

3. Click Next to save data and go to the next input form. 
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Note:  ACI does not require that effective flange widths be used for 

prestressed beams. The widths calculated by the program are in 

accordance with the ACI recommendations for non-prestressed beams.  

5.2.3 Specify Geometry of Drop Cap and/or Transverse Beam 

If you enter a two-way system and you answered “Yes” to the Include 

Drops & Transverse Beams question on the General Settings screen, 

the Span Geometry screen will be followed by the Geometry-Drop 

Cap/Transverse Beam screen (Fig. 5.2-7). This screen is also available 

through menu Geometry→Drop Cap/Transverse Beam. 

The input parameters are defined in the figures at the top of the screen. 

Note that H, the depth of the cap or beam, is the total depth of the 

section, not the depth below the slab. 

 

Figure 5.2-7 Drop Cap/Transverse Beam Input Screen 

If there are drop caps or transverse beams with the same dimensions at 

several supports, their dimensions may be entered using the typical 

row. To enter typical values for drop caps, type the value into the typical 

row and press ENTER. The value will be copied to any supports that 

have been marked as having drop caps. Any supports which are 

subsequently marked as having drop caps will also be assigned this 

value as a default.  

Transverse Beams dimensions are entered in the same manner. 
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5.2.4 Specify Geometry of a Drop Panel  

If you enter a two-way system and you answered “Yes” to the Include 

Drops & Transverse Beams question on the General Settings screen, 

the Drop Cap/Transverse Beam screen will be followed by the 

Geometry-Drop Panel screen (Fig. 5.2-8). This screen is also available 

through menu Geometry→Drop Panel. 

 

Figure 5.2-8 Drop Panel Input Screen 

The data entries for drop panels are the same as for drop caps. Typical 

values can be entered with the typical row at the top of the table. 

5.2.5 Specify Support Geometry and Stiffness 

This screen is used to input support heights, widths, and depths of 

supports (Fig. 5.2-9). Support selection options will change depending 

on the structural system you selected. 

 

Figure 5.2-9 Support Geometry and Stiffness Input Screen 
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If you model a two-way system or a beam, the available support options 

will be: 

• Lower column,  

• Both columns, 

• No columns 

If you model a one-way system, the support options will be: 

• Lower wall,  

• Both walls,  

• Point support or transverse beam. 

To model supports do the following: 

1. Select lower, both or no support option.  

2. Enter the height of lower supports (H1) if any. H1 is the 

distance from the mid-depth of the slab to the top of the 

slab below.  

3. Specify cross section dimension for support: 

• If rectangular, enter data in column D (dimension in 

span direction) and B (dimension perpendicular to span 

direction). 

• If circular, enter data in column Dc (diameter of circular 

column). 

4. Specify the percentage column stiffness that you would like 

to consider in analysis.  

5. Repeat the procedure to define geometry of upper columns 

if any, or simply copy the data. 

6. If you model a two-way system you will have an option to 

assign a Left edge and Right edge condition. This option is 

available only for two-way systems and it is used to 

determine column condition for punching shear check.   

• If you select Exterior the program will automatically 

check the left and right tributary width. If the tributary 

that falls to the left or to the right side of the column is 

less than code required for interior column, the 

program will automatically consider it as an exterior 

column.   



 

46 

• If you select Interior the program does not check left 

and right tributary width and treats the column as 

interior.  

Note: The program always checks left and right distance to 

the slab edge. If the dimension B of a column is at least 80% 

of tributary width the program will treat this column as wall 

and will not check it for punching shear. 

5.2.6 Specify Support Boundary Conditions  

This screen is used to enter support widths and column boundary 

conditions (Fig. 5.2-10).  

 

Figure 5.2-10 Supports-Boundary Conditions Input Screen 

1. Select Slab/beam boundary conditions at far ends. 

• Choose “No” if the slab end is rotationally free. This 

occurs when a slab/beam terminates over wall, column, 

or beam. 

• Choose “Yes” if the slab end is rotationally fixed. This 

occurs if the span/beam end is tied to a structure that is 

rigid enough to prevent rotation. A typical example 

might be slab tied to a stiff shear wall. A rotationally 

fixed end condition can also be used to model half of a 

symmetrical, multi-span frame if there will be no 

rotation over the support at the line of symmetry. 

Note: If there is a cantilever at the right or left end of span, 

the corresponding slab/beam end condition option will not 

be available. 

2. Specify support width SW. This option is available if you 

choose “Yes” to the Reduce Moments to face-of -support in 

the Design Settings screen. 
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• To automatically set the values in SW column to actual 

support widths, D, check box in front SW = Actual width 

of support. This option will not be available if you select 

no columns or point support transverse beam option for 

supports. 

• To manually enter support width, uncheck box in front 

SW = Actual width of support and input data.  

3. Choose support boundary conditions by clicking on the 

arrow in the appropriate cell of the table. The following 

figure shows the available boundary conditions and symbols 

used in 3D view.   

 

 

Condition 1 

fixed 

(a) 

 

 

Condition 2 

pinned 

(b) 

 

 

Condition 3 

roller 

(c) 

Figure 5.2-11 Boundary Conditions 

Note: If  No Columns option was specified on the Supports-

Geometry screen the boundary condition entries will be 

ignored. The support widths will be used to calculate 

reduced moments, however.  

5.3 Loads  

ADAPT PT/RC allows you to specify a variety of load types including dead, live, 

earthquake or wind loads (lateral loads).  

5.3.1 Specify Dead, Live, and Other loads 

Figure 5.3-1 shows the screen used to enter loading information. 
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Figure 5.3-1 Load Input Screen 

 

1. Specify loaded spans. 

• To enter load for an individual span, click on the arrow in cell of 

the Span column and select a span number from the list of all 

available spans, or just type in a span number.  

• To enter a load for all spans, enter ‘all’ or ‘ALL’ as the span 

number.  

• To enter loads on a left cantilever, enter either LC or 0 as the 

span number. To enter loads on a right cantilever, enter either 

RC or the number of spans +1 as the span number. 

2. Specify the class of load by clicking on the arrow in the cell of a Class 

column. There are four available classes: 

• SW – self-weight. This load class will be available only if you 

select “No” for Include self-weight. In this case you have an 

option to enter self-weight of the structure manually instead of 

allowing the program to calculate it.  If “Yes” is selected for self-

weight, the program calculates the structure self-weight based 

on the density of the concrete material selected.  The user has 

an option in this dialogue menu to override the concrete unit 

weight. 

• SDL – superimposed dead load 
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• LL – live load 

• X – other load 

3. Specify the type of loading by typing U, P, C, M, L, R, V, or Z in the 

L/T-? column, or by dragging the icon from the graphics of the 

loading that you intend to apply to the cell in the L/T-? column. 

There are eight load types:  

• U - Uniform,  

• P - Partial uniform,  

• C- Concentrated,  

• M - Moment,  

• L - Line,  

• T - Triangle,  

• V - Variable, and  

• T - Trapezoidal.  

Note: Uniform and partial loads are assumed to be uniformly 

distributed over the upper most surface of the member with a 

constant intensity per unit area. The user only needs to enter the 

loads intensity and ADAPT calculates the frame loadings. These 

frame loadings are reported in report table 3.2 Compiled loading. 

4. Enter load intensity and position. The schematics for each load type 

indicate the required input data. Note that on cantilevers, distances 

are always measured from the support (Fig. 5.3-2). The distances for 

a left cantilever are thus entered contrary to those of the typical 

spans.  

 

Figure 5.3-2 
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Any number of different loads and load types may be entered for a 

span. You may also specify whether to skip the live loading and 

whether to calculate self-weight automatically. If these features are 

selected, the skip factor and concrete unit weight must be entered.  

When the Skip Loading function is used, the program considers 

those 6 patterns shown in Fig. 5.3-3.   

The program reports deflections at all 1/20th points along spans for 

all skip patterns and enveloped Max and Min results in report 

Section 36.  For Sustained Load combinations, the program 

considers the user-specified portion of live load for creep/long-term 

computations.  Creep Max and Creep Min values are also reported.    

       

Figure 5.3-3 

5. The loading input table as shown in Figure 5.3-1 contains a Label 

column allowing the user to enter notes associated with each 

represented load.  Note that loading notes are not reported in the 

tabular report output but are contained only with the input 

dialogue window.   
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The loading dialogue window contains sorting functions for all input 

columns.  Sorting can be made by Ascending or Descending order or 

can be restored to the original input.  At the title cell for each input 

column, click on the cell to sort by Ascend, click again to sort by 

Descend and click a third time to reset back to the original input. 

   Ascending Order 

 

  Descending Order 

5.3.2 Specify Lateral Loads 

ADAP- PT/RC allows you to specify lateral loads (wind or earthquake 

loads) as unbalanced concentrated moments acting at the face of 

supports. To define these loads: 

1. Go to Criteria→Load Combination.  

2. Check Include Lateral Loads and click Set Values. 

3. Go to Lateral moments tab and input values. (Fig. 5.3-4) 

 

Figure 5.3-4 Lateral Input Data Screen 

4. Click OK. The lateral moments will show on the screen. 
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5.4 Material 

5.4.1 Specify Concrete Material  

This screen is used to enter concrete properties (Fig. 5.4-1).  

 

Figure 5.4-1 Concrete Material Input Screen 

Depending on the code, the concrete weight classification is used in 

shear and/or flexure calculations. Default values of the modulus of 

elasticity are calculated based on the concrete strength, concrete type 

(Normal, Semi-Lightweight, and Lightweight) and appropriate code 

formula. The ultimate creep coefficient is used in the calculation of 

long-term deflections.  The option for concrete strength at stressing is 

used only for PT mode and does not apply to RC designs.   

5.4.2 Specify Reinforcement Material  

This screen is used to specify bar sizes and properties for longitudinal 

and shear reinforcement (Fig. 5.4-2).  For RC mode, the program 

includes entry for Column Strip Allocation.  Here the user specifies the 

percentage of total strip reinforcement to be allocated to the column 

strip in spans, over interior columns, and over exterior columns.  The 

balance of calculated reinforcement is allocated to the middle strips.   
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PT Mode – Two-Way System 

 

One-Way/Beam System (EC2) 
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RC Mode – Two-Way System 

Figure 5.4-2 Steel Material Input Screen 

When entering data for a beam and one-way slab, entry for preferred 

stirrup bar size and number of legs is active. When entering data for 

two-way slab options to select between stirrups and studs is active. 

• If you select Studs the program will ask you to specify stud 

diameter and number of rails per side of a column.  ADAPT-

PTRC includes separate input for number of rails per side for 

individual ‘b’ and ‘d’ column sides.  The ‘b’ side is that 

transverse to the span direction.   

• If you select Stirrups the program will ask you to specify stirrup 

bar size. For EC2 the program gives input for angle of beam or 

slab-to-stirrup and beam or slab-to-compression strut for use 

with inclined stirrups less than 90 deg.  

The preferred bar sizes are used when calculating the number of bars 

required. The bar sizes may be changed on the Summary report, 

however. 

For RC mode, when the European – EC2 code is selected as the design 

code, the program includes the option for the allowable crack width.  

The program adds reinforcement necessary to control the crack width 

to the limiting value.  EC2 methodology is used in calculating crack 

widths and reinforcement.   
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There are 3 new input fields in this input window for two-way shear 

checks in ADAPT-PT/RC.  These include: 

• Include minimum shear reinforcement for drift. 

• Consider octagonal critical sections outside shear reinforced 

zone. 

• Edge distance of rails – This option is required for the 2nd option 

listed above.  

New improvements have been made for punching shear checks in 

ADAPT-PT/RC according to ACI318-14.  The first improvement is the 

option to consider the least critical section as an octagonally-shaped 

section at d/2 outside the last line of reinforcement.  The applicable 

code sections being 22.6.4.2 and 22.6.6.1.   

The second improvement is the option to consider minimum 

reinforcement up to a distance 4*slab thickness to satisfy a minimum 

strength of 3.5*f’c^1/2.  This requirement is found is Section 18.14.5.1 

and is applied to satisfy adequate ductility of members not part of a 

lateral-resisting system in seismic design categories D, E, and F.   

The third improvement applies to the application of minimum 

reinforcement at critical sections as dictated in ACI318-14 Section 

22.6.8.3. The critical section used to determine the minimum amount of 

reinforcement is that of the section located d/2 from face of support.  In 

previous versions of the software, the critical section length as based on 

the section being checked.  In other words, the amount of 

reinforcement necessary to meet minimum became larger each critical 

section (layer) that was checked.  Upon a formal review of the program 

code and the interpretation of design code, this was modified and 

improved.   

The following sections provide more detailed description of the first two 

features described above.   

5.4.2.1 Critical Section Outside the Reinforced Zone 

The option to consider critical sections outside the shear 

reinforced zone with either a rectilinear or octagonal-shaped 

critical section is given in the program. ACI318-14 Sections 

22.6.4.2, 22.6.6.1 apply.  The following images show the 

octagonal-shaped section for compliance with ACI318-14.  

Note this section shape can now also be used for designs 
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performed using all ACI318 versions supported by the 

program.  
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When this option is selected the program determines the 

critical section, based on a rectilinear shape, where no 

reinforcement is required. Each critical section is located at 

d/2 from the previous. At the critical section where no 

reinforcement is required (As = 0), the program rechecks the 

same location but with a reduced critical length and area. This 

is calculated using an octagonally-shaped section and is 

checked until the stress is less than code specified. The user 

can specify the edge distance between the edge of column 

and stud rail or shear stirrups. This value affects the critical 

section length.  

5.4.2.2 Minimum Reinforcement for Drift  

The option to apply two-way shear provisions for minimum 

reinforcement for seismic drift as found in ACI318-14 Section 

18.14.5.1 is now included in ADAPT-PT/RC. The referenced 

provision is found in the excerpt below.  Note that the 

provision is conditional upon a check of the inter-story drift 

ratio at the support location.  However, the program does not 

check this but gives the user the option to directly enforce the 

minimum shear strength as given as 3.5*f’c^1/2.           
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The current expresssions used to calculate As for two-way 

shear is shown below as taken from ADAPT-Technical Note 

TN504.  If the new minimum reinforcement for drift 

requirement is selected, the program checks that the quantity 

in the parentheses is ≥ 3.5*f’c^1/2 for all critical sections with a 

distance 4*slab thickness from face of the support.  Additional 

checks with respect to Av,min still apply as shown below.   

 

5.4.3 Specify Post-Tensioning Material (PT mode only) 

This screen is used to input the post-tensioning system parameters (Fig. 

5.4-3) 
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Figure 5.4-3 Prestressing Material Input Screen 

The information entered here defines the post-tensioned system type 

and is:  (a) used to calculate the ultimate moment capacity of the 

member when the “effective force” calculation method is used. When 

the “tendon selection” calculation method is used, the program 

calculates the effective stress. The stress in the tendon at nominal 

strength (fps) is calculated from the effective stress and the 

reinforcement ratio, and (b) determines the effective force per stand 

used to calculate the final force in the Recycler window when the 

“effective force” calculation method is used. 

5.5 Criteria 

5.5.1 Specify the Design Code  

To select the code: 

1. Click Criteria→Design Code. The Criteria-Design Code dialog 

window will open (Fig. 5.5-1) 
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Figure 5.5-1 Criteria-Design Code Input Screen 

2. Select the design code from the list. 

3. Click Next. This will save input data and open a new input screen 

Design Settings where you can select your analysis and design 

options. 

Note: Depending on the code chosen, material factors and other design 

parameters may need to be entered. These are entered on the Load 

Combinations screen (Fig. 5.5-10). If you model in American or MKS 

units only ACI318 codes are available.  All design selectable design codes 

other than the ACI318 code are active when SI units are used.   

5.5.2 Specify Base Non-Prestressed Reinforcement 

This screen is used to specify base non-prestressed reinforcement (Fig.  

5.5-2). 
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Figure 5.5-2 Base Non-Prestressed Reinforcement Input Screen 

The program allows you to specify a base reinforcement that is taken 

into consideration when designing the structure. You have an option to 

define reinforcement as mesh or isolated longitudinal bars for all system 

types and stirrups for one-way slabs and beams. The position of a bar is 

defined with distances of the first X1 and second X2 bar end to its 

immediate left support.  

For example, Bar 3 starts at 0.8 of Span 2 and ends at 0.2 of Span 3.  
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The user can see the base reinforcement in the 3D 

Structure View window as shown in Figure 5.5-3. 

 

Bars shown in plan. 

 

Bars shown in elevation. 

Figure 5.5-3 Base Reinforcement View 

Multiple entries can be used for stirrups at different spacing increments, 

stirrup size and spacing and the range where the stirrups are applied.  If 

the spacing of the base stirrup entry exceeds the maximum spacing for 

the code selected, the base stirrups are ignored in the calculation.  

Where base stirrups are applied, the program will report a status check 

in Report 12 – Shear Reinforcement as “OK” or “NS.”   

If the base stirrups meet the required area and spacing by calculation, 

“OK” will be reported in the “Base” column of Report 12 and no 

additional reinforcement will be reported.  If “NS” is reported, the base 

stirrups are not sufficient to meet the demand and the program will 

report the demand balance for required reinforcement along with the 

necessary spacing.  This reported reinforcement in Report 12 is in 

addition to the base reinforcement entered by the user.   

5.5.3 Specify Allowable Stresses (PT mode only) 

This screen is used to enter initial and final allowable stresses (Fig. 5.5-

4). 
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Figure 5.5-4 Criteria-Allowable Stresses Input Screen  

Tension stresses are input as a multiple of the square root of f’c, 

compression stresses are entered as a multiple of f’c. The values 

entered for final allowable stresses will be shown on the Stresses 

Compression and Tension tab of the Recycle window. 

5.5.3.1 PT Crack Design Mode/Allowable Crack Width 

When the European – EC2 code is selected as the design code, 

the program includes an option for PT Crack Design 

Mode/Allowable Crack Width in the Allowable Stress screen 

(Fig. 5.5-5).  The user can specify if the design is to be checked 

as an Uncracked or Cracked design.  If the option for 

Uncracked is selected, the options for Unbonded (Quasi) and 

Bonded (Frequent) are grayed out and the RC Sections 

(Quasi) option is active.   

The program treats the Uncracked condition similar to those 

designs performed using the ACI code where if the allowable 

stress is exceeded, the design is No Good (NG) in the Recycler 

Screen and corrective action must be taken to modify the 

tendon force and/or profile to achieve acceptable fiber 

stresses.    

For an Uncracked design, any design section that does not 

include post-tensioning is considered a RC section.  The 
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program calculates and limits cracking to the user specified 

value for allowable crack width by adding reinforcement to 

the slab or beam.   

If the option for Cracked is selected, the user can set 

allowable crack widths for Unbonded (Quasi) and Bonded 

(Frequent) conditions, in addition to the RC Sections option.  

If the allowable stress is exceeded for either condition, the 

program will calculate and limit cracking to the user specified 

value for allowable crack width by adding reinforcement to 

the slab or beam.   

                

Figure 5.5-5 Criteria – PT Crack Design Mode  

Crack widths and required reinforcement to limit crack widths 

are calculated using methodology outlined in the EC2-2004 

code.  

The program graphically reports allowable and calculated 

crack widths for those combinations selected to be checked 

by the user (Fig. 5.5-6).   

                 

Figure 5.5-6 Crack Width Diagram  
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5.5.4 Specify Recommended Post-Tensioning Values (PT mode only) 

This screen allows the user to specify minimum and maximum values for 

average pre-compression (P/A; total prestressing divided by gross cross-

sectional area) and percentage of dead load to balance (Wbal) (Fig. 5.5-

7).  

 

Figure 5.5-7 Criteria-Recommended Post-Tensioning Values 

These values are used by the program to determine the post-tensioning 

requirements shown on the Tendon Forces and Heights tab of the 

Recycle window. They are also used to determine the status of the 

Pmin/Pmax and Wbal Min/Max indicators on the Recycle window.  

If data is being entered for a one-way or two-way slab, the bottom of 

the screen will ask for the maximum spacing between tendons. This is 

entered as a multiple of the slab thickness (i.e. 8 x slab thickness). The 

program does not check tendon spacing. However, this is something 

that must be checked on the shop drawings. Tendon spacing is typically 

more of an issue for detailing than design but on very thin, very lightly 

loaded slabs, it may govern the design. 

5.5.5 Specify Calculation Options (PT mode only)  

This screen is used to select the post-tensioning design option (Fig. 5.5-

8).  
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Figure 5.5-8 Criteria-Calculation Options Input Screen  

The two options are Force Selection and Force/Tendon Selection. Force 

Selection is the default option. To use Tendon Selection, the 

Force/Tendon Selection option must be specified.  

If Force/Tendon Selection is specified, the screen will prompt for the 

information required to calculate the prestress losses. The values given 

as defaults are typical in the industry and should be used unless more 

accurate information is available. Long-term losses may either be 

entered as a lump sum value, or the information required to calculate 

them may be entered.  

5.5.6 Specify Tendon Profile (PT mode only) 

This screen allows the user to specify the tendon profiles (Fig. 5.5-9).  
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Figure 5.5-9 Criteria-Tendon Profile Input Screen 

The parameters used to define the tendon are shown in the schematics 

at the top of the screen. The profile and values shown, a reversed 

parabola with the low point at mid-span and inflection points at span 

length/10, are the defaults. These are typical industry defaults; they will 

be appropriate for most designs with essentially uniform loading. Note 

that if a non-standard profile, i.e. a low point at somewhere other than 

mid-span is used, this must be clearly called out on the structural 

drawings. Transfer girders and slabs with heavy concentrated loads may 

require a harped profile. The low point is usually specified to coincide 

with the column being transferred or the concentrated load. 

Tendons in the model can have up to three different profiles. To define 

all three profiles, fill in data in the tables of tab Tendon A, Tendon B, 

and Tendon C.  

You have an option to define length and shape of tendon extension that 

terminates at the interior of a member.  

You have the option to select the option to set tendon ends using CG of 

effective section.  If left unchecked, the tendon ends will be set using 

the CG of the gross cross-section.   

5.5.7 Specify Minimum Covers  

This screen is used to specify minimum covers for both the post-

tensioning tendons and mild-steel reinforcement (Fig. 5.5-10).  
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Figure 5.5-10 Criteria – Cover/CGS Input Screen 

Note that the cover for the pre-stressing steel is specified to the center 

of gravity of the strand (cgs) whereas, for mild steel, it is clear cover. For 

½ in. strand, the clear cover on the tendon will be ¼ in. less than the 

distance to the cgs.  Only the Non-prestressed Reinforcement cover 

input applies to designs performed in RC mode.  

5.5.8 Specify Minimum Bar Length  

This screen is used to define how mild steel reinforcement bar lengths 

are calculated (Fig. 5.5-11).  

 

Figure  5.5-11 Criteria-Minimum Bar Extension Input Screen 

The values entered for cut-off lengths apply only to PT designs and are 

used to calculate top and bottom bar lengths when minimum 

reinforcement requirements govern. The lengths of bars required for 

ultimate strength are calculated from the reinforcement necessary to 
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supplement post-tensioning at 1/20
th points along each span. Bar 

lengths for steel required for ultimate strength will include the specified 

extension lengths.  When performing designs in RC mode, only the 

development length option for strength reinforcement is active and 

applicable.   

5.5.9 Specify Reinforcement Curtailment 

The program determines minimum bar lengths for calculated 

reinforcement from location of zero moment and with respect to the 

input for Minimum Bar Extensions and Development Lengths as 

described in the previous section.  In addition to these settings, the 

program includes customizable Rebar Curtailment settings for top and 

bottom longitudinal reinforcement.  Figure 5.5.-12 and 13 show the 

dialogue windows for the input settings related to rebar curtailment.  

When used, these settings supersede the default reinforcement output.  

Where the calculated lengths related to curtailment are less than the 

stored default lengths, the program ensures a safe design by using the 

default lengths.   

Entries can be made for Cantilevers, Exterior spans, and Interior Span 

conditions for top and bottom rebar placement.  A fraction of the total 

enveloped area of steel required can be designated for Longer Bars and 

Shorter Bars.  Bars can be input as any fraction of the span length to 

which they belong.  Note that the total fraction of span length for longer 

bars must be greater than that for shorter bars.  For example, the 

program would not accept a value of 0.25*L for a Longer Bar and 0.33*L 

for a Shorter Bar.  A minimum number of bars can be entered as part of 

the input.  If the enveloped bar requirement is calculated as 1#8 bar and 

a user has made an entry for 3 bars minimum, the program uses 3#8 

bars and applies the curtailment input to the equivalent area of steel 

calculated from 3#8 bars.  Note that the curtailment rules do not apply 

to user-defined base reinforcement but only that reinforcement 

calculated by the program.  

The program provides default options for curtailment rules based on 

User-defined settings, ADAPT settings, ACI318 and EC2.  Curtailment 

rules can be turned off and reinforcement arrangement output defaults 

to rules based on the Bar Extension input as shown in Figure 5.5-11. 

Settings made to the Reinforcement Curtailment dialogue window can 

be saved as a template file and stored for broad user across multiple 

users.  To save settings select the File Save tab under the Curtailment 

File settings.   
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Figure  5.5-12 Criteria-Reinforcement Curtailment – Top Bars 

 

Figure  5.5-13 Criteria-Reinforcement Curtailment – Bottom Bars 

The reinforcement output relative to settings made in the 

Reinforcement Curtailment input is realized in two areas: 
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1. BuilderSum – Summary Report  

When the Summary Report is generated, the reinforcement output 

show for Top and Bottom bars is calculated from the curtailment 

settings.  The curtailment rules are ONLY REFLECTED when the 

Envelope of reinforcement is selected.  If a Service, Strength or 

Initial load combination is selected, the reported reinforcement is 

based on the default values relative to the minimum bar extention 

and development length input. To make modifications within the 

Summary Report, select the Options>Reinforcement Curtailment 

selection to open the curtailment dialogue window.  Modifications 

can be made and applied for real-time adjustments.   

 

2. Tabular Report Block 10.2 – Provided Rebar Report 

The Provided Rebar report generated by use of the Report 

Generator outputs spans and specific locations, quantities and 

lengths of the provided reinforcement calculated by the program.  

Where curtailment is used in a design, the lengths are reflected in 

this report.   

In BuilderSum, from the Options>Reinforcement Schedule selection, 

the reinforcement output can be generated in a schedule format as 

shown in Figure 5.5-14.  
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The schedule can be saved in .XLS format for collataing results from 

other ADAPT-PT or RC runs.  The schedule contains:  Project 

Information, Bar Mark, Bar Size, Bar Diameter, Bar Length, Shape Code, 

Bar Bend Tags, Area of steel for bars and Bar Weight.   

 

Figure  5.5-14 ADAPT-BuilderSum – Reinforcement Schedule 

5.5.10 Specify Load Combinations 

This screen is used to define the load combination factors for service, 

strength (ultimate), and initial load (PT mode only) conditions. It also 

gives access to the input screens for lateral loads and lateral loads 

combinations described in Section 5.3.2 and is used to enter any 

applicable material factors or strength-reduction factors. The default 

values depend on selected design code. 

Note for RC mode, service combinations replicate those in PT mode.  

The program defaults to the same combinations shown below except 

for the Initial load combination.  This is active only for PT mode.   

The program automatically calculates minimum reinforcement for RC 

systems based on the design code selected and the system type for 

Sustained and Total Service conditions.  Oftentimes, the minimum 

reinforcement requirements for these conditions is identical for RC 

systems.  PT systems must be checked for serviceability requirements of 
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pre-compression, tensile and compressive stress, and balanced loading 

for each service combination, hence, load combinations for Service 

conditions are active.   

In the instance where a PT model contains spans or portions of spans 

that are RC (no post-tensioning force intersecting the design sections), 

the program is able to determine necessary Strength and Service 

reinforcement for the hybrid model and envelope the reinforcement 

accordingly.  

 For example, a two-way post-tensioned slab over supports requires 

0.00075*Ac checked in each direction at the support.  A two-way 

reinforced concrete slab is subject to minimum temperature and 

shrinkage steel that requires 0.0018*Ag.  If two adjacent sections in a 

model are “PT” and “RC” sections, based on the positioning and 

termination of the tendons, the program reconciles the controlling 

reinforcement over the support and is able to envelope the correct 

amount.   

For the calculations of ultimate (Strength) reinforcement at an RC 

section included in a PT model, the program’s design algorithm assumes 

zero force/stress and area for Fps and Aps and calculates the necessary 

reinforcement as it would in ADAPT-RC mode.   

 

PT and RC mode 

Figure 5.5-15 Criteria-Load Combination Input Screen 

To define load combinations that include lateral loads check Include 

lateral load option and click Set Values. The Lateral Input Data window 

opens (Fig. 5.5-16).  
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Figure 5.5-16 Lateral Input Data Input Screen 

If you answer “Yes” to the Do lateral loads change sign? the program 

will internally consider a new load combination with the modified sign 

of lateral load and report results for it. PT to resist Factored Moment 

option is used to specify the percentage of contribution of post-

tensioning to unbalanced moment due to lateral loads. Note that this 

option will not be available if in the Design Settings window you select 

to disregard contribution of prestressing in strength check.   
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6 Program execution Overview 

The program can be executed either by selecting the Execute item on the Main Program 

window or clicking the Execute Analysis button,  on the Main Toolbar. 

The program begins by reading the data files and performing several preliminary data 

checks. If an error is detected, the program will stop and display a message box 

indicating the most likely source of the error. The data consistency checks are not 

exhaustive, however, which means that the user is ultimately responsible for ensuring 

that the data is entered correctly. 

In RC mode, when the model analysis is run, the program will directly run through 

multiple calculations for the general frame analysis, deflections and reinforcement and 

return to the Main Program window. The results can then be viewed and/or printed.   

In PT mode, the program can be executed in Automatic or Interactive mode. In the 

automatic mode, the program attempts to select a post-tensioning force and profile 

within the design bounds specified by the user. If a solution is possible, the program will 

complete the calculations and return to the Main Program window. The results can then 

be viewed and/or printed. If a satisfactory solution is not possible, the program will 

display a message box, which describes the problem and will switch to the interactive 

mode. The user can then decide whether it is possible to change the original design 

criteria and continue with the design.  

The automatic mode begins by assuming the maximum drape for each span and 

determining the minimum force, which satisfies the maximum allowable tensile 

stresses. The same force is used for all spans. The force is then adjusted to meet the 

following requirements as specified by the user: 

• Minimum percentage of dead loading to balance for each span. 

• Minimum average precompression for each span. 

• Maximum spacing of tendons (applies only to slabs). 

After these initial adjustments, each span is checked for compliance with the following: 

• Maximum percentage of dead loading to balance: if the balanced loading in 

any span exceeds the maximum percentage specified by the user, the program 

adjusts the tendon drape in that span to lower the balanced loading. It then 

recalculates the balanced loading and the related moments. 

• Average precompression and compressive stresses: if either the average 

precompression or the compressive stresses exceed the maximum permissible 

values, the program will stop and display a message box. It then switches to the 

Interactive mode and displays the Recycle window. 
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The interactive mode gives the user an opportunity to optimize the design by adjusting 

the tendon forces and tendon drapes in each span. It can be executed using either the 

Force Selection or Force/Tendon Selection mode.  

The program begins by going through the same calculations that it goes through for the 

Automatic mode. After it has determined an initial tendon force and profile however, it 

displays the PT Recycling window shown in Fig. 6-1  

 

Figure 6-1 PT Recycling Window 

The PT Recycling window is comprised of five tabs which display information about the 

post-tensioning design, a Design Indicator box which summarizes the status of the 

current design, a Status indicator and four control buttons: Recycle, Recall, Graphs and 

Exit.  

6.1 PT Recycling Window Tabs 

The PT Recycling Window tabs are: 

• Tendon Force & Heights Tab. This screen allows the user to select the 

tendon profile, adjust the tendon heights and post-tensioning forces 

(Fig. 6.1-1).  
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Figure 6.1-1 

The table lists the post-tensioning forces at the midpoint of each span, 

the tendon heights at the left, center and right of each span, the 

average precompression at mid-span (P/A mid) and the percentage of 

dead loading balanced in each span (Wbal % DL) for current tendons and 

all tendons. 

You can select either single tendon or multiple tendon paths for the 

force selection method. You can select the tendon (A, B or C) to 

evaluate when the Multiple Tendon Path is selected.  If Single Tendon 

Path is selected, then only Tendon A will remain as an option for the 

analysis.  For Multiple Tendon Path, the PT force must be the same for 

each tendon group.  The user can modify the calculated force reported 

in PT Force per unit width and PT Force cells.  For Single Tendon Path, 

the PT force can vary along the length of the structure by entering 

unique values in the cells.   

Adjustments in tendon force, and/or tendon height may change the 

average precompression and the percentage of dead load balanced. 

These changes are reflected in the P/A and Wbal columns as the changes 

are made. To see how the changes, affect the stresses and average 

precompression at locations other than mid-span, however, it is 

necessary to recycle the window. 

The Typical Values Row option allows for the inclusion of a typical 

values row in the Tendon force and height table. By activating this 

option, values entered in the TYP row, followed by hitting the Enter key, 

are populated into all the cells in that column.   
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• Required and Provided PT Force Tab. The PT forces tab shows the PT 

forces provided in the left, center, and right region of each span as well 

as the forces required in each region for minimum P/A and allowable 

tensile stresses (Fig. 6.1-2).  

 

Figure 6.1-2 

The post-tensioning force provided in each region is compared with the 

governing minimum force in that region as shown on the Required 

Forces tab. If the provided force does not envelop the required values, 

FORCE NG (No Good) is displayed in the indicator box at the top of the 

screen. Forces that are less than what is required will be highlighted in 

red in the Provided PT Force columns. 

• Required PT Force Tab. This tab shows the required post-tensioning 

forces for only the most recently calculated profile (Fig. 6.1-3).  

 

Figure 6.1-3 
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Note that all values in the tables are forces and that these forces refer 

to the entire tributary width entered in the geometry input.  

The window consists of three sections: The left (light blue) boxes display 

the governing forces for the left, center, and right region of each span. 

The force selected for each region is the largest required force based on 

tensile stresses in that region, minimum P/A, and minimum percentage 

of dead load to balance.  

The middle (light yellow) boxes display the forces required for tensile 

stresses. If the moments in a particular region are such that no 

post-tensioning is required, a zero (0) is shown. 

The first column of the right (light green) section is the post-tensioning 

force required to satisfy the minimum average precompression 

specified by the user, based on the member’s cross-sectional area at 

mid-span (P/A mid). Average precompression P/A is not a function of 

the applied loading or tendon profile. 

The second column of the right section (Wbal %DL) is the force required 

to provide an uplift equal to the minimum percentage of the total dead 

load specified by the user. The force required for each span depends on 

the tendon geometry and loading of that span. All the dead loads, 

including superimposed dead load, are summed for each span, 

regardless of whether they are self-weight, uniform or concentrated. 

Note that when calculating Wbal for display on this screen, the 

downward tendon forces are not included. This approximation is made 

only for the purposes of obtaining a rapid screen display. The actual 

computations of moments and stresses include all equivalent loads 

from each tendon. 

• Extreme Fiber Stresses Tab. This tab shows the maximum tensile and 

compressive stresses in the left, center, and right regions of each span 

(Fig. 6.1-4).  
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FIGURE 6.1-4 

The stresses are calculated at 1/20th points and the highest stress in 

each region is displayed. If any of the stresses displayed are more than 

the allowable value, they will be highlighted in red. If the stress at any of 

the 1/20th points exceeds the allowable value, an NG warning is 

displayed in the indicator box. The location of the critical stress values 

can be determined by looking at the Stresses Recycle graph.  

Tensile stresses are shown as a ratio of the square root of the concrete 

compressive strength at 28 days (f’c
1/2). Compressive stresses are 

shown as a ratio of f’c. The allowable stress values are shown for 

reference. 

• Tendon Selection and Extents Tab. This screen is used to edit tendons. 

The options in this window will change depending on the PT selection 

method you chose in recycling screen. 

If you select Force selection, the screen will allow you to change the 

stressing ends of all the tendons and tendon extents of additional 

tendons B and C (Fig. 6.1-5). To change tendon extents, position the 

mouse cursor over the tendon end and drag the end to its new location. 

To change tendon ends (Stressing/Fixed), position the mouse cursor 

over the tendon end, left click while holding down Shift key. You can 

also use the table to the side of the tendon layout to enter/change  the 

locations of tendon types B and C. These tendons must be at least 1 

span length long but can be located anywhere along the length of the 

member.   The values of the Left End location start at 0.0, at the far-left 

end of the modeled structure, and the Right End Location will vary, up 

to the number of spans modeled.  The table values will update as the 
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mouse is used to change the tendon extents graphically, and the 

graphical view will update if the values are entered into the table.   

 

Figure 6.1-5  

If you select Tendon Selection, you will be able to edit the number of 

tendons, change the length of short tendons and stressing ends (Fig. 

6.1-6).   

 

Figure 6.1-6  

The tendon ends and extents can be modified as described above.  In 

this case, the table also shows the Average Force and Selected Number 

of tendons for each tendon group. The average force in each strand is 

the force after all losses. Note, however, that the average forces are not 

actually used in the calculations.  They are displayed to provide the user 
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with a measure of the relative efficiency of each strand type.  You can 

edit the number of strands per each tendon type, and the extents of the 

short tendons.  You can choose to anchor ends of short tendon types B 

and C at the centroid of the concrete section.  Once all changes have 

been made, Recycle the screen to make sure all changes are included in 

the calculations.   

6.2 Design Indicator Box 

 

Figure 6.2-1 

The status of the current design is summarized and displayed in the Design 

Indicator box at the top center of the Recycle window. Each design check is 

identified as either OK or NG (No Good).  For cracked designs performed using 

the European code – EC2, the program will also indicate if the calculated stress 

exceeds the allowable tensile or compressive stress by CR (Cracked).  

The items displayed in the Design Indicator Box are as follows: 

• Iteration No: # . Each time a force or tendon height is adjusted and 

recycled, the program recalculates the related balanced loadings, 

moments, stresses, average precompression and percent of dead load 

balanced. Each set of calculations is referred to as a cycle. The number 

of cycles executed for a particular design is shown in the Iteration block. 

In most cases two to three cycles are adequate to arrive at an 

acceptable solution. It is rarely necessary to exceed five cycles. 

• Weight of PT: ### lb/ft2 or ### kg/m2. The weight of post-tensioning 

strand required to provide the selected forces is estimated and 

displayed in either pounds per square feet or kilograms per square 

meter.  

The weight is estimated as follows: The force supplied by each strand is 

calculated based on its cross-sectional area and final effective stress, 

both of which are values input during data entry. The number of strands 

required to provide the forces shown on the Tendon Forces and Heights 

tab is then determined. The actual length of each strand is assumed to 

be its calculated length plus 3 feet (1 meter) to allow for a stressing tail. 

If the force changes between successive spans, it is assumed that the 

larger force extends over the common support and the tendons are 



   

  83  

anchored at 1/5 of the next span if otherwise specified by user. If the 

forces are modified, the weight is recalculated and displayed after the 

window is recycled. 

• PT Force min OK   PT Force max OK. This block compares the average 

precompression at mid-span with the minimum and maximum values 

entered by the user. If the average precompression is above or below 

the specified limits, an NG is displayed. 

Note that although the PT Force indicator considers the P/A all along 

the span, this block only considers the P/A at mid-span. If the P/A is 

above or below the specified limits in a support region, the Pmin and Pmax 

indicators will show OK, however the PT Force indicator will show NG.  

In two-way slabs with drops or transverse beams the cross-sectional 

area at the supports will be much larger than the cross-section at mid-

span. Providing the minimum P/A at the supports may result in a much 

higher PT force than necessary. The program determines the required 

force for the min/max range based on the cross-sectional area at mid-

span.  This may result in a precompressive stress at supports being 

lower than the specified minimums. 

The PT Forces tab (Fig. 6.1-2) shows the post-tensioning force required 

in each of the three regions of each span. 

• Balanced DL Min OK, Balanced DL Max NG. The total upward force of 

the tendon (Wbal) in each span is computed from the post-tensioning 

force in span and the tendon geometry in the span. This upward force is 

compared with the total dead loading on the respective span. An OK for 

both Wbal Min and Wbal Max means that the ratio of balanced loading 

to the total dead loading is within the limits specified by the user in all 

spans. The percentage of dead load balanced in each span is shown on 

the Tendon Force & Heights tab (6.1-1). The force required to balance 

the specified minimum percentage of dead loading is shown on the 

Required Forces tab (Fig. 6.1-3). 

• Stresses (service) or (initial): Tens  OK, Comp  NG. This block compares 

the tensile and compressive stresses with the allowable values specified 

by the user. The maximum stresses in each span are shown on the 

Extreme Fiber Stresses tab (Fig. 6.1-4). If the compressive stress or 

tensile stress exceeds the allowable limits, the values will show in red in 

that tab, as appropriate, under Sustained, Total, or Initial load 

conditions.  In addition to this the program will prompt warning 

message (Fig. 6.2-2) if the compressive stress exceeds allowable stress 

for the initial condition.  
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Figure 6.2-2 

6.3 Recycle Window Control Buttons 

 The Recycle button causes the stresses and required forces along the 

member to be recalculated based on the current tendon profile and 

forces.  

If changes are made to either the tendon profile or force in any span, 

the status indicator at the top right of the Recycle window will begin to 

flash. Once all the changes are made, click on the Recycle button to 

update all the tabs, the Design Indicator box, and the Recycle Graphs. 

 The Recall button allows the user to undo editing changes by recalling 

the tendon forces and profile from the previous recycle. After selecting 

Recall, the window must be recycled again to update the tabs, the 

Design Indicator box, and the graphs. If the Single Tendon Path was 

originally selected, with non-constant PT force, and then Multiple 

Tendon path is selected, the program will give you the warning shown in 

Fig 6.3-1. You must click cancel and select single tendon path to keep 

the non-constant PT force, if you click “OK” force will be made constant 

due to multiple tendon path selection. 

 

Figure 6.3-1 

 



   

  85  

  The Graphs button displays a set of three graphs which provide detailed 

information on the tendon profile, the tension and compression 

stresses and the required versus provided post-tensioning forces. The 

Recycle graphs are shown in Fig. 6.3-2.  

The graphs are as follows: 

• Tendon Height. The Tendon Height graph can be used as a 

means of verifying that the tendon profile is at least reasonable. 

This graph allows the user to see the tendon profile either by 

itself or as it relates to the member elevation (concrete outline). 

This can be helpful for finding input errors such as a tendon 

profile that extends outside the member, or a profile that is not 

continuous. The concrete outline shows all steps, drop 

caps/panels, transverse beams, and changes in thickness. 

 

Figure 6.3-2 

• Stresses. This graph plots the maximum compressive and tensile 

stresses at the top and bottom face of the member. All types of 

loadings can either be shown separately or combined. The 

Display allowable/computed stresses options show the 
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combined stresses along with an envelope of the allowable 

stresses. The graph provides easy interpretation of stress results 

and clearly shows if stress limits are exceeded.  All stress graphs 

in Recycler and BuilderSum report the max and min stresses for 

the system.   

 

• Post-tensioning. This graph shows the required and provided 

post-tensioning force at 1/20th points along each span. 

The graphs may be configured to show only certain spans and 

values by clicking on the check boxes at the left of the 

window. To maximize a graph for detailed viewing or change 

the display options, right-click on the desired graph and use 

the editing menu that opens.  

  Selecting the Exit button closes the PT Recycling window and 

starts calculations of internal forces, deflection and 

reinforcement based on the most recent tendon force and 

profile selection. At the conclusion of the calculations, the user 

is returned to the Main Program window. The Results Report, 

the PT Summary Report and the Results Graphs may then be 

viewed and/or printed. 

Note: If force or profile adjustments are made and you did not click on 

Recycle button before exiting, the program will automatically do a 

Recycle. 

6.4 PT Selection Method 

If you select Force/Tendon Selection option in the Criteria - Calculation Options 

screen you may choose between the Force selection and Tendon selection 

modes in the PT Recycling window (Fig.  6.4-1) 
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Figure 6.4-1 

6.4.1 Force Selection Method 

It assumes that a tendon will be assigned a final and constant effective 

force equal to the jacking force minus all stress losses expressed as a 

single representative value.  

6.4.2 Tendon Selection Method 

The Tendon Selection method is a newer, more accurate procedure 

than force selection method. In the Tendon Selection method, the post-

tensioning force is assumed to vary along the length of the tendon. The 

variation accounts for stress losses in the tendon due to both immediate 

and long-term effects. It also includes consideration of the interaction 

between the various sources of loss. It is thus more accurate than 

procedures which account for losses as a lump sum approximation. 

In Tendon Selection mode, the actual number of strands, as opposed to 

effective forces, may be specified. The user can see what the final 

stresses will be and can adjust the number of strands, short tendon 

locations, the tendon profiles, and the stressing ends, as necessary. At 

each design section along a span, the program performs an analysis 

based on the post-tensioning force at that section. Consideration is 

given to both short-term (friction, seating loss) and long-term (elastic 

shortening, creep, shrinkage, and relaxation of the prestressing steel) 

stress losses.  

If the tendon profile is altered, friction and long-term losses are 

recalculated, and the revised tendon forces are used for the 

computations. If the tendon forces have changed significantly, however, 

the selected profile may not be satisfactory. The solution thus becomes 

iterative since subsequent changes to the profile will also result in 

changes to the tendon forces. The iteration is automatically continued 

until an acceptable solution is reached.  
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6.4.2.1 Description of Features 

Tendon types. For each member, up to three tendon types, A, 

B, and C, may be specified. Each type can be configured to 

have a different length and different stressing/fixed ends. A 

given tendon type may include one or more strands.  

Figure 6.4-2(a) shows a five-span beam with three different 

tendon arrangements. Tendon A extends the entire length of 

the beam and is stressed at both ends. It is shown in Fig. 6.4-

2(b) as a straight line with two arrowheads representing the 

stressing ends.  

The other two tendon types, B and C, start at either end of 

the beam and extend only part way through the member. The 

short vertical lines signify a fixed (non-stressing) end.  

Figure 6.4-2(c) illustrates the shapes that the different tendon 

types can assume. Tendon type A must extend from one end 

of the member to the other. It can be stressed at one or both 

ends. Tendons types B and C can be configured the same as A, 

the same as one another, or completely different. They can be 

stressed at one or both ends.  So long as Tendon types B and 

C are in at least one span, the tendon ends can be anchored 

internally and are not required to be fixed at one end.  

Under normal conditions, the three tendon types will be 

configured differently. A post-tensioned member may not 

need all the three tendon types, however. Many members 

have only a Type A tendon. Type B and C tendons are typically 

configured to provide additional post-tensioning in end spans 

if necessary. 
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Figure 6.4-2 

The number of strands in each type of tendon, and 

consequently the force in each tendon will usually be 

different. Tendons can have different profiles.  

Stress Loss Calculations. There are two types of prestress 

losses:  

• Immediate losses which occur at the time the tendon is 

stressed, and  

• Long-term losses which may continue for several years.  

 

The final effective force in the tendon is the jacking force 

minus all losses. 

The immediate losses, friction, and anchorage seating are 

calculated based on the user-input friction parameters 

together with the tendon’s profile and stressing configuration. 

The stress in the tendon immediately after it is seated, with 

due allowance for friction and seating loss, is referred to as 
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the initial or lock-off stress. Although friction coefficients are 

different for grouted (bonded) and unbonded systems, the 

friction loss computations are essentially the same. 

There are three options for long-term stress loss calculations: 

• Lump sum entry. A lump sum value may be calculated 

by the user and entered during data input. The effective 

stresses in the tendon are calculated by subtracting this 

value from the initial stresses. Since the friction and 

seating losses cause the initial stresses to vary along the 

tendon, the effective stresses will also vary.  

• Long-Term Loss calculations for unbonded tendons. 

For unbonded tendons, the strain in the tendon at any 

given point is not directly related to the local strain in 

the concrete. The program can calculate an average 

long-term loss value for the entire tendon based on the 

average precompression in the member and expected 

losses due to shrinkage, creep, elastic shortening and 

relaxation of the prestressing steel. The effective 

stresses in the tendon are calculated by subtracting the 

average long-term loss value from the initial stresses. 

• Long-Term Loss computation for grouted tendons. 

Long-term stress losses in grouted tendons are a 

function of the local strain in the concrete. Long-term 

losses are thus computed at 1/20th points along the 

tendon. The effective stress at each point is the jacking 

stress minus the friction, seating loss and long-term 

stress losses at that point. The long-term losses are 

stored in the file LTLOSS.DAT. This is a text file and can 

be viewed with any text editor or word processor. 

6.4.2.2 Description of Execution 

The Tendon Selection & Extents tab (Fig. 6.4-3) becomes 

active when the Tendon Selection mode is chosen. 
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Figure 6.4-3  

The right side of the tab shows the average force in each 

strand and the number of strands selected for each tendon 

type. The average force in each strand is the force after all 

losses. Note however that the average forces are not actually 

used in the calculations. They are displayed to provide the 

user with a measure of the relative efficiency of each strand 

type. 

The left side of this screen shows a symbolic representation of 

the spans and the tendon layout. The default layout is a Type 

A continuous tendon stressed at both ends of the member, a 

Type B tendon stressed from the left and extending over the 

leftmost span and a Type C tendon stressed from the right 

and extending over the rightmost span.  

You can edit the post-tensioning layout by: 

• Adjusting the tendon profiles. Tendon heights are 

edited on the Tendon Force & Heights tab. Note that 

when the Tendon Selection option is active, you cannot 

access the Force column on this tab. In the Tendon 

Selection option, forces are calculated based on the 

number of strands and the final stresses in the strand. 

• Editing the number of strands in a tendon type. The 

number of strands to use for each tendon type is shown 

in the Selected Number column. These numbers may be 

changed independently of one another. To delete a 

tendon type, set the number of strands to zero. To add 
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a tendon type, enter the number of strands to use for 

that type. 

• Changing the stressing ends and/or extent of the 

tendons. To change a tendon end from dead to 

stressing or stressing to dead, hold down the Shift key 

and left click once at the end of the tendon. Clicking a 

second time will change the tendon back to its original 

configuration. Note that the tendon must have at least 

one stressing end. To change the extent of a Type B or C 

tendon, position the cursor over the tendon end, hold 

down the left mouse button and drag the end to the 

desired location. The table to the side of the tendon 

layout can also be used to change the location of 

tendon types B or C.  These shorter tendons must be at 

least 1 span length long but can be located anywhere 

along the length of the member.  The table will 

automatically update as the mouse is used to update 

the tendon extents graphically, and the graphical view 

will update if the values are entered into the table.  

If any changes are made to the tendon profiles or number of 

strands, the window must be recycled to recalculate the force 

provided. There is no limit on the number of changes that can 

be made or the number of times the window can be recycled. 

Once an acceptable post-tensioning layout has been 

determined, select Exit to continue with the calculations. 

Clicking on the Force Selection button at the top of the 

Recycle Window will toggle the program back to the Force 

Selection mode. Any changes that have been made while in 

the Tendon Selection mode will be reflected in the forces 

shown on the Tendon Force & Heights tab.  



   

  93  

7 View/Validate Results 

After the analysis is executed a graphical report can be generated. The ADAPT 

BuilderSum module opens and enables you to generate comprehensive graphical 

reports for each ADAPT-PT/RC run. You have an option to display and print results 

graphs for each load combination and generate a report that summarizes all post-

tensioning parameters, rebar requirements and shear checks on a single page of output.  

7.1 ADAPT-BuilderSum Screen 

To invoke ADAPT BuilderSum, click on the Open the BuilderSum button, ,  or 

select the PT or RC Sumary menu item from the View menu in the Main 

program window. The window will open as shown in Figure 7.1-1.  

 

 

 

Figure 7.1-1 

BuilderSum Title Bar. Contains program name, and name and location of the 

opened file. 

BuilderSum Menu bar. Menu bar lists all available menus in ADAPT-BuilderSum 

module.  

BuilderSum Toolbar. This toolbar contains all available tools in the ADAPT-

BuilderSum screen.  

BuilderSum Menu bar 

BuilderSum Toolbar 

Combination List  

Status bar 

BuilderSum Title bar 
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Status Bar. Status bar gives you information about units, current date, and time.  

Combination List. This is a drop-down list that contains all available load 

combinations.  

7.2 ADAPT-BuilderSum Menu Items and Corresponding Tools 

All options that can be accessed by the BuilderSum program menus are listed 

below. For the commands that might be activated using the toolbar, the 

appropriate icon is displayed next to the feature. 

7.2.1 File Menu 

Export Graph. Allows you to export the currently active result graph or 

summary report as either a bitmap (.BMP) file or a Windows metafile 

(.WMF). The graph or report must first be set up with the desired 

information and in the desired format.  

Export to DXF File. Allows you to export the tendon profiles to a 

Drawing Exchange Format (DXF) file.  If installed on your computer, 

AutoCAD will launch, and the file will automatically open after the file is 

created.  

Print. This tool prints active result graph with frame containing project 

information or active Summary Report.  

When you print a graph the program will display the Print Graphs 

Option screen (Fig. 7.2-1) where you have an option to select sheet 

orientation and add additional comments that will appear at the bottom 

of the graph (Fig. 7.2-2).  

 

Figure 7.2-1 
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Figure 7.2-2 

Page/Print Setup. This option allows you to specify the printer, set the 

margins or the orientation of the reports.  

Exit. Exits the BuilderSum Module. 

7.2.2 Graphs Menu 

Summary. When you select this option the  Summary Report window 

will open with a default format for the Summary report as shown in Fig. 

7.3-1.  

View All Graphs. This option will show all available graphs for selected 

load combination or envelope. 

Forces Diagram. This tool displays forces diagram for selected load 

combination or envelope (Fig. 7.2-3).  

 

Figure 7.2-3 
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Moment Diagram. This tool displays bending moment diagram for 

selected load combination or envelope (Fig. 7.2-4).  

 

Figure 7.2-4 

Stresses Diagram (PT mode only). Displays calculated stresses for 

selected initial or service load combinations (Fig. 7.2-5).   

Note: this tool will not be active if you select strength load 

combinations.  

 

Figure 7.2-5 

Rebar Diagram. Displays calculated rebar for the selected load 

combination or envelope. The graph shows required rebar calculated at 

1/20th points and provided rebar (Fig. 7.2-6).  
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Figure 7.2-6 

Crack Width. Displays allowable and actual crack width diagrams for 

Unbonded (Quasi) and/or Bonded (Frequent) load combinations when 

user defined for prestressed designs performed with the European code 

– EC2.  For RC designs using the same code, the allowable and actual 

crack width diagrams are generated for the Quasi-permanent load 

combination.  (Fig. 7.2-7).  

 

Figure 7.2-7 

7.2.3 Options Menu 

Summary options. Displays summary report setup window (Fig. 7.3-2 

(a)-(c)). It has the same function as Report Setup button, , on the 

Span Selection toolbar.  
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Graph properties. Configures the graphs generated by the program. 

Options include whether to include X and Y gridlines, min/max data 

points and a legend. 

7.2.4 Window Menu 

This menu lists which of the graph windows are open. The graphs may 

be stacked vertically for scrolling, or the windows may be cascaded. 

7.2.5 Help Menu 

Documentation. Opens the folder where documentation is stored on 

the local machine.  

7.3 PT Summary Report  

The Figure 7.3-1 shows Summary report as it opens once you select Summary 

from Graphs menu, or click on Summary report button, , in the main toolbar.  

Note the second page of the Summary reports graphical and tabular enveloped 

deflection results. 
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Figure 7.3-1 

The format of Summary report can be modified using the Span Selection 

Toolbar. With this toolbar you can select which of the data blocks to print, or 

you can recalculate the mild steel requirements using a bar size which is 

different from what was initially specified in the ADAPT run. In addition, you can 

select to print the report in color or black-and-white, portrait or landscape, and 

on a variety of paper sizes. After the data blocks are selected, the report is 

automatically rescaled to fit the specified paper size. The following is the 

description of the Span Selection Toolbar. 

 

7.3.1 Span Selection Toolbar  

 

 Report Setup. To specify what information to print, select the 

Report Setup. A window with three tabs will appear. Figure 7.3-2 (A-C) 

shows these three tabs: 
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• Use the check boxes on the ‘Sections to be printed’ tab to select 

which data blocks to print.   

 

Figure 7.3-2a 

• Use the ‘Rebar Selection’ tab to change the bar sizes or bar 

system used for top and bottom reinforcing steel.  

 

Figure 7.3-2b 

The bar system used for the ADAPT-PT/RC analysis is determined 

according to the design code selected during data input. The preferred 

bar size is also specified during data input. Although these will be used 

as defaults for the Summary Report, both the bar system and bar size 

can be changed. 
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All the bar systems shown on the Rebar Selection tab (ASTM - US 

Customary, ASTM - US SI, Euro or CSA) are available, no matter what 

design code was used for the ADAPT-PT/RC run. First, select the desired 

bar system. Then, specify the top and bottom bar size from the pull-

down list of bar sizes available for that bar system. Click on Apply to 

recalculate the mild steel reinforcing requirements with the new bar 

sizes. 

To go back to the bar system and sizes in the original ADAPT-PT/RC run, 

select the ‘Use Input Data as Default’ option. Click on Apply to 

recalculate the number of bars required. 

• Use the ‘Designer’s Notes’ tab to input notes that will be 

printed at the bottom of the report.  

 

Figure 7.3-2c 

Click on the Apply button to apply the selected options to the 

report.  

 Page Setup. This tool gives you an option to print your report in 

portrait or landscape. 

 Color Settings. The tool gives you an option to print your report in 

color or black-and-white.  his will change the color setup on both the 

screen and the printout. 

 Zoom options. The Zoom buttons can be used to 

adjust the size of the report on the screen.  
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 Spans selection. Allows you to format the 

report to include certain spans. From the left drop down list select first 

span and from the right drop down list specify last span that you want 

to include in the Summary Report. 

The following is a description of the data blocks that can be included in 

the Summary Report: 

 

Data Block 1  - General Project Information 

Data block 1 contains the General and Specific titles entered during data 

input. 

 

Data Block 2 – Member Elevation 

Data block 2 contains an elevation view of the member with span 

dimensions and labels. It also includes a graphical representation of the 

tendon profile that shows inflection points and low points. An elevation 

view of the member, including all drops and steps, with span lengths 

and the post-tensioning tendon profile, including inflection points and 

low points. 

 

Data Block 3 – Top Rebar 

Data block 3 reports the amount and length of rebar required at the top 

of the member. The rebar shown is the larger of the steel required to 

withstand the negative moment demand and code-specified minima.  

Where rebar curtailment rules are used in the input, the program 

arranges longitudinal reinforcement relative to those rules set by the 

user.  See Section 5 for additional information.  Section 3.3 of this block 

reports the number of layers required to meet minimum reinforcement 
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spacing requirements based on the design code selected.  This is a 

longitudinal reinforcement spacing check for the provided 

reinforcement in the section.  For example, when the ACI318 code is 

selected, the program calculates the spacing between bars as:  

 

N-1 (where ‘N’ equals the number of bars provided)  / Total section 

width (B) – 2*cover input (to longitudinal bar) 

If the required number of layers is reported greater than 1, the user 

should modify the input for cover requirements to maintain the proper 

effective depth in design of the section.   

If the steel required is controlled by the negative-moment demand, the 

bar lengths are based on the required rebar quantities at 1/20th points. 

By default, the selected rebar is calculated as two lengths to minimize 

material requirements, unless reinforcement curtailment rules are 

applied in which case these rules supersede the program defaulted 

calculated lengths.  

Note that the steel selected by the program is only one of several 

acceptable design solutions. Space has been provided in this data block 

for the designer to provide alternate information on rebar quantity, 

size, and length. The designer may also use this space to write in any 

additional notes or remarks pertaining to the rebar. 

For two-way slabs designed to the ACI318 design code, the program 

adjusts the required reinforcement when the minimum flexural 

requirement exceeds the requirement for Strength by one-third. The 

adjustment is made to the graphical reinforcement layout and Block 6 

for individual Service combinations when they are selected in the 

combination pull-down menu.  The modification is also reflective in the 

Envelope selection.   

 

Data Block 4 – Tendon Profile 
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Data block 4 shows an elevation view of the tendon profile. Tendon 

control points are marked and their heights with respect to the 

reference line are given. If the computer run was done in the Force 

Selection mode, the program shows the total post-tensioning force in 

each span. If the Tendon Selection option was used, the elevation view 

also includes the total number of tendons, the location of all dead and 

live stressing ends, and any added tendons. Heights of tendon control 

points with respect to the reference line and the total post-tensioning 

force or total number of strands specified for each span. If Tendon 

Selection is used, this data block will report elongations at each end of 

Tendons A, B and C. This block also reports the total force/width for 

each span and precompression at the mid-span location of each span.  If 

a span is segmented, the program uses the mid-span width for the 

calculation of data for items 4.14 and 4.15.  

 

Data Block 5 – Bottom Rebar 

Data block 5 reports the amount and length of rebar required at the 

bottom of the member. The format is the same as data block 3 – Top 

Rebar. 

For two-way slabs designed to the ACI318 design code, the program 

adjusts the required reinforcement when the minimum flexural 

requirement exceeds the requirement for Strength by one-third. The 

adjustment is made to the graphical reinforcement layout and Block 6 

for individual Service combinations when they are selected in the 

combination pull-down menu.  The modification is also reflective in the 

Envelope selection.  

 

Data Block 6 – Required & Provided Bars 

Data block 6 plots the rebar required and provided for the top and 

bottom of the section at each 1/20th point. The maximum required 

areas of steel required at each joint for the top and bottom of each span 

are also shown. 
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Data Block 7 – Shear Stirrups / Punching Shear (One-Way Shear) 

For beams, data block 7 reports the stirrup size and spacing based on 

user input during data entry. The spacing shown is the maximum 

spacing along the different segments of the span. The data block also 

includes a bar graph of the area of shear reinforcement required along 

each span.  The graphical diagram displays design sections as red where 

the concrete shear capacity is exceeded by shear demand (Vu/Phi,Vc > 

1.0).   

This block is typically not included on reports for one-way slabs since 

shear reinforcement is seldom required. Although this block may 

indicate that shear reinforcement is required at the supports for a one-

way slab, a review of the Results Report will show that this is for beams 

only. 

Note: the shear diagram is only available for strength and envelope load 

combinations. 

 

Data Block 7 – Shear Stirrups / Punching Shear(Two-way Shear) 

For two-way slabs, data block 7 plots an elevation view of the model, 

which indicates the punching shear stress ratio at each support and 

states whether the stress ratio is acceptable per the specified code. 

Note: This block is available only if you select Envelope from the drop-

down list of load combinations on the Main toolbar. 

 

Data Block 8 – Legend 

Data block 8 identifies the symbols used to indicate stressing and dead 

ends. Note, however, that the stressing and dead ends are only shown 
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when the Tendon Selection option has been used for the analysis. The 

legend is not applicable if Force Selection was used. 

 

Data Block 9 – Design Parameters 

Data block 9 reports the following design parameters used in the 

ADAPT-PT/RC run: 

• Design Code 

• Concrete strength, f’c 

• Mild steel yield strength, fy for longitudinal and shear 

reinforcement 

• Ultimate tendon strength, fpu (PT mode only) 

• Minimum Top and Bottom rebar cover 

• Rebar Table 

 

Data Block 10 –Material Quantities 

Data block 10 reports the following design parameters used in the 

ADAPT-PT/RC run: 

• Concrete: Total volume and area covered 

• Mild Steel: Total weight of rebar 

• Prestressing Steel: Total weight of tendons (PT mode only) 

 

Data Block 11 – Designer’s Notes 

Data block 11 contains notes added by the designer. The entry in this 

box will be used on future runs and future projects until it is cleared. To 

clear the notes, select Clear and then click on Apply in the ‘Designer’s 

Notes’ tab of Report Setup. 
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The Summary Report can be viewed in final form on the screen. It can 

then be printed or saved as either a .WMF or .BMP or copied and pasted 

to a word processor. If it is saved as a file, it can be inserted into 

contract documents, calculation packages or structural drawings. 

 

Data Block 12 – Deflections 

Data block 12 contains graphical and tabular deflections for Sustained 

and Total conditions. The graphical output displays maximum and 

minimum deflections for the Envelope of Service Sustained and Service 

Total conditions.  The tabular display produces a summary of deflections 

for each span and service load condition and is like Block 14 of the 

tabular report produced by the Report Generator.   

7.4 Export to DXF File 

The DXF export feature will allow users to graphically extract relevant tendon 

(PT mode only), longitudinal reinforcement and shear reinforcement 

information from their ADAPT-PT/RC models.  
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The DXF feature includes options to customize drawing parameters, tendon 

properties and attributes, tendon placement parameters, reinforcement type 

selection, reinforcement drawing arrangement and reinforcement/tendon 

visualization parameters.  The drawings for tendons, longitudinal reinforcement 

and shear reinforcement can be arranged as an overlaid or stacked profile.  

The Figure 7.4-1 shows the export to DXF input dialogue.  This window will open 

once you select Export to DXF file from the File menu, or click on Export to DXF 

file button, , in the main toolbar. 

The Drawing Title will be displayed on the top of the drawing file.  The default 

name of the file will be the name of the ADAPT-PT/RC model.dxf.  To change the 

name of the file, click the Change File button to define the new name of the 

drawing you are creating, then click Create DXF button to create the drawing file 

and launch AutoCAD.     

 

Figure 7.4-1 

 



   

  109  

8 Reports Overview 

This section describes in detail the reports generated by the ADAPT-PT/RC Report 

Generator for one-way slabs, two-way slabs, and beams. It is a useful tool in compiling 

customized, standard reports for your designs or those who review structural designs 

performed using ADAPT-PT/RC. The report can be produced as a standalone Microsoft 

Word® .RTF file or produced as the .RTF report and a Microsoft Excel® .XLS file.  

The material presented identifies the program input parameters by the user, the 

parameters which the user may edit during the execution of the program, and results 

computed by ADAPT-PT/RC. The reports differentiate between those values input by the 

user from those calculated by the program. 

Each report option is subdivided into sections. Each section is given a unique 

identification number. The report consists of those sections that are selected by the 

user. The user has control over which report sections can be included in the production 

of a single report.  Customized reports can be saved as templates and recalled for future 

use each time the Report Generator is opened.  

8.1 Report Generator Screen 

To create a report, click on the Report Setup button,  on the Main toolbar. 

The Report Generator window opens (Fig. 8.1-1). 

 

Figure 8.1-1 Report Generator Screen 

The following is the description of items included in the Report Generator: 
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• List of All Sections. Includes a collapsible tree that lists the sections 

available to be included in a report.  To expand the report section, click 

on the + tab.  To select a section, check the box in front the section.  

Note that if a main report section is checked, all sub-sections will be 

included in the report.  To exclude the section, deselect the box.  If a 

report section does not apply to the results for the specific model type, 

the section will not be available in the Report Generator.  For example, 

if your structural system is a beam, the punching shear report (Section 

13) will not be available.   

• List of Selected Sections. Lists all sections that were selected to be 

included in a report.  

 Removes the highlighted selection from the drop-

down list. 

 Saves the current set of sections to a custom 

report in the drop-down list.  

 Saves the current set of sections as the default 

report. 

 Generates a report and displays them in rich text 

format (.RTF) when completed. 

 Opens a list of reports that have previously been 

saved to the last file location.   

  Allows you to customize report footer and cover 

page with specific company information.   

 Create Optional Spreadsheet Report (.XLS) – Allows the user to 

replicate the report information in a Microsoft Excel® spreadsheet file.  

 Exits Report Generator and goes back to the ADAPT Main 

program window. 
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8.2 How to Create A Report 

To create reports, go through the following steps: 

1. First set the report to show your company information when you create the 

report documents. To do so click on  button. The 

Company Information dialog box opens.  

 

Figure 8.2-1 

2. In the Company Information edit box, specify the text that you would like to 

include in the footer of each page of your report. To upload the company’s 

logo, click on the Browse button and upload Bitmap or JPEG file of your 

logo. The logo will show on the report cover page. Once you set up your 

company information the program will use it whenever you create new 

reports. If left blank, the program will use default ADAPT information. 

3. Click OK to close Company Information edit box. 

4. In the Report Generator tree, select the sections that you would like to 

include in your report. The selection will appear at the right side of the 

window in the List of Selected Sections.  

5. Click on  button. The program will ask you to specify 

name and location where you would like to save your report. The default 

location is the .ADB file folder where your project is saved.  

6. Click OK.  The program will start generating the report. Once completed, the 

program will open the report in rich text format. The report content will 
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include sections you selected, and they will be shown in default program 

settings. You will be able to modify it as you wish.  

8.3 Description of Report Sections 

The main report sections available are: 

• Report cover page. 

• Table of contents 

• Concise report 

• Tabular report-compact 

• Tabular report-detailed 

• Graphical reports 

• Legend 

The following explains each of these sections: 

8.3.1 Report Cover Page 

The program-generated cover page will contain a company logo, title, 

bitmap of a 3D structure view, and date (Fig. 8.3-1). The cover page will 

be created only if you select the Report Cover option from the list of 

sections. 

Your company logo will appear at the top of the report cover page and 

will show the bitmap or JPEG file that you uploaded (Fig 8.2-1). The 

default cover page title will be the Generic title and Specific title of your 

project that you specified in the General Settings window of PT or RC 

Input. While in PT or RC Input you can set the structure view as you 

want it to appear on the cover page of your report. When you exit PT or 

RC Input (click on Close button, or click Execute), the program will take a 

screen shot of the 3D structure and show it on the cover page. At the 

bottom of the cover page the program shows the date when you 

created report. 
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Figure 8.3-1 Report Cover Page 

8.3.2 Table of Contents 

To include a table of contents with your report, select the Table of 

Contents section in the Report Generator tree. The table will contain 

only sections that were selected by user and listed in the Selected 

Sections of the Report Generator window. The following table includes 

all sections available in ADAPT-PT/RC report.  Note that some sections 

may not apply to RC designs using RC mode.   
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TABLE OF CONTENT: 
 
 
       Concise Report 
 
              A. - Project Design Parameters and Load Combinations  
                     A.1 - Project Design Parameters  
                     A.2 - Load Combinations  
 
              B. - Design Strip Report Multi-span segmented beam frame system 
                     B.1 - Geometry 
                     B.2 - Applied Loads 
                     B.3 - Design Moments 
                            Envelope 
                     B.4 - Tendon Profile 
                     B.5 - Stress check / Code check 
                            Envelope 
                     B.6 - Rebar Report 
                     B.7 - Punching Shear 
                     B.8 - Deflection 
                     B.9 - Quantities 
 
       Tabular Reports - Compact 
 
              1 - User Specified General Analysis and Design Parameters 
 
              2 - Input Geometry 
                     2.1 - Principal Span Data of Uniform Spans 
                     2.2 - Detailed Data for Nonuniform Spans 
                     2.3 - Effective Width Data of Uniform Spans 
                     2.4 - Effective Width Data for Non-Uniform Spans 
                     2.7 - Support Width and Column Data 
 
              3 - Input Applied Loading 
                     3.1 - Loading as Appears in User's Input Screen 
                     3.2 - Compiled Loads 
 
              4 - Calculated Section Properties 
                     4.1 - Section Properties of Uniform Spans and Cantilevers 
                     4.2 - Section Properties for Non-Uniform Spans 
 
              5 - Moments, Shears and Reactions 
                     5.1 - Span Moments and Shears (Excluding Live Load) 
                     5.2 - Reactions and Column Moments (Excluding Live Load) 
                     5.3 - Span Moments and Shears (Live Load) 
                     5.4 - Reactions and Column Moments (Live Load) 
 
              6 - Moments Reduced to Face of Support 
                     6.1 - Reduced Moments at Face of Support (Excluding Live Load) 
                     6.2 - Reduced Moments at Face of Support (Live Load) 
 
              7 - Selected Post-Tensioning Forces and Tendon Profiles 
                     7.1 - Tendon Profile 
                     7.2 - Selected Post-Tensioning Forces and Tendon Drape 
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                     7.4 - Required Minimum Post-Tensioning Forces 
                     7.5 - Service Stresses 
                     7.6 - Post-Tensioning Balance Moments, Shears and Reactions 
 
              8 - Factored Moments and Reactions Envelope 
                     8.1 - Factored Design Moments (Not Redistributed) 
                     8.2 - Reactions and Column Moments 
                     8.3 - Secondary Moments 
 
              10 - Mild Steel (No Redistribution) 
                     10.1 - Required Rebar 
                            10.1.1 - Total Strip Required Rebar 
                     10.2 - Provided Rebar 
                            10.2.1 - Total Strip Provided Rebar 
                            10.2.2 - Total Strip Steel Disposition 
 
              12 - Shear Reinforcement 
                     12.1 - Shear Calculation Envelope 
 
              14 - Deflections 
                     14.1 - Maximum Span Deflections 
                     14.3 - Maximum Span Deflections 
 
              15 - Friction, Elongation and Long-term Losses 
                     15.1 - Input Parameters 
                     15.2 - Long-term Losses 
                     15.3 - Friction and Long-term Loss Calculation 
                     15.4 - Summary 
                     15.5 - Critical Stress Ratios 
 
       Tabular Reports - Detailed 
 
              21 - Tendon Heights 
 
              22 - Post-Tensioning Balanced Loading 
 
              23 - Detailed Moments 
 
              24 - Detailed Shears 
 
              25 - Factored Moments and Reactions 
 
              27 - Detailed Stresses 
 
              28 - Required Post-Tensioning 
 
              29 - Detailed Rebar 
 
              31 - Detailed Friction and Long-term Stress Losses 
 
              34 - Demand Moment and Moment Capacity 
                     34.2 - Based on Designed Values 
 
              35 - Detailed Deflections 
                     35.1 - Detailed Deflections 
                     35.3 - Detailed Deflections 
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              36 - Detailed Deflections Live Load 
                     36.1 - Detailed Deflections Live Load 
                     36.3 - Detailed Deflections Live Load 
 
       Graphical Reports 
 
              PT-Force 
 
              PT-Profile 
 
              Deflection 
 
              Load Cases 
                     Self-weight 
                     Super Imposed Dead 
                     Live 
                     Other 
                     Prestressing 
                     Hyper-Static 
 
              Load Combinations 
                     SERVICE_1_Min_LL 
                     SERVICE_1_Max_LL 
                     SERVICE_2_Min_LL 
                     SERVICE_2_Max_LL 
                     STRENGTH_1_Min_LL 
                     STRENGTH_1_Max_LL 
                     INITIAL_MIN_LL 
                     INITIAL_MAX_LL 
                     Cracking_Moment 
                     Envelope 
 
       Legend 

8.3.3 Concise Report 

The concise report is the short version of the report that includes all 

information necessary to describe project input and results. 

Sections of concise report are: 

• Project Design Parameters and Load Combinations 

• Design Strip Report – System type 

Project Design Parameters and Load Combinations includes information 

common to the entire project and can be printed as verification that 

data in design criteria was properly entered into the program. This 

option includes: 

• Material properties 
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• Covers 

• Design Code 

• Design Settings 

• Allowable stresses (PT mode only) 

• Post-tensioning parameters (PT mode only) 

• Load combinations  

• Other common entries for all support lines. 

Design Strip Report includes: 

• Definition of geometry (annotated graphics) 

• Applied loads (annotated graphics) 

• Tendon layout and values (graphics) with information on force, 

tendon height (PT mode only) 

• Stress check results (PT mode only) 

• Rebar report  

• Punching shear 

• Deflection graph 

• Quantities 

The following is the example of concise report: 
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A. Design Parameters and Load Combinations  
 
A.1 Project Design Parameters  

 
Parameter Value Parameter Value 

Concrete   Fy (Shear reinforcement) 66.72 ksi 

F'c  for BEAMS/SLABS 4061.00 psi Minimum Cover at TOP 1.50 in 

F'ci for BEAMS/SLABS 3045.80 psi Minimum Cover at BOTTOM 1.50 in 

For COLUMNS/WALLS 4061.00 psi Post-tensioning   

Ec  for BEAMS/SLABS 3607.00 ksi SYSTEM UNBONDED 

For COLUMNS/WALLS 3607.00 ksi Fpu 269.77 ksi 

CREEP factor 2.00 Fse 174.04 ksi 

CONCRETE WEIGHT NORMAL Strand area 0.153 in 2 

UNIT WEIGHT 150.00 pcf Min CGS from TOP 2.00 in 

Tension stress limits / (f'c)1/2   Min CGS from BOT for interior 
spans 

2.00 in 

At Top 6.000 Min CGS from BOT for exterior 
spans 

2.00 in 

At Bottom 6.000 Min average precompression 149.39 psi 

Compression stress limits / f'c   Max spacing / slab depth 8.00 

At all locations 0.450 Analysis and design options   

Tension stress limits (initial) / 
(f'c)1/2 

  Structural system BEAM 

At Top 3.000 Moment of Inertia over support is NOT 
INCREASED 

At Bottom 3.000 Moments reduced to face of 
support 

YES 

Compression stress limits (initial) / 
f'c 

  Moment Redistribution NO 

At all locations 0.600 Effective flange width 
consideration 

YES 

Reinforcement   Effective flange width 
implementation method 

ACI-318 

Fy (Main bars) 66.72 ksi DESIGN CODE SELECTED American-ACI318 
(2014)/IBC 2015 

 

 
A.2 Load Combinations  
 
Strength load combinations 
1.  1.2 SW  +  1.6 LL  +  1.2 SDL  +  1.6 X  +  1 HYP  
 
Service load combinations 
    Sustained Load 
1.  1 SW  +  0.3 LL  +  1 SDL  +  0.3 X  +  1 PT  
    Total Load 
2.  1 SW  +  1 LL  +  1 SDL  +  1 X  +  1 PT  
 
Initial load combinations 
         1 SW  +  1.15 PT  
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B. Design Strip Report: Multi-span segmented beam frame system 
B.1 Geometry 
 
- Plan 

  

 
  
 

 
- Elevation 
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B.2 Applied loads 
 
- Superimposed Dead Load 

  

 
  
 

 
- Live Load 
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B.3 Design Moment  
 

LOAD COMBINATION: Envelope 
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B.4 Tendon Profile  
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B.5 Stress check results / Code check  
 

LOAD COMBINATION: Envelope 
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SERVICE COMBINATION STRESSES 

(Tension stress positive) 
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B.6 Rebar Report  
 
 
 
 Total Strip Provided Rebar 

Span ID Location From Quantity Size Length Area 

      ft     ft in2 

1 1 TOP 0.00 8 5 6.00 2.48 

1 2 TOP 22.80 9 5 13.00 2.79 

2 3 TOP 28.00 9 5 14.00 2.79 

3 4 TOP 28.00 9 5 13.00 2.79 

4 5 TOP 22.80 8 5 6.00 2.48 

1 6 BOT 0.00 1 8 3.00 0.79 

1 7 BOT 8.55 2 8 11.50 1.58 

1 8 BOT 24.23 2 8 9.50 1.58 

2 9 BOT 10.50 2 8 14.00 1.58 

2 10 BOT 29.75 2 8 10.50 1.58 

3 11 BOT 10.50 2 8 14.00 1.58 

3 12 BOT 29.75 2 8 9.50 1.58 

4 13 BOT 8.55 2 8 11.50 1.58 

4 14 BOT 25.65 1 8 3.00 0.79 

1 16 BOT 25.65 1 8 6.50 0.79 

2 17 BOT 31.50 1 8 7.00 0.79 

3 18 BOT 31.50 1 8 6.50 0.79 

 

 
B.8 Deflection  
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DEFLECTION 

 
B.9 Quantities  
 
CONCRETE 
 Total volume of concrete = 1552.21ft3 (57.49 yd3) 
 Area covered = 2423.33 ft2 
 
MILD STEEL 

 Total weight of rebar = 985.05 lbs 
 Average rebar usage = 0.41 psf, 0.63 pcf 
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PRESTRESSING MATERIAL 
Total weight of tendon = 680.9 lb 
Average tendon usage = 0.28 psf, 0.44 pcf 

8.3.4 Compact Report 

The compact report consists of the mirror image of user input, plus a 

tabular listing of critical information, such as post-tensioning and 

reinforcement, necessary for preparation of structural drawings. Also, it 

includes values of actions, such as moments, shears and stresses at left, 

center, and right of each span. 

The following is the description of the available report sections: 

8.3.4.1 Section 1- User Specified General Analysis and Design 

Parameters 

This data block reflects the user’s input in the selection of 

design parameters and design options.  Some options related 

to post-tensioning may not be shown if the design is made in 

RC mode.  

       

The following are parameters which enter the computations 

as recommended initial values but can be edited during the 

execution of the program. The final values are listed in the 

output section of the report.  These parameters apply only to 

PT mode.   
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• Tendon CGS (Center of Gravity of Strand) at top of 

support and mid-spans: these are the user-suggested 

values. The actual cover used in the calculations, as 

modified by the user in the Recycle Window, are listed 

in Section 7 of the report. 

• Minimum average precompression shows the value set 

by the user. The actual average post-tensioning is listed 

in Section 7 of the report. 

• Max spacing between strands is also entered by the 

user. Refer to Section 7 where the force provided by 

each tendon reveals whether this postulation is 

adhered to.  

• Tension stress limits are defined as multiples of the 

(f’c)1/2. Based on these values, the required 

post-tensioning along the member is determined. 

Specifying a set of permissible values in this data block 

is no guarantee that the final stresses are, in fact, 

equal or less than the limits stated. During execution in 

the Recycle Window the user may overwrite the 

previously set stress limits with the selected 

post-tensioning. The actual stresses are reported in data 

sections Section 7 of the report. 

The following input data cannot be altered during the 

execution of the program:  

• Reinforcement: This data block refers to the non-

prestressed reinforcement in the beam/slab. The values 

for beam stirrups, where applicable, are given in Section 

12 of the report. 

• Post-tensioning system: Indicates the user’s selection 

between grouted (bonded) or unbonded 

post-tensioning. 

The average effective stress in a strand  (fse) is the user’s 

estimate of the stress in a strand after all losses have 

taken place. This value is used in the determination of 

the ultimate strength of a section if the “force 

selection” option of the program is used. It affects the 

amount of supplemental rebar which may be required 

to meet the strength stipulations of a section. If the 

“variable force” option (tendon selection) is used, the 
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program does not use this value. It calculates that 

actual stress in the stand at each design section.   

• Analysis option used: If the answer to moments 

reduced to face-of-support is YES, it indicates that the 

calculated centerline moments at each support are 

adjusted to face-of-support. In addition to the 

centerline moments, ADAPT prints out the moments 

reduced to face-of-support. Refer to moment data 

blocks for the description of printed values. 

• Moment of Inertia over support: The beam or slab 

region over the width of a support (columns or walls) 

exhibits a greater stiffness than the unsupported 

regions. ADAPT has an option to allow for this greater 

stiffness by increasing the moment of inertia of region 

over the support. The increase is determined by a 

relationship proposed in ACI-318. 

8.3.4.2 Section 2: Input Geometry 

This data block reports model geometry as input by the user. 

It includes basic span geometry, effective width used in 

calculations, drop can, drop panel, transfer beam dimensions 

as well as support width and column dimensions. The 

geometry is described as follows: 

• 2.1  Principal Span Data of Uniform Spans. This section 

is available only if the user selects conventional 

geometry input. 

 
Span Form Length Width Depth TF Width TF Thick. BF/MF 

Width 
BF/MF 
Thick. 

Rh Right Mult. Left Mult. 

    ft in In in in in in in     

1 1 19.17 120.00 12.00         10.00 0.50 0.50 

2 1 27.17 120.00 12.00         10.00 0.50 0.50 

3 1 22.75 120.00 12.00         10.00 0.50 0.50 

C 1 3.50 120.00 12.00         10.00 0.50 0.50 

 

• Detailed Data for Nonuniform Spans. This section is 

available only if the user selects segmental geometry 

input. 

 
Span Seg. Form Left Dist. Width Depth TF Width TF Thick. BF/MF 

Width 
BF/MF 
Thick. 

Rh Right 
Mult. 

Left Mult. 

      ft In in in in in in in     

1 1 2 0.00 24.00 30.00 216.00 8.00     10.00 0.56 0.44 

1 2 2 0.33 24.00 30.00 216.00 8.00     10.00 0.56 0.44 
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1 3 2 5.00 24.00 30.00 216.00 8.00     10.00 0.56 0.44 

1 4 1 18.42 24.00 30.00         10.00 0.50 0.50 

The following is the description of the data: 

• Span. This column shows the span number (ID). If the 

problem has a cantilever at left, its data precedes the 

first span by a line starting with “C.” Likewise, in the 

case of a cantilever at right, the last line will start with 

“C” describing the geometry of the right cantilever. 

• Seg. This column shows the segment number (ID). 

• Form. Identifies the cross-sectional geometry of the 

slab at mid-span. Figure 8.3-2 illustrates the 

cross-sectional options. The same figure also gives the 

definition of parameters Depth, Width, TF Width (top 

flange width), TF Thick. (Top flange thickness) , BF/MF 

Width (bottom flange/middle flange width) and BF/MF 

Thick. (bottom flange/middle flange thickness) . 
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Figure 8.3-2 

• Rh (Reference height). The distance from a user-

specified reference line to the top of the slab. For 

example, if a slab is 7” thick and Rh is set to 7”, the 

datum is located at the slab soffit. This data identifies 

the location from which tendon height control points 

are measured and is also used to input steps in a 

member. 

• Right or Left (Width) Multiplier.  A parameter which 

describes the factor by which the slab unit strip must be 

multiplied to cover the total tributary of a given span.  

It should be noted that the results printed in the output, 

such as the moments and reactions, refer to the total 

tributary (not effective tributary) unless indicated 

otherwise.   
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• 2.3 Effective Width Data of Uniform Spans. This section 

applies to Conventional geometry input.  

Span Effective Width 

 in 

1 57.51 

2 81.51 

3 68.25 

• Effective Width Data for Non-Uniform Spans. This 

section applies to Segmental geometry input. 

Span Seg. Effective Width 

    in 

1 1 57.51 

1 2 57.51 

1 3 57.51 

• Span. This column shows the span number (ID). If the 

problem has a cantilever at left, its data precedes the 

first span by a line starting with “C”. Likewise, in the 

case of a cantilever at right, the last line will start with 

“C” describing the geometry of the right cantilever. 

• Seg. This column shows the segment number (ID). 

• Effective width. Mirrors the data in the Geometry-

Effective Flange width input form. 

• 2.5 Drop Cap and Drop Panel Data. This data block 

gives the dimensions of drop caps/panels for each 

support if a two-way slab is the system type. Figure 8.3-

3 illustrates the definition of data columns 2 through 

10. 

Joint Cap T Cap B Cap DL Cap DR Drop TL Drop TR Drop B Drop L Drop R 

  in in in in in in in in in 

1 36.00 48.00 0.00 24.00 0.00 30.00 100.00 0.00 50.00 

2 36.00 48.00 24.00 24.00 24.00 30.00 100.00 50.00 50.00 

3 36.00 48.00 24.00 24.00 24.00 30.00 100.00 50.00 50.00 

4 36.00 48.00 24.00 24.00 24.00 30.00 100.00 50.00 50.00 

For example, Cap T, which is the heading of column 2, is 

shown at the bottom right hand side of Fig. 8.3-3 to indicate 

the total depth of “CAP.” STEP 1 in the figure indicates the 

first thickening of the slab past the support, and is referred to 

as DROP CAP regardless of its size. The second change in 

thickness is called DROP PANEL, or STEP 2. 
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Figure 8.3-3 

If no drop caps or panels are present, zeros are shown in this 

data block. A zero indicates that the user has not entered any 

value for a parameter. However, as far as the computations 

are concerned, ADAPT selects a minimum default value if 

necessary. For example, CAPT equal zero will result in a 

default value of CAPT equals span thickness for 

calculations.2.6 Transverse Beam Data. Transverse beam data 

are reported in the table of Section 2.5. 

• 2.7 Support Width and Column Data. This data block is 

only printed if column data is input, or if support widths 

are specified for reduction of moments to face-of-

support. Otherwise the following sentence is printed: 

“NO COLUMN STIFFNESS IS INCLUDED IN THE 

ANALYSIS.” 

Joint Support 
Width 

Length 
LC 

B(DIA.) 
LC 

D LC % LC CBC LC Length 
UC 

B(DIA.) 
UC 

D UC % UC CBC UC 

  in ft in in     ft in in     

1 8.0 10.0 216.0 8.0 100 (2)           

2 18.0 10.0 12.0 18.0 100 (1)           



   

  131  

3 18.0 10.0 12.0 18.0 100 (1)           

4 8.0 10.0 216.0 8.0 100 (2)           

• Support Width. Is the support width at each joint. 

These values are used in the reduction of moments to 

the face-of-support. This value may be different from 

the column dimensions. 

• Length LC. Is the height of the lower column measured 

from the center of the slab to the top of the bottom 

slab. 

• Length UC. Is the height of the upper column measured 

from the center of the slab to the bottom of the top 

slab. 

• B(DIA). Is the dimension of the column cross-section 

normal to the direction of the frame. A circular column 

is entered using B(DIA) only. 

• D. Is the column dimension parallel to the frame. 

• CBC is the Column Boundary Condition parameter. B 

and D can also describe the horizontal dimensions of 

the structural element supporting the slab, such as the 

thickness and length of a continuous wall. Whether or 

not a given wall/column support dimensioned through 

B and D is taking moments is determined by the way the 

wall/column is connected to the slab. The nature of the 

connection of the support to the slab at the 

slab/support junction is indicated by the CBC parameter 

as defined by the user and reflected in columns 6 and 

10 of this data block. Note that the CBC parameter also 

describes the condition of fixity of the column at its far 

end away from the beam/slab, namely at its connection 

to the slab above and the slab/footing below. 

• % is the percentage of the column stiffness included in 

the analysis. 

8.3.4.3 Section 3: Input Applied Loading 

This data block reports model geometry as input by the user. 

Loads entered by the user are sorted according to the span on 

which they act and are listed in the loading data block.  
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• 3.1 Loading As Appears in User's Input Screen. This 

section mirrors the data as shown in the Loads input 

screen. 

 

Span Class Type W P1 P2 A B C F M 

      k/ft2 k/ft k/ft ft ft ft k k-ft 

1 LL U 0.050               

1 SDL U 0.020               

2 LL U 0.050               

2 SDL U 0.020               

3 LL U 0.050               

3 SDL U 0.020               

4 LL U 0.050               

4 SDL U 0.020               

 
 
 NOTE: SELFWEIGHT INCLUSION REQUIRED (SW= SELF WEIGHT Computed from geometry 
       input and treated as dead loading. Unit self-weight  W =  150.0 pcf    
 NOTE: LIVE LOADING is SKIPPED with a skip factor of    1.00 
 
 

• 3.2 Compiled loads. This section shows frame loads 

calculated by the program. If you specified uniformly 

distributed or partial loadings, the program would 

calculate frame loading based on the tributary width. 

 

Span Class Type P1 P2 F M A B C Reduction 
Factor 

      k/ft k/ft k k-ft ft ft ft % 

1 LL U 1.000             0.000 

1 SDL U 0.400               

1 SW U 1.891               

2 LL P 1.000       0.000 15.000   0.000 

2 LL P 0.417       15.000 20.000   0.000 

2 LL P 1.000       20.000 35.000   0.000 

2 SDL P 0.400       0.000 15.000     

2 SDL P 0.167       15.000 20.000     

2 SDL P 0.400       20.000 35.000     

2 SW P 1.912       0.000 15.000     

2 SW P 1.029       15.000 20.000     

2 SW P 1.912       20.000 35.000     

3 LL P 1.000       0.000 15.000   0.000 

 

• Class. Specifies load class for each span. Class LL is live 

load, class SDL is superimposed dead load, class SW is 

self-weight and class X is other loading.  
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• Type. There are 8 different load types:  

• U is for a uniformly distributed load acting on the 

entire tributary. 

• C is for a concentrated load. It acts at a point 

entered by the user and measured from the left 

support of the respective span. 

• P is for a partial uniform load that acts on the entire 

width (tributary) of a span over the length entered 

by the user. 

• M is for an applied moment that acts on the entire 

tributary at a distance from the left support entered 

by the user. 

• L is for a Line load that acts along the frame line of 

the slab. Line loads are entered in the same manner 

as partial loads. 

• R is for triangle load that acts along the frame line 

of the slab. 

• V is for variable load that acts along the frame line 

of the slab. 

• T is for trapezoidal load that acts along the frame 

line of the slab. 

The user can also select the self-weight option. Using 

the geometry and unit weight entered by the user, 

ADAPT calculates the self-weight of the entire 

beam/slab and automatically amends the loading file. 

The value of the self-weight loading will appear in the 

output data. 

Live load is not skipped unless stipulated by the user, in 

which case the following sentence appears at the end of 

the loading table: 

LIVE LOADING is SKIPPED with a skip factor of x.xx. 

When the skip load option is activated, ADAPT obtains 

two sets of solutions. (i) In the first set, live loading is 

assumed to act without the skip factor on all spans. (ii) 

In the second set, live load multiplied by the specified 

skip factor is selectively placed on different spans. 

Solutions of the second set are combined to yield the 



 

134 

maximum possible negative and positive moments at 

each location. Results of moment combinations from (i) 

and (ii) are then merged to arrive at the governing 

moments for design.  

8.3.4.4 Section 4: Calculated Section Properties 

The data block on section properties gives the cross-sectional 

area, moment of inertia, and the location of the neutral axis 

of the entire tributary perpendicular to the direction of the 

span. 

• 4.1 Section Properties of Uniform Spans and 

Cantilevers. The table below shows the data for 

rectangular cross-sections. 

 

Span Area Yb Yt b_eff I Yb Yt 

  in2 in in in in4 in in 

1 1815.40 18.40 5.58 85.50 0.4423E+05 15.75 8.23 

2 --- --- --- --- --- --- --- 

3 --- --- --- --- --- --- --- 

4 1815.40 18.40 5.58 85.50 0.4423E+05 15.75 8.23 

 

In the case of flanged T-beams, there are two cross-

sectional properties computed as shown above. One is 

for the section reduced by “effective” width, and the 

other is for the entire tributary. The reduced values are 

used for the general frame analysis of the model and to 

calculate stresses.  

• 4.2 Section Properties for Non-Uniform Spans. The 

table below shows the data for rectangular cross-

sections. 

The calculated section properties are given in terms of 

span segments, for both customary and segmental 

input geometries. A non-segmental span with no drop 

Span Seg. Area Yb Yt b_eff i Yb Yt 

    in2 in in in in4 in in 

2 1 1836.00 18.41 5.59 105.00 0.4760E+05 16.37 7.63 

2 2 988.00 16.21 7.77 100.00 0.4666E+05 16.21 7.77 

2 3 1836.00 18.41 5.59 105.00 0.4760E+05 16.37 7.63 

3 1 1836.00 18.41 5.59 105.00 0.4760E+05 16.37 7.63 

3 2 988.00 16.21 7.77 100.00 0.4666E+05 16.21 7.77 

3 3 1836.00 18.41 5.59 105.00 0.4760E+05 16.37 7.63 
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caps or drop panels has one segment. A span with drop 

caps at either end has three segments. A span with drop 

caps and drop panels has five segments. Finally, a 

segmental span can have up to seven segments. 

Yb and Yt refer to the distance from the section 

centroid to the top and bottom fibers. 

When there is a change in cross-section of a span at the 

line of support, as shown in the idealized Fig. 8.3-4(a), 

two options regarding the face-of-support arise. Over 

the support line, ADAPT considers the cross-section at 

the face-of-support of the shallower member to be the 

same as that of the deeper member. But, recognizing 

that the deeper span does not penetrate the shallower 

one, ADAPT assumes a zero length for the geometry of 

the deeper section into the shallower span. The same 

assumption is used for change of geometry over the 

supports of finite width as shown in Fig. 8.3-4(b). 

 

Figure 8.3-4 

If the analysis is done with finite support widths, and 

the user has included the option to increase moment of 

inertia over the support, then ADAPT adds an additional 

segment over each support. 

8.3.4.5 Section 5: Moments, Shears and Reactions 

Values given as moments, shears and reactions all refer to the 

total tributary and not the unit strip. Moments in this data 

block are moments at the center of supports (system line 

moments). 
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• 5.1 Span Moments and Shears (Excluding Live Load).  

Span Load Case  Moment  
Left 

Moment 
Midspan 

Moment 
Right 

  Shear   
Left 

 Shear  
Right 

    k-ft k-ft k-ft k k 

1 SW -89.64 71.05 -152.26 -24.75 29.14 

2 SW -170.13 82.29 -179.23 -31.00 31.52 

3 SW -179.24 82.29 -170.11 -31.52 31.00 

4 SW -152.25 71.05 -89.65 -29.14 24.75 

1 SDL -19.08 15.12 -31.89 -5.25 6.15 

2 SDL -34.81 16.22 -36.29 -6.37 6.46 

3 SDL -36.29 16.22 -34.80 -6.46 6.37 

4 SDL -31.89 15.12 -19.08 -6.15 5.25 

1 XL 0.00 0.00 0.00 0.00 0.00 

2 XL 0.00 0.00 0.00 0.00 0.00 

3 XL 0.00 0.00 0.00 0.00 0.00 

4 XL 0.00 0.00 0.00 0.00 0.00 

Moment Left and Moment Right relate to centerline 

moments in the slab at the left and right of each span, 

respectively.  

Moment Mid-span refers to the moment at mid-span. 

The moment at mid-span is not necessarily the largest 

value. For the location and value of the maximum 

moment refer to Section 23 that gives detailed report at 

1/20th points. 

Shear Left and Shear Right are the centerline shear 

forces at the left and right of each span. 

• 5.2 Reactions and Column Moments (Excluding Live 

Load) 

Joint Load Case Reaction Moment      
Lower Column 

Moment      
Upper Column 

    k k-ft k-ft 

1 SW 24.75 -89.64 0.00 

2 SW 60.15 -17.87 0.00 

3 SW 63.04 -0.02 0.00 

4 SW 60.14 17.86 0.00 

5 SW 24.75 89.65 0.00 

1 SDL 5.25 -19.08 0.00 

2 SDL 12.52 -2.91 0.00 

3 SDL 12.92 0.00 0.00 

4 SDL 12.52 2.91 0.00 

5 SDL 5.25 19.08 0.00 

1 XL 0.00 0.00 0.00 

2 XL 0.00 0.00 0.00 

3 XL 0.00 0.00 0.00 

4 XL 0.00 0.00 0.00 

5 XL 0.00 0.00 0.00 
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Reaction is the centerline dead load reaction at each 

support line. 

Moment Lower Column and Moment Upper Column are 

upper and lower column moments and are given for 

each support at the connection of column to 

slab/beam. If a support does not have a column, or if 

moment transfer between the support and slab is 

inhibited by the user through the specification of an 

appropriate column boundary condition, a zero (0) is 

printed. 

• 5.3 Span Moments and Shears (Live Load). This section 

is a summary of maximum and minimum live load 

moments, and corresponding shear forces at the left 

and right centerlines, as well as at center span.  Live 

load moments, shears and reactions are values reported 

at the center of supports and refer to the entire 

tributary. 

Span  Moment  
Left Max 

 Moment  
Left Min 

Moment 
Midspan 

Max 

Moment 
Midspan 

Min 

Moment 
Right Max 

Moment 
Right Min 

  Shear   
Left 

 Shear  
Right 

  k-ft k-ft k-ft k-ft k-ft k-ft k k 

1 -55.97 8.26 44.35 -6.54 -81.90 -19.00 -14.16 15.48 

2 -95.17 -6.62 50.42 -9.86 -98.44 -11.59 -16.72 16.81 

3 -98.45 -11.59 50.42 -9.86 -95.15 -6.62 -16.81 16.72 

4 -81.89 -18.99 44.35 -6.53 -55.97 8.26 -15.48 14.16 

Maximum and minimum values at a section may occur 

due to the skipping of live loading.  

• 5.4 Reactions and Column Moments (Live Load). This 

section is a summary of the maximum and minimum 

live load reactions and column moments given for each 

support at the connection of column to slab/beam. 

Joint Reaction 
Max 

Reaction 
Min 

Moment 
Lower 

Column Max 

Moment 
Lower 

Column Min 

Moment 
Upper 

Column Max 

Moment 
Upper 

Column Min 

  k k k-ft k-ft k-ft k-ft 

1 14.16 -1.04 8.26 -55.97 0.00 0.00 

2 32.20 14.15 51.79 -59.07 0.00 0.00 

3 33.62 15.49 64.50 -64.51 0.00 0.00 

4 32.20 14.15 59.06 -51.78 0.00 0.00 

5 14.16 -1.04 55.97 -8.26 0.00 0.00 

If a support does not have a column, or if moment 

transfer between the support and slab is inhibited by 
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the user through the specification of an appropriate 

column boundary condition, a zero (0) is printed. 

These are minimum and maximum centerline values 

based on skipped loading case. 

Values given as moments, shears and reactions all refer 

to the total tributary and not the unit strip. Moments in 

this data block are centerline moments. 

8.3.4.6 Section 6: Moments Reduced to Face of Support 

If the option of reducing moments to the face-of-support is 

invoked by the user, ADAPT adjusts the centerline moments 

to the face-of-support. The adjustments are based primarily 

on support widths. The adjusted values are printed in Sections 

6.1 and 6.2. 

• 6.1 Reduced Moments at Face of Support (Excluding 

Live Load) 

Span Load 
Case 

 Moment  
Left 

Moment 
Midspan 

Moment 
Right 

    k-ft k-ft k-ft 

1 SW -62.10 71.05 -119.58 

2 SW -135.33 82.29 -143.83 

3 SW -143.83 82.29 -135.33 

4 SW -119.58 71.05 -62.11 

1 SDL -13.24 15.12 -25.00 

2 SDL -27.65 16.23 -29.03 

3 SDL -29.04 16.23 -27.65 

4 SDL -25.00 15.12 -13.24 

1 XL 0.00 0.00 0.00 

2 XL 0.00 0.00 0.00 

3 XL 0.00 0.00 0.00 

4 XL 0.00 0.00 0.00 

 

• 6.2 Reduced Moments at Face of Support (Live Load) 

Span Moment Left 
Max 

Moment Left 
Min 

Moment 
Midspan 

Max 

Moment 
Midspan Min 

Moment 
Right Max 

Moment 
Right Min 

  k-ft k-ft k-ft k-ft k-ft k-ft 

1 -40.15 7.05 44.34 -6.53 -64.55 -17.92 

2 -76.38 -6.83 50.42 -9.87 -79.54 -11.45 

3 -79.55 -11.45 50.42 -9.86 -76.36 -6.83 

4 -64.54 -17.92 44.34 -6.53 -40.15 7.05 
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8.3.4.7 Section 7: Selected Post-tensioning Forces and Tendon Profiles 

(PT mode only) 

• 7.1 Tendon Profile Tendon profile types available in the 

library of the ADAPT version used are listed in this data 

block. 

Tendon A 

Span Type X1/L X2/L X3/L A/L 

1 1 0.100 0.500 0.100 --- 

2 1 0.100 0.500 0.100 --- 

3 1 0.100 0.500 0.100 --- 

4 1 0.100 0.500 0.100 --- 

• Type. Reflects the profile type chosen for each span. 

Parameters X1/L, X2/L, X3/L and A/L are tendon profile 

inflection points in terms of a fraction of the span 

length. These are illustrated in Fig. 8.3-5. Note that 

some parameters are unnecessary for describing certain 

profile types.  

  

  

 

Figure 8.3-5 

• 7.2 Selected Post-Tensioning Forces and Tendon Drape 

(PT mode only) Columns 2 through 6 of this data block 

give the total post-tensioning forces and tendon heights 

selected by the user for tendon type A. Columns 7 and 8 

are values calculated by ADAPT based on the post-

tensioning selected in the preceding data block.  

Tendon A 
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Span Force CGS Left CGS C1 CGS C2 CGS Right P/A Wbal WBal (%DL) 

  k in in in in psi k/-   

1 274.554 18.42 --- 5.75 22.00 151.24 3.259 142 

2 274.554 22.00 --- 2.02 22.00 277.89 2.985 139 

3 274.554 22.00 --- 2.02 22.00 277.89 2.985 139 

4 274.554 22.00 --- 5.75 18.42 151.24 3.259 142 

 

 

The All Tendons table lists the sums of the PT force, P/A 

and Wbal of Tendon A, Tendon B, and Tendon C 

selected. 

                                   All Tendons 

Span Force Total P/A Total WBal 
(%DL) 

  k psi   

1 274.554 151.24 142 

2 274.554 277.89 139 

3 274.554 277.89 139 

4 274.554 151.24 142 

During the execution of the program, ADAPT calculates 

the required post-tensioning forces and displays them 

on the screen. The execution may pause, requiring the 

user to confirm the prompted values or modify them. 

The modification of the values calculated by ADAPT and 

prompted on the screen is referred to as Selection of 

post-tensioning by the user. After the user’s selection/ 

modification of forces and drapes, the program 

recalculates all the parameters and stresses based on 

the user’s input and prompts a new set of suggested 

values. The important issue for a reviewer to note is 

that, at this stage, the user has the option to override 

ADAPT’s calculated/displayed values. The Recycle 

Window is completely interactive and allows user 

modification.  

It is recommended that the reviewer pay particular 

attention in comparing the user-selected post-

tensioning (as displayed in data block 7.2) with the 

calculated required minimum values given in data block 

7.4. 

Columns 3 through 5 of data block 7.2 refer to the 

height of the tendon’s centroid (CGS) from a user-

defined reference line. The left and right locations refer 

to the maximum height of tendon at left and right of 
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the span relative to this reference line. In the case of a 

reversed parabola, these are the heights over the 

centerline of supports. For simple parabolas with 

straight portions over the supports, the heights refer to 

maximum rises at left and right of the span at location 

of transition to a straight line. The straight portion is 

called the Tendon Support Width and is defined through 

the coefficients in data block 7.1. 

P/A in column 7 is the calculated average compression 

at mid-span, based on the user selected post-

tensioning. 

Wbal in column 8 is the balanced loading % in each span 

due to post-tensioning force and profile selected. It is 

the average uplift force over the entire span divided by 

the dead load tributary to the span. For purposes of 

calculating Wbal%, the program averages resulting 

concentrated forces from equivalent PT loading.  For 

the frame analysis, the program uses the actual 

equivalent balanced loads due to PT at the proper, 

applied locations.   

A positive value of Wbal means load acting upward 

against gravity. A negative value indicates a load in the 

direction of gravity. 

• 7.4 Required Minimum Post-Tensioning Forces (PT 

mode only). The forces in this data block refer to the 

required forces at left, center, and right for the entire 

tributary. 

Based on Stress Conditions                 Based on Minimum P/A 

Type Left Center Right Left Center Right 

  k k k k k k 

1 0.00 62.98 35.52 271.20 271.20 271.20 

2 33.92 75.78 43.41 274.28 274.28 274.28 

3 43.42 75.79 33.91 274.28 274.28 274.28 

4 35.52 62.98 0.00 271.20 271.20 271.20 

The required forces determined are the net effective 

forces after the immediate and long-term stress losses 

have been deducted. From the effective forces 

determined by ADAPT, the post-tensioning supplier 

calculates the initial forces required at time of stressing 

of tendons. 
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This data block shows the post-tensioning required to 

meet design criteria. Columns 2 through 4 are based on 

maintaining the tensile stresses in concrete at the 

location of maximum span moment, to the limit 

specified by the user in data block 1. Each row includes 

three regions for a given span. Data column 2 relates to 

the span’s left support region; data column 3 is for the 

mid-span region; data column 4 shows the required 

force at the right support region of the same span.  The 

“Left” region is 20% of the span length from the left 

support.  The “Center” region is the 20-80% the span 

distance in the interior portion of span.  The “Right” 

region is 20% of the span length from the right support.   

For example, if the specified permissible stress for the 

exterior span is input as x(f’c)1/2 in data block 1, the 

number printed on column 3 in row of span 1 is the 

post-tensioning force necessary to meet that 

requirement. 

At a given support, the post-tensioning required at the 

left of a support may be different from the force at its 

right. 

The following considerations are observed in calculating 

the required post-tensioning in the support region: 

• Stresses are calculated at 1/20th points in the span. 

In the region closest to the left support, the highest 

stress value is selected, and the required post-

tensioning force provided to meet this condition is 

printed. If user wishes to know the exact location of 

the highest stress, detailed reports of stresses at 

1/20th points given in report Section 27 should be 

reviewed. 

• If moments are not reduced to the face-of-support, 

the centerline moments are used in lieu of 

moments reduced to face. 

• The cross-section associated with the centerline of a 

support is that of the slab at the support line 

without any contribution from the supporting 

structure. 
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If at any location the existing moments are such that no 

post-tensioning is required, a zero (0) will be printed at 

that location. 

MIN P/A in column 5 through 7 are the post-tensioning 

forces required to provide the user-specified minimum 

average compression (see data block 1) in the left, right, 

and center regions of the span. 

• 7.5 Service Stresses (PT mode only). Based on the post-

tensioning forces and profiles confirmed or selected by 

the user, the top and bottom fiber stresses are 

calculated for each span and printed out in this data 

block. The stresses refer to concrete. 

Envelope of Service 1 

Span Left   
Top   

Max-T 

Left    
Top  

Max-C 

Left    
Bot  

Max-T 

Left    
Bot  

Max-C 

Center 
Top 

Max-T 

Center 
Top 

Max-C 

Center 
Bot  

Max-T 

Center 
Bot  

Max-C 

Right 
Top 

Max-T 

Right 
Top 

Max-C 

Right  
Bot  

Max-T 

Right  
Bot  

Max-C 

  psi psi psi psi psi psi psi psi psi psi psi psi 

1 ----- -272.94 81.66 ----- ----- -53.08 ----- -404.28 ----- -330.87 192.52 ----- 

2 ----- -319.20 214.34 ----- ----- -224.12 ----- -465.39 ----- -320.63 217.42 ----- 

3 ----- -320.66 217.48 ----- ----- -224.12 ----- -465.39 ----- -319.14 214.21 ----- 

4 ----- -330.84 192.46 ----- ----- -53.08 ----- -404.29 ----- -272.94 81.65 ----- 

 
Envelope of Service 2 

Span Left   
Top   

Max-T 

Left    
Top  

Max-C 

Left    
Bot  

Max-T 

Left    
Bot  

Max-C 

Center 
Top 

Max-T 

Center 
Top 

Max-C 

Center 
Bot  

Max-T 

Center 
Bot  

Max-C 

Right 
Top 

Max-T 

Right 
Top 

Max-C 

Right  
Bot  

Max-T 

Right  
Bot  

Max-C 

  psi psi psi psi psi psi psi psi psi psi psi psi 

1 ----- -283.96 102.74 -98.93 ----- -122.39 ----- -423.83 ----- -330.87 192.52 -83.27 

2 ----- -319.20 214.34 -100.84 ----- -294.67 ----- -494.16 ----- -320.63 217.42 -110.82 

3 ----- -320.66 217.48 -110.79 ----- -294.67 ----- -494.16 ----- -319.14 214.21 -100.89 

4 ----- -330.84 192.46 -83.30 ----- -122.39 ----- -423.83 ----- -283.95 102.73 -98.93 

Tensile stresses are shown as positive and compressive 

stresses as negative. Maximum tension and 

compression, at the top and bottom at the left and right 

face-of-support and mid-span, are printed in their 

respective columns. Note that the maximum stress in a 

span may occur elsewhere. For the location and 

magnitude of the maximum stress, refer to either the 

graphical display of stress distribution, or the detailed 

report of stresses at 1/20th point of each span. 

• 7.6 Post-Tensioning Balance Moments, Shears and 

Reactions (PT mode only). The post-tensioning 

balanced moments are moments generated in the slab 

because of post-tensioning.  These are also referred to 

as equivalent loads.  These are displayed in a manner 
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like the moments, shears, reactions, and column 

moments in Section 5. They refer to the total tributary. 

Span Moments and Shears 

Span Moment Left Moment Center Moment Right Shear Left Shear Right 

  k-ft k-ft k-ft k k 

1 127.75 -143.42 225.00 -0.70 -0.70 

2 251.17 -140.50 261.75 -0.33 -0.33 

3 261.83 -140.58 251.17 0.33 0.33 

4 225.00 -143.42 127.75 0.69 0.69 

 

Reactions and Column Moments 

Joint Reaction Moment 
Lower 

Column 

Moment 
Upper 

Column 

  k k-ft k-ft 

1 0.695 136.583 0.000 

2 -0.370 22.383 0.000 

3 -0.652 0.026 0.000 

4 -0.368 -22.367 0.000 

5 0.695 -136.583 0.000 

If the reduction of moments to the face-of-support 

option is used in the data input (refer to data block 1), 

slab moments printed are those reduced to face-of-

support. Otherwise, they are centerline moments. 

Shears, reactions, and column moments are centerline 

values. 

It is reiterated that values printed herein are due only to 

post-tensioning. Since post-tensioning forces are in self-

equilibrium, the sum of external reactions generated by 

them must add up to zero. The reactions reported in 

this data block are the hyperstatic (secondary) actions 

due to post-tensioning. 

8.3.4.8 Section 8: Factored Moments and Reactions Envelope 

This data block lists the duly combined actions for the 

evaluation of the member’s ultimate strength.  

• 8.1 Factored Design Moments (Not Redistributed). The 

factored and combined actions, or design actions, are 

the sum of dead loading, live loading, and secondary 

effects, each multiplied by a coefficient. If reduction to 

face-of-support is invoked by the user, the factored 

moments given relate to face-of-support; else, they 

represent centerline moments. 
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Span Left        
Max 

Left         
Min 

   Middle    
Max 

   Middle    
Min 

Right      
Max 

Right       
Min 

  k-ft k-ft k-ft k-ft k-ft k-ft 

1 -17.23 58.29 320.86 239.45 -121.20 -46.58 

2 -138.61 -27.35 383.40 286.93 -144.96 -36.01 

3 -144.90 -35.94 383.40 286.95 -138.59 -27.35 

4 -121.18 -46.58 320.86 239.46 -17.24 58.28 

• 8.2 Reactions and Column Moments. The factored 

support reactions and moments apply to the analysis 

solution considering the effective geometry with 

application of load from the full tributary entered in 

data block 2.1.   

Joint Reaction 
Max 

Reaction 
Min 

Moment 
Lower 

Column Max 

Moment 
Lower 

Column Min 

Moment 
Upper 

Column Max 

Moment 
Upper 

Column Min 

  k k k-ft k-ft k-ft k-ft 

1 59.35 35.04 19.30 -83.46 0.00 0.00 

2 138.35 109.47 80.30 -97.06 0.00 0.00 

3 144.29 115.28 103.20 -103.21 0.00 0.00 

4 138.34 109.46 97.05 -80.30 0.00 0.00 

5 59.35 35.03 83.46 -19.30 0.00 0.00 

For the design of columns, total factored reactions and 

factored column moments are normally used. If design 

handbooks are used for column design, the relating 

eccentricity of the axial loading commonly required for 

use in such handbooks is readily obtained by dividing 

the printed factored column moment by the 

corresponding total factored reaction. Shears, 

reactions, and column moments are centerline values. 

• 8.3 Secondary Moments (PT mode only). Secondary 

(hyperstatic) moments are caused by post-tensioning 

forces. These are induced in the member by the 

constraints of the supports to the member’s free 

movement. They are calculated from the secondary 

actions at the supports. 

Span Left Midspan Right 

  k-ft k-ft k-ft 

1 137.42 146.50 155.58 

2 179.17 184.50 189.75 

3 189.83 184.50 179.17 

4 155.58 146.50 137.42 

Secondary moments are adjusted to the face-of-

support, provided this option is selected during input 

into ADAPT. 
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• 8.4 Factored Design Moments (Redistributed). These 

section shows moments are listed in Section 8.1 after 

redistribution. This section is available only if you 

selected to redistribute moments. 

Span Left        
Max 

Left         
Min 

   Middle    
Max 

   Middle    
Min 

Right      
Max 

Right       
Min 

Redist. 
Coef. Left 

Redist. 
Coef Right 

  k-ft k-ft k-ft k-ft k-ft k-ft     

1 59.09 -17.48 326.72 240.93 -124.16 -41.98 0.00 11.24 

2 -124.21 -30.44 387.72 305.89 -129.95 -32.48 11.24 11.21 

3 -129.95 -32.48 387.72 305.91 -124.24 -30.52 11.24 -11.24 

4 -124.19 -41.98 326.72 240.91 59.07 -17.49 -1.53 0.00 

 

8.3.4.9 Section 9: Factored Lateral Moments Envelope 

This section shows the results for the combination of lateral 

and gravity moments. 

• 9.1 Input Lateral Moments. This section mirrors the 

input data specified in the Lateral Input Data screen. 

Span Left Right 

  k-ft k-ft 

1 30.00 -30.00 

2 45.00 -45.00 

3 45.00 -45.00 

4 30.00 -30.00 

• 9.2 Factored Lateral Moments (Not Redistributed). This 

section shows factored and combined actions of dead 

loading, live loading, secondary effects, and lateral 

moments each multiplied by a coefficient. 

Span Left        
Max 

Left         
Min 

   Middle    
Max 

   Middle    
Min 

Right      
Max 

Right       
Min 

  k-ft k-ft k-ft k-ft k-ft k-ft 

1 +97.16 +34.41 +294.25 +224.05 -110.01 -2.09 

2 +74.52 +18.80 +353.14 +273.17 -139.18 -7.78 

3 +76.22 +12.91 +353.14 +273.17 -134.81 -9.55 

4 -54.91 -8.28 +294.25 +224.05 +42.05 -20.70 

• 9.3 Factored Lateral Moments (Redistributed). This 

section shows moments listed in Section 9.2 for 

redistribution.  This section is available only if you 

selected to redistribute moments. 

Span Left        
Max 

Left         
Min 

   Middle    
Max 

   Middle    
Min 

Right      
Max 

Right       
Min 

Redist. 
Coef. Left 

Redist. 
Coef Right 

  k-ft k-ft k-ft k-ft k-ft k-ft     

1 98.14 35.26 300.79 226.41 -99.14 -1.88 0.00 11.24 

2 75.30 19.25 360.71 276.34 -125.49 -7.01 0.00 11.24 

3 77.02 13.29 360.38 276.44 -121.57 -8.60 0.00 11.24 

4 -61.43 -9.27 296.73 226.29 42.47 -21.16 -11.24 0.00 
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If reduction to face-of-support is invoked by the user, 

the factored moments given relate to face-of-support; 

else, they represent centerline moments. 

8.3.4.10 Section10: Mild Steel - No Redistribution 

The mild reinforcement is calculated based on one of the 

following three sets of criteria: 

• One-way systems. 

• Two-way systems; and 

• Beam system. 

The applicable set of criteria is invoked by the user through 

the choice of the structural system (one-way, two-way, beam) 

and the design type (post-tensioned or mild-reinforced). The 

user’s selection is shown clearly in data block 1. 

• 10.1 Required Rebar. This section shows required rebar 

based on ultimate, minimum, initial (PT mode only) and 

the UBC special load case requirement (PT mode only).  

Column 5 reports the maximum enveloped value of 

reinforcement for the span and position in span.   

10.1.1 Total Strip Required Rebar  

Span Location From To As Required Ultimate Minimum Initial UBC 

    ft ft in2 in2 in2 in2 in2 

1 TOP 0.00 4.27 2.23 0.00 2.23 0.00 0.00 

1 TOP 24.23 28.50 2.23 0.00 2.23 0.00 0.00 

2 TOP 0.00 5.25 2.66 0.00 2.66 0.00 0.00 

2 TOP 29.75 35.01 2.66 0.00 2.66 0.00 0.00 

3 TOP 0.00 5.25 2.66 0.00 2.66 0.00 0.00 

3 TOP 29.75 35.01 2.66 0.00 2.66 0.00 0.00 

4 TOP 0.00 4.27 2.23 0.00 2.23 0.00 0.00 

4 TOP 24.23 28.50 2.23 0.00 2.23 0.00 0.00 

1 BOT 0.00 1.42 0.57 0.00 0.00 0.57 0.00 

1 BOT 9.97 18.52 1.38 0.00 1.38 0.00 0.00 

1 BOT 25.65 28.50 1.72 0.00 0.00 1.72 0.00 

2 BOT 0.00 3.50 2.07 0.36 0.00 2.07 0.00 

2 BOT 12.25 22.75 1.44 0.00 1.44 0.00 0.00 

2 BOT 31.50 35.01 2.15 0.00 0.00 2.15 0.00 

3 BOT 0.00 3.50 2.15 0.38 0.00 2.15 0.00 

3 BOT 12.25 22.75 1.44 0.00 1.44 0.00 0.00 

3 BOT 31.50 35.01 2.07 0.00 0.00 2.07 0.00 

4 BOT 0.00 2.85 1.72 0.19 0.00 1.72 0.00 

4 BOT 9.97 18.52 1.38 0.00 1.38 0.00 0.00 

4 BOT 27.07 28.50 0.57 0.00 0.00 0.57 0.00 
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• Provided Rebar. This section lists provided rebar details 

as calculated by the program.  

 

10.2.1 Total Strip Provided Rebar 

Span ID Location From Quantity Size Length Area 

      ft     ft in2 

1 1 TOP 0.00 8 5 6.00 2.48 

1 2 TOP 22.80 9 5 13.00 2.79 

2 3 TOP 28.00 9 5 14.00 2.79 

3 4 TOP 28.00 9 5 13.00 2.79 

4 5 TOP 22.80 8 5 6.00 2.48 

1 6 BOT 0.00 1 8 3.00 0.79 

1 7 BOT 8.55 2 8 11.50 1.58 

1 8 BOT 24.23 2 8 10.50 1.58 

2 9 BOT 10.50 2 8 14.00 1.58 

2 10 BOT 29.75 2 8 11.50 1.58 

3 11 BOT 10.50 2 8 14.00 1.58 

3 12 BOT 29.75 2 8 9.50 1.58 

4 13 BOT 8.55 2 8 11.50 1.58 

4 14 BOT 25.65 1 8 3.00 0.79 

1 16 BOT 25.65 1 8 7.50 0.79 

2 17 BOT 31.50 1 8 8.00 0.79 

3 18 BOT 31.50 1 8 6.50 0.79 

 
10.2.2 Total Strip Steel Disposition 

Span ID Location From Quantity Size Length 

      ft     ft 

1 1 TOP 0.00 8 5 6.00 

1 2 TOP 22.80 9 5 5.70 

2 2 TOP 0.00 9 5 7.30 

2 3 TOP 28.00 9 5 7.00 

3 3 TOP 0.00 9 5 7.00 

3 4 TOP 28.00 9 5 7.00 

4 4 TOP 0.00 9 5 6.00 

4 5 TOP 22.80 8 5 6.00 

1 6 BOT 0.00 1 8 3.00 

1 7 BOT 8.55 2 8 11.50 

1 8 BOT 24.23 2 8 4.27 

1 16 BOT 25.65 1 8 2.85 

2 8 BOT 0.00 2 8 6.23 

2 9 BOT 10.50 2 8 14.00 

2 10 BOT 29.75 2 8 5.25 

2 16 BOT 0.00 1 8 4.65 

2 17 BOT 31.50 1 8 3.50 

3 10 BOT 0.00 2 8 6.25 

3 11 BOT 10.50 2 8 14.00 

3 12 BOT 29.75 2 8 5.25 

3 17 BOT 0.00 1 8 4.50 

3 18 BOT 31.50 1 8 3.50 

4 12 BOT 0.00 2 8 4.25 

4 13 BOT 8.55 2 8 11.50 

4 14 BOT 25.65 1 8 3.00 

4 18 BOT 0.00 1 8 3.00 
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• 10.3 Base Reinforcement. This section describes base 

reinforcement as entered by the user.  

Base Reinforcement  

Isolated bars  

Span Location From Quantity Size Cover Length Area 

-- -- ft -- -- in ft in2 

1 TOP .00 5 5 1.50 72.59 1.55 

 
Mesh Reinforcement  

# Span Location From Spacing Size Cover Length Area 

-- -- -- ft in -- in ft in2 

1 1 BOT .00 12.00 4 1.50 19.17 3.60 

  2 BOT .00 12.00 4 1.50 27.17 3.60 

 

8.3.4.11 Section11: Mild Steel –Redistributed 

This section is the same as Section 10. The difference is that 

the values for reinforcement are based on the redistributed 

moments. 

8.3.4.12 Section 12: Shear Reinforcement 

Depending on the structural system selected, the results are 

based on the type of shear check made, punching shear check 

(two-way systems) or a one-way shear check (one-way 

systems).   

A one-way shear check is conducted for beams and one-way 

slabs. 

• 12.1 Shear Calculation Envelope. Each span is 

subdivided into 20 equal parts. Shear is checked at each 

subdivision. 

 
12.1 Shear Calculation Envelope 
SPAN 1 

X/L X d Vu,max Mu,max Ratio Req. Spacing Base 

  ft in k kft   in2/ft in   

0.00 0.00 19.20 -111.91 -0.01 1.11 0.000 0.00 OK 

0.05 1.75 19.20 -100.72 187.89 1.26 0.023 18.00 NS 

0.10 3.50 19.20 -89.54 356.00 1.62 0.213 18.00 NS 

0.15 5.25 19.20 -78.33 504.32 1.65 0.166 18.00 NS 

0.20 7.00 19.20 -67.15 632.92 1.62 0.095 18.00 NS 

0.25 8.75 19.20 -55.96 741.97 1.39 0.000 0.00 OK 

0.30 10.50 19.20 -44.76 830.56 1.11 0.000 0.00 OK 

0.35 12.25 20.20 -33.57 899.96 0.79 0.000 0.00 OK 
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0.40 14.00 21.20 -22.39 949.42 0.50 0.000 0.00 OK 

0.45 15.75 21.80 -11.20 978.95 0.24 0.000 0.00 --- 

0.50 17.50 22.00 0.00 277.81 0.00 0.000 0.00 --- 

0.55 19.25 21.80 11.20 978.95 0.24 0.000 0.00 --- 

0.60 21.00 21.20 22.39 949.42 0.50 0.000 0.00 OK 

0.65 22.75 20.20 33.57 899.96 0.79 0.000 0.00 OK 

0.70 24.50 19.20 44.76 830.56 1.11 0.000 0.00 OK 

0.75 26.25 19.20 55.96 741.97 1.39 0.000 0.00 OK 

0.80 28.00 19.20 67.15 632.92 1.62 0.095 18.00 NS 

0.85 29.75 19.20 78.33 504.32 1.65 0.166 18.00 NS 

0.90 31.50 19.20 89.54 356.00 1.62 0.213 18.00 NS 

0.95 33.23 19.20 100.72 187.89 1.26 0.023 18.00 NS 

1.00 35.01 19.20 111.91 -0.01 1.11 0.000 0.00 OK 

 

Note: "Ratio" is calculated using paired shear (V) and moment (M) design values resulting in the lowest 
concrete capacity. For ACI and CSA codes, the lowest value of V*d/M is used. 
Note: Sections with **** have exceeded the maximum allowable shear stress. 
Note: Base stirrups flagged as OK satisfy the requirements - additional reinforcement is not needed. Base 
stirrups flagged as NS are not sufficient - additional stirrups are reported in the table. 

 

The first and last points refer to the system line at support 

(X/L=0 and X/L=1). It is not required by some codes to check 

the shears at the system line. The first point for which shear is 

to be checked is recommended to be taken a distance equal 

to the depth of member from the face-of-support. Hence, the 

values given for X/L=0 and X/L=1 are to be considered as a 

guideline. 

The depth ‘d’ used for stirrup calculations is based on the 

total depth of the section, reinforcement cover, post-

tensioning CGS (where applicable) and bar size.   

For post-tensioned, one-way systems, the concrete capacity 

for ACI and CSA designs are dependent on the ratio of 

Vu*d/Mu, where ‘Vu’ and ‘Mu’ are ultimate demand shears 

and moments at the individual design sections.  When Live 

Load skipping is active, the shear capacity at each design 

check is governed by the worst-case ratio.  The program 

conservatively uses the Vu and Mu values from the load 

skipping data set which result in the lowest ratio.  The values 

do not necessarily pair from the same skip pattern result.   

When base shear reinforcement is applied to beams or one-

way slab designs, the program reports the design status in the 

“Base” column of the report. Where base stirrups are applied, 

the program will report a status check as “OK” or “NS.”   

If the base stirrups meet the required area and spacing by 

calculation, “OK” will be reported and no additional 
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reinforcement will be reported.  If “NS” is reported, the base 

stirrups are not sufficient to meet the demand and the 

program will report the demand balance for required 

reinforcement along with the necessary spacing.  This 

reported reinforcement in Report 12 is in addition to the base 

reinforcement entered by the user.   

8.3.4.13 Section 13: Punching Shear Reinforcement  

A punching shear check is carried out if the structural system 

is two-way. 

• 13.1 Critical Section Geometry 

Column Layer Cond. a d b1 b2 

      in in in in 

1 2 1 4.69 9.38 52.37 45.37 

2 1 1 8.19 16.38 28.84 28.84 

3 1 1 7.19 14.38 28.38 30.37 

4 1 1 4.44 8.88 38.87 56.87 

 
 Layer  : The layer of the reinforcement for each column 
 Cond.  : 1 = Interior, 2 = End, 3 = Corner, 4 = Edge   
 a  : The distance between the layer and face of column or drop cap(*) 
 d  : Effective depth   
 b1  : length of section parallel to span line  
 b2  : length of section normal to span line  
 

• 13.2 Critical Section Stresses. The outcome of the 

punching shear analysis is summarized in data column 

entitled Stress ratio. This is the total stress from two-

way action divided by the allowable stress. If the stress 

ratio for any support exceeds limits imposed by the 

code the cross section must be enlarged and/or the 

concrete capacity increased and/or punching shear 

reinforcement provided. 

Label Layer Cond. Factored 
shear 

Factored 
moment 

Stress due 
to shear 

Stress due 
to moment 

Total stress Allowable 
stress 

Stress ratio 

      k k-ft ksi ksi ksi ksi   

1 2 1 -211.90 +163.79 0.12 0.026 0.142 0.186 0.764 

2 1 1 -341.03 -56.61 0.18 0.014 0.194 0.190 1.025 

3 1 1 -395.71 +17.12 0.23 0.005 0.239 0.190 1.259 

4 1 1 -196.22 -263.75 0.12 0.046 0.162 0.183 0.884 

Four location classifications exist.  These are Corner, 

Interior, End and Edge.  These conditions are 

differentiated in the punching shear calculations by the 

number of edges that participate in development of 

shear resistance. These conditions are identified at the 

top of the data block. From the geometry of the 

problem input by the user, ADAPT determines which of 
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the conditions is applicable at each support. The 

condition as identified by ADAPT is listed in data column 

3.  Condition 1 is Interior, Condition 2 is End, Condition 

3 is Edge and Condition 4 is corner.   

If ADAPT determines that a punching shear check is not 

applicable for a support, such as in the case of a wall 

support, no values will be printed for that joint. 

Data columns 4 and 5 are the applicable factored shear 

and moment at the joints. Calculated stresses due to 

the factored shears and moments are shown in data 

columns 6 and 7. 

Total stress (column 8) is the sum of stresses due to 

shear and bending (sum of columns 6 and 7).  Column 9 

reports the allowable stress, as determined by the 

applicable design code.  Column 10 reports the stress 

ratio.  This is the total stress divided by the allowable 

stress.  

The contribution of the vertical component of force 

from post-tensioning is conservatively omitted in 

determining the allowable stress.  

• 13.3 Punching Shear Reinforcement. This section lists 

required punching shear reinforcement.  The term 

“Dist” refers to the distance from the face of column or 

drop that the layer of studs is located.  If the maximum 

allowable shear stress is exceeded, the program will 

report “*”. If a value is followed by “*” (e.g. 8*) this 

refers to the distance from face of drop to the stud 

layer.  This would apply only if drop panels or drop caps 

are modeled.   

Reinforcement option: Shear Studs 
Stud diameter: 0.38 
Number of rails per side: 1 

Col. Dist Dist Dist Dist Dist Dist Dist Dist Dist Dist 

  in in in in in in in in in in 

1                    

2 1.6 3.3 4.9 6.5 8.2           

3 1.0 2.1 3.1 4.1 5.1 6.2 7.2       

4                    

 
Dist. = Distance measured from the face of support 

Note: Columns with --- have not been checked for punching shear. 

Note: Columns with *** have exceeded the maximum allowable shear stress. 
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8.3.4.14 Section 14: Deflections 

The deflection data block in the report is a summary of the 

calculations showing only the maximum values obtained for 

each span.  Deflections for each stage shown in the data block 

are calculated with due consideration of cracking and loss of 

stiffness.  The program utilizes hard-coded values for modulus 

of rupture dictated by the selected design code.   

Deflections are reported for sustained and total long-term 

conditions with and without consideration of incremental live 

load applied as sustained load an exposed to creep.  For 

example, the reports blocks shown below are for “Service 

Combination 1” (SC1) and “Service Combination 3” (SC3).  

These are the combinations: 

SC1: 1.0*SW + 1.0*SDL + 1.0*PT + 0.3*LL + 0.3*XL, referred to 

as “Sustained Load” in the load combination input.   

SC3: 1.0*SW + 1.0*SDL + 1.0*PT + 1.0*LL + 1.0*XL, referred to 

as “Total Load” in the load combination input.   

Note that the program allows for 2 “Sustained Load” 

combinations and 2 “Total Load” combinations.   

The “Sustained” and “Total” load combination values are 

determined as follows: 

Example 1 – Span 2 – Long-Term Deflections with 

consideration of incremental Live Load: 

SC1 – Sustained = -0.14” + (-0.06”*0.3*3) = -0.20”  

SC1 – Total = -0.20” + (-0.06”*0.7) = -0.24”  

The sustained result is a long-term sustained deflection that 

includes the factor of 0.3 multiplied by the live load 

deflection.  In effect, this is the portion of live load that is 

sustained through the life of the structure and subject to 

creep. The factor of 0.3 is taken directly from the load 

combination defined by the user.   

The total result is the long-term total deflection which 

includes the additional increment of live load taken by the 

factor 0.7* the live load deflection.  The factor of 0.7 is 1 – the 

user defined live load factor of 0.3.   
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The results for SC1 and SC2 (if used) are referred to as long-

term deflections.   

Example 2 – Span 2 – Long-Term deflection without 

consideration of incremental Live Load: 

SC3 – Sustained = -0.14” (Note that no live load is included) 

SC3 – Total = --0.14” + -0.06” = -0.21” (Note that this 

displacement is the instantaneous deflection + creep + live 

load deflection as a short-term load not subject to long-term 

effects).   

NOTE: The second data block for combinations SC3 and SC4 

are calculated identical to previous versions of the program. 

14.1 Maximum Span Deflections - Service Combination 1 

Span SW SW+PT SW+PT+
SDL 

SW+PT+SDL
+Creep 

LL X Sustained Total 

  in in in in in in in in 

1 0.04 -0.04 -0.03 -0.08(4079) -0.03(10660) 0.00(*****) -0.11(3114) -0.13(2605) 

2 0.07 -0.06 -0.05 -0.14(2902) -0.06(6864) 0.00(*****) -0.20(2102) -0.24(1731) 

3 0.07 -0.06 -0.05 -0.14(2902) -0.06(6865) 0.00(*****) -0.20(2103) -0.24(1731) 

4 0.04 -0.04 -0.03 -0.08(4079) -0.03(10662) 0.00(*****) -0.11(3114) -0.13(2606) 

 
14.3 Maximum Span Deflections - Service Combination 3 

Span SW SW+PT SW+PT+
SDL 

SW+PT+SDL
+Creep 

LL X Sustained Total 

  in in in in in in in in 

1 0.04 -0.04 -0.03 -0.08(4079) -0.03(10660) 0.00(*****) -0.08(4079) -0.11(3029) 

2 0.07 -0.06 -0.05 -0.14(2902) -0.06(6864) 0.00(*****) -0.14(2902) -0.21(2040) 

3 0.07 -0.06 -0.05 -0.14(2902) -0.06(6865) 0.00(*****) -0.14(2902) -0.21(2040) 

4 0.04 -0.04 -0.03 -0.08(4079) -0.03(10662) 0.00(*****) -0.08(4079) -0.11(3029) 

 
Note: Deflections are calculated using effective moment of inertia of cracked sections. 

The concrete’s modulus of elasticity (Ec) used for the 

deflection is calculated by ADAPT using the concrete strength 

input by the user and the selected code’s formula for normal-

weight and light-weight concrete. The user has the option to 

overwrite the code-based modulus of elasticity and enter 

his/her choice.  

The Creep Factor (K) is input by the user and is used in 

determining long-term, time-dependent deflections as 

described above.   

A negative deflection value indicates deflection upward. 
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Values in the parentheses are the deflection ratios computed 

as the length of each span divided by its maximum deflection. 

Deflection ratios are entered as positive regardless of 

direction of deflection. If a deflection ratio exceeds 100000, a 

value equal to 99999 is entered within the parentheses. 

The program checks for cracked deflection for multiple stages.  

Data column 2 (SW) is deflection due only to self-weight. It 

should be noted that this column of data serves only as 

background information for the user, for at no time during its 

function is the slab expected to be subjected to self-weight 

alone. Under normal conditions either post-tensioning or 

shoring will be present.  

SW+PT in column 3 is the immediate elastic deflection of the 

slab due to the self-weight and the post-tensioning. 

SW+PT+SDL in column 4 is the immediate elastic deflection of 

the slab due to the self-weight, user-defined dead loading, 

and the post-tensioning. 

SW+PT+SDL+CREEP in column 5 is the sum of the immediate 

deflection (column 4) and the deflection due to creep. The 

deflection due to creep is applied to the live load as outlined 

in Example 1 above. Column 5 is (1+K) times the deflection 

due to SW+PT+SDL (column 4). 

Deflection due to live loading (LL) is listed in column 6 and is 

calculated by taking (SW+PT+SDL+LL) – Column 4.  This 

represents the total live load deflection.  From this value, the 

program applies the necessary sustained load factor (0.3 by 

default) and creep factor to determine that portion of long-

term deflection influenced by sustained live load.   

Where X load is applied, the program determines this by 

taking (SW+PT+SDL+LL+XL) – (SW+PT+SDL+LL).  The deflection 

for X load is added directly to the sustained or total load 

result with no creep factor applied.   
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8.3.4.15 Section15: Friction, Elongation and Long-Term Stresses (PT 

mode only) 

• 15.1 Input Parameters. This section shows the values 

entered during data entry. 

 

Parameter Value Parameter Value 

Type of Strand Low Relaxation Coefficient of Angular Friction (meu) 0.07000 1/rad 

Age of Concrete at Stressing 5 days Coefficient of Wobble Friction (K) 0.00050 rad/m 

Ec at Stressing 10500.00 MPa Ratio of Jacking Stress 0.90 

Average Relative Humidity 80.00 percent Anchor Set 6.00 mm 

Volume to Surface Ratio of Members 130.00 mm Tendon_A Stressing Method Both side 

Es of Strand 190000.00 MPa     

 

• 15.2 Long-term Losses. This section can report different 

information depending on the option that the user 

selected for the long-term stress loss calculation. There 

are three options for long-term stress loss calculations: 

• Lump sum entry. A lump sum value may be 

calculated by the user and entered during data 

input. The effective stresses in the tendon are 

calculated by subtracting this value from the initial 

stresses. Since the friction and seating losses cause 

the initial stresses to vary along the tendon, the 

effective stresses will also vary. The lump sum is 

reported in the Section 15.1 Input parameters. In 

this case the section 15.2 is not reported. 

• Long-Term Loss calculations for unbonded tendons. 

For unbonded tendons, the strain in the tendon at 

any given point is not directly related to the local 

strain in the concrete. The program can calculate 

and report an average long-term loss value for the 

entire tendon based on the average 

precompression in the member and expected losses 

due to shrinkage, creep, elastic shortening and 

relaxation of the prestressing steel. The effective 

stresses in the tendon are calculated by subtracting 

the average long-term loss value from the initial 

stresses. To obtain these results the user must 

execute ADAPT in Force Selection mode. The 

section table will show as follows: 
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Tendon Elastic shortening Shrinkage Creep Relaxation Total 

  MPa MPa MPa MPa MPa 

TENDON_A 28.52 17.28 34.96 42.49 123.20 

• Long-Term Loss computation for grouted tendons. 

Long-term stress losses in grouted tendons are a 

function of the local strain in the concrete. To 

calculate long-term stress loss for a grouted system, 

a detailed strain computation must be performed 

along the path of a tendon. A detailed listing of 

stresses and long-term losses is available if ADAPT is 

executed in Tendon Selection mode. In this case the 

values at left, center and right of each span are 

listed as shown in the following table:  

 

Tendon Span Left Center Right 

    ksi ksi ksi 

TENDON_A CL 7.29 7.57 8.16 

TENDON_A 1 8.26 8.87 9.46 

TENDON_A 2 9.58 9.05 9.03 

ADAPT calculates the losses at 1/20th points along 
each span and lists them in a file for interested 
users (friction_detail.dat). This is a text file and can 
be viewed with any text editor or word processor. 

If a friction and long-term losses calculation need to 
be done for a grouted system designed with Force 
Selection, a lump sum must be entered for long-
term loss. 

• 15.3 Calculated Stresses After Friction and Long-Term 

Losses (PT mode only). Shows calculated stresses after 

friction and long-term loss at left, center and right of 

span. 

Tendon Span Stress Left   FL 
Only 

Stress Center   
FL Only 

Stress Right   
FL Only 

Stress Left 
FL+LTL 

Stress Center 
FL+LTL 

Stress Right 
FL+LTL 

    ksi ksi ksi ksi ksi ksi 

TENDON_A 1 215.59 218.49 224.01 203.97 206.88 212.54 

TENDON_A 2 224.01 225.32 220.53 212.54 213.70 208.91 

TENDON_A 3 220.53 213.85 210.36 208.91 202.23 198.75 

• 15.4 Summary (PT mode only). Gives the average initial 

stress, total long-term losses, final average stress, and 

final average force. The section shows the left, right and 

total elongation after anchor set. It also gives the left 

and right anchor set influence distances. 

Tendon Avg. Initial 
Stress 

LTL Avg. Final 
Stress 

Avg. Final 
Force 

Elongation 
Left 

Elongation 
Right 

Elongation 
Total 

Left Anchor 
Set 

Right 
Anchor Set 
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  ksi ksi ksi k in in in ft ft 

TENDON_A 219.45 11.60 207.85 31.89 5.80 -0.06 5.74 28.00 32.00 

• 15.5 Critical Stress Ratios (PT mode only). The critical 

stress ratios show the ratios of the calculated tendon 

stress to the strand’s specified ultimate strength.   

Tendon Stressing  Left Stressing Right Anchorage Left Anchorage 
Right 

Max 

TENDON_A 0.90 0.90 0.80 0.78 0.84 

• 15.6 Summary (PT mode only). Gives the average force 

per span, tendon extents, elongation left and right of 

span, anchor set left and right of span, stress at 

anchorage and maximum stress along the tendon.  This 

data block only applies if the calculation method is 

Tendon Selection Method.  

Tendon Force Ext. Left Start 
Span 

End 
Span 

Ext. 
Right 

Elong. Left Elong Right Anchor 
Left 

Anchor 
Right 

Max 
Stress 
ratio 

  k         in in       

TENDON_A 33.58 0.00 1 3 0.00 5.80 -0.06 0.80 0.78 0.84 

TENDON_B 33.63 0.00 1 1 0.20 2.68 0.00 0.80 0.84 0.84 

TENDON_C 32.83 0.20 3 3 0.00 0.00 2.16 0.83 0.78 0.83 

 

• Tendon column lists the types of tendons used. 

These may be tendons A, B and C. 

• Force is the average force in each strand along the 

length of each tendon. The average force is not 

used in the computations. It is listed as an indicator 

since this force is often viewed as a measure of 

effectiveness of a strand when comparing 

alternatives. 

• Ext. Left and Ext. Right illustrate the extent of each 

tendon type into left and right spans.  

• Elong. Left and Elong. Right are the elongations at 

left and right ends of each tendon. If a tendon type 

is stressed at one end only, the elongation at the 

dead end will be shown by a zero (0) in the report. 

• Anchor Left and Anchor Right is a ratio determined 

by taking the stress after seating loss at anchorage 

divided by the strand’s ultimate strength.  

• Max. Stress Ratio is the ratio of the maximum 

stress along each tendon to the strand’s ultimate 

strength immediately after jacking and seating of 

tendon. 
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Example Output for:  Type A, Type B, and Type C 

• A solution for a grouted system in effective-force 

mode with lump sum stress specification (TYPE B). 

• A solution for an unbonded tendon system in 

effective-force mode, together with computed long-

term stress losses (TYPE A); and, 

• A solution for a grouted system in tendon-selection 

mode with computed long-term stress loss (TYPE C). 

An unbonded tendon system with tendon-selection 

mode and computed long-term loss calculations 

also has a report type (C) as indicated in the flow 

chart. 

INPUT

ADAPT
FORCE 

SELECTION
TENDON

SELECTION

FRICTION

LT LOSS

PRINT
SECTION 15

TYPE C

20TH POINT
 DATA

GRAPHICAL
 DISPLAY

SYSTEM

GROUTEDUNBONDED

FRICTION LOSS
+

LUMPSUM
LONG-TERM

LOSSES ONLY

FRICTION LOSS
+

LONG-TERM
LOSSES 

PRINT
SECTION 15

TYPE A

PRINT
SECTION 15

TYPE B

END

 

15 - FRICTION, ELONGATION AND LONG-TERM LOSSES 

 
15.1 Input Parameters 

Parameter Value Parameter Value 

Type of Strand Low Relaxation Coefficient of Angular Friction (meu) 0.07000 1/rad 

Age of Concrete at Stressing 5 days Coefficient of Wobble Friction (K) 0.00140 rad/ft 

Ec at Stressing 1523.00 ksi Ratio of Jacking Stress 0.80 

Average Relative Humidity 80.00 percent Anchor Set 0.25 in 

Volume to Surface Ratio of Members 0.00 in Tendon_A Stressing Method Both sides 

Es of Strand 29000.00 ksi     
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15.2 Long-term Losses 

Tendon Elastic Shortening Shrinkage Creep Relaxation Total 

  ksi ksi ksi ksi ksi 

TENDON_A 1.19 4.04 1.61 3.54 10.48 

 
15.3 Calculated Stresses After Friction and Long-term Losses 

Tendon Span Stress Left   
FL Only 

Stress Center   
FL Only 

Stress Right   
FL Only 

Stress Left 
FL+LTL 

Stress Center 
FL+LTL 

Stress Right 
FL+LTL 

    ksi ksi ksi ksi ksi ksi 

TENDON_A 1 177.67 182.56 189.66 167.19 172.08 179.18 

TENDON_A 2 190.64 196.29 190.93 180.16 185.81 180.45 

TENDON_A 3 189.97 183.44 176.94 179.49 172.96 166.46 

TENDON_A CR 176.47 173.32 170.50 165.99 162.84 160.02 

 
 
15.4 Summary 

Tendon Avg. 
Initial 
Stress 

LTL Avg. Final 
Stress 

Avg. Final 
Force 

Elongation 
Left 

Elongation 
Right 

Elongation 
Total 

Left 
Anchor 

Set 

Right 
Anchor 

Set 

  ksi ksi ksi k in in in ft ft 

TENDON_A 183.20 10.48 172.72 26.94 5.59 0.00 5.59 32.03 32.5 

 
15.5 Critical Stress Ratios 

Tendon Stressing  
Left 

Stressing 
Right 

Anchorage 
Left 

Anchorage 
Right 

Max 

TENDON_A 0.80 0.80 0.66 0.64 0.73 

 

Type A 

15 - FRICTION, ELONGATION AND LONG-TERM LOSSES 
 
15.1 Input Parameters 

Parameter Value Parameter Value 

Long term Lump Loss 1.16 ksi Ratio of Jacking Stress 0.80 

Es of Strand 29000.00 ksi Anchor Set 0.25 in 

Coefficient of Angular Friction (meu) 0.07000 1/rad Tendon_A Stressing Method Both sides 

Coefficient of Wobble Friction (K) 0.00140 rad/ft   

 
15.3 Calculated Stresses After Friction and Long-term Losses 

Tendon Span Stress Left   
FL Only 

Stress Center   
FL Only 

Stress Right   
FL Only 

Stress Left 
FL+LTL 

Stress Center 
FL+LTL 

Stress Right 
FL+LTL 

    ksi ksi ksi ksi ksi ksi 

TENDON_A 1 178.42 183.36 190.47 177.26 182.20 189.31 

TENDON_A 2 190.47 197.01 190.91 189.31 195.84 189.75 

TENDON_A 3 190.91 184.38 175.52 189.75 183.21 174.36 

TENDON_A CR 175.52 173.78 172.18 174.36 172.62 171.02 

 
15.4 Summary 

Tendon Avg. 
Initial 
Stress 

LTL Avg. Final 
Stress 

Avg. Final 
Force 

Elongation 
Left 

Elongation 
Right 

Elongation 
Total 

Left 
Anchor 

Set 

Right 
Anchor 

Set 

  ksi ksi ksi k in in in ft ft 

TENDON_A 184.00 1.16 182.84 27.98 5.65 -0.01 5.64 32.76 39.83 

 
15.5 Critical Stress Ratios 

Tendon Stressing  
Left 

Stressing 
Right 

Anchorage 
Left 

Anchorage 
Right 

Max 

TENDON_A 0.80 0.80 0.66 0.64 0.73 

Type B 
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15 - FRICTION, ELONGATION AND LONG-TERM LOSSES 
 
15.1 Input Parameters 

Parameter Value Parameter Value 

Type of Strand Low Relaxation Coefficient of Wobble Friction (K) 0.00140 rad/ft 

Age of Concrete at Stressing 5 days Ratio of Jacking Stress 0.80 

Ec at Stressing 1523.00 ksi Anchor Set 0.25 in 

Average Relative Humidity 80.00 percent Tendon_A Stressing Method Both sides 

Volume to Surface Ratio of Members 0.00 in Tendon_B Stressing Method Left side 

Es of Strand 29000.00 ksi Tendon_C Stressing Method Right side 

Coefficient of Angular Friction (meu) 0.07000 1/rad     

 
15.2 Long-term Losses 

Tendon Span Left Center Right 

    ksi ksi ksi 

TENDON_A 1 7.92 10.17 10.97 

TENDON_A 2 10.90 11.20 10.89 

TENDON_A 3 10.95 10.45 8.77 

TENDON_A CR 9.26 7.65 7.30 

TENDON_B 1 7.73 10.17 10.85 

TENDON_B 2 10.86 0.00 0.00 

TENDON_B 3 0.00 0.00 0.00 

TENDON_B CR 0.00 0.00 0.00 

TENDON_C 1 0.00 0.00 0.00 

TENDON_C 2 0.00 0.00 10.84 

TENDON_C 3 10.95 10.45 8.77 

TENDON_C CR 9.26 7.65 7.30 

 
15.3 Calculated Stresses After Friction and Long-term Losses 

Tendon Span Stress Left   
FL Only 

Stress Center   
FL Only 

Stress Right   
FL Only 

Stress Left 
FL+LTL 

Stress Center 
FL+LTL 

Stress Right 
FL+LTL 

    ksi ksi ksi ksi ksi ksi 

TENDON_A 1 178.42 183.36 190.47 170.44 173.20 179.44 

TENDON_A 2 190.47 197.01 190.91 179.58 185.83 180.02 

TENDON_A 3 190.91 184.38 175.52 180.02 173.92 166.95 

TENDON_A CR 175.52 173.78 172.18 166.23 166.08 164.78 

TENDON_B 1 177.12 182.05 189.17 169.42 171.89 178.28 

TENDON_B 2 189.17 0.00 0.00 178.42 0.00 0.00 

TENDON_B 3 0.00 0.00 0.00 0.00 0.00 0.00 

TENDON_B CR 0.00 0.00 0.00 0.00 0.00 0.00 

TENDON_C 1 0.00 0.00 0.00 0.00 0.00 0.00 

TENDON_C 2 0.00 0.00 191.05 0.00 0.00 180.17 

TENDON_C 3 191.05 184.38 175.52 180.17 173.92 166.95 

TENDON_C CR 175.52 173.78 172.18 166.23 166.08 164.78 

 
15.6 Summary 

Tendon Force Ext. 
Left 

Start 
Span 

End 
Span 

Ext. 
Right 

Elong. Left Elong Right Anchor 
Left 

Anchor 
Right 

Max 
Stress 
ratio 

  k         in in       

TENDON_A 28.15 0.00 1 CR 0.00 5.65 -0.01 0.66 0.64 0.73 

TENDON_B 28.13 0.00 1 1 0.20 1.88 0.00 0.66 0.71 0.71 

TENDON_C 27.58 0.20 3 CR 0.00 0.00 2.43 0.72 0.64 0.72 
 

Type C 
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8.3.5 Detailed Report 

The detailed report consists of listing of values at 1/20th points along 

each span. As an example, the following tables illustrate partial listings 

of those results available in the Detailed Report settings. Selected 

detailed results of the analysis and design at 1/20th points along each 

span may be included in the comprehensive output using the report 

setup dialog box. Detailed output for a portion of the results are 

available after completion of the run.  The remainder of the detailed 

results are available after execution of the analysis and design post-

processors. All the detailed output files are written to separate data files 

with the .DAT extension and located in the model files location.  These 

files may be accessed by the user.   

8.3.5.1 Section 21: Tendon Heights (PT mode only) 

The detailed tendon height output reports the height of the 

centroid of each tendon type at 1/20th points along each 

span. The data is stored in the PTCGS.DAT file. 

X/L X CGS A CGS B CGS C 

  ft in in in 

  SPAN 1       

0.00 0.000 18.42 18.42 18.42 

0.05 1.425 17.81 17.81 17.81 

0.10 2.850 15.99 15.99 15.99 

0.15 4.275 13.71 13.71 13.71 

0.20 5.700 11.73 11.73 11.73 

0.25 7.125 10.05 10.05 10.05 

0.30 8.550 8.68 8.68 8.68 

0.35 9.975 7.62 7.62 7.62 

0.40 11.400 6.86 6.86 6.86 

0.45 12.825 6.40 6.40 6.40 

0.50 14.250 6.25 6.25 6.25 

0.55 15.675 6.45 6.45 6.45 

0.60 17.100 7.04 7.04 7.04 

0.65 18.525 8.02 8.02 8.02 

0.70 19.950 9.40 9.40 9.40 

0.75 21.375 11.17 11.17 11.17 

0.80 22.800 13.34 13.34 13.34 

0.85 24.225 15.90 15.90 15.90 

0.90 25.650 18.85 18.85 18.85 

0.95 27.075 21.21 21.21 21.21 

1.00 28.500 22.00 22.00 22.00 

8.3.5.2 Section 22: Post-tensioning Balanced Loading (PT mode only) 
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This option lists the equivalent loading (balanced loads) 

generated to substitute the post-tensioning obtained in 

ADAPT’s final design. These loads can be used as an applied 

loading in an independent general frame program to verify 

the accuracy of ADAPT post-tensioning solutions. 

Span Type W F M a b 

    k/ft k k-ft ft ft 

1 3 13.928     0.00 2.85 

1 3 18.021     25.65 28.50 

1 3 -3.482     2.85 14.25 

1 3 -4.505     14.25 25.65 

2 3 15.158     0.00 3.50 

2 3 15.158     31.50 35.00 

2 3 -3.789     3.50 17.50 

2 3 -3.789     17.50 31.50 

3 3 15.158     0.00 3.50 

3 3 15.158     31.50 35.00 

3 3 -3.789     3.50 17.50 

3 3 -3.789     17.50 31.50 

4 3 18.021     0.00 2.85 

4 3 13.928     25.65 28.50 

4 3 -4.505     2.85 14.25 

4 3 -3.482     14.25 25.65 

1 4     -0.26 28.50   

4 4     0.26 0.00   

2 4     -50.77 15.00   

2 4     50.77 20.00   

3 4     -50.77 15.00   

3 4     50.77 20.00   

8.3.5.3 Section 23: Detailed Moments 

This section reports moments for all load cases and enveloped 

(max/min) results when skip loading is active at 1/20th points 

along each span.   

SPAN 1 

X/L X SW SDL XL LL Min LL Max PT Secondary 

  ft k-ft k-ft k-ft k-ft k-ft k-ft k-ft 

0.00 0.00 -89.64 -19.08 0.00 -223.87 33.04 133.05 133.08 

0.05 1.43 -56.29 -12.01 0.00 -147.19 27.12 119.88 134.06 

0.10 2.85 -26.79 -5.74 0.00 -78.64 21.20 78.44 135.04 

0.15 4.28 -1.12 -0.29 0.00 -18.21 15.28 26.39 136.01 

0.20 5.70 20.71 4.35 0.00 8.34 44.42 -18.60 136.99 

0.25 7.12 38.70 8.17 0.00 3.07 82.08 -56.51 137.97 

0.30 8.55 52.85 11.19 0.00 -2.47 114.35 -87.35 138.95 

0.35 9.98 63.16 13.39 0.00 -8.39 142.29 -111.12 139.92 

0.40 11.40 69.63 14.78 0.00 -14.31 162.11 -127.82 140.90 

0.45 12.83 72.26 15.36 0.00 -20.22 173.81 -137.45 141.88 

0.50 14.25 71.05 15.12 0.00 -26.14 177.38 -140.01 142.85 

0.55 15.68 66.00 14.08 0.00 -32.06 172.83 -134.45 143.83 

0.60 17.10 57.10 12.22 0.00 -37.98 160.16 -119.75 144.81 

0.65 18.53 44.37 9.55 0.00 -43.90 139.37 -95.91 145.78 
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0.70 19.95 27.80 6.06 0.00 -49.81 110.45 -62.91 146.76 

0.75 21.38 7.39 1.77 0.00 -55.73 73.41 -20.77 147.74 

0.80 22.80 -16.86 -3.34 0.00 -61.65 28.25 30.53 148.72 

0.85 24.23 -44.95 -9.26 0.00 -99.45 -25.03 90.97 149.69 

0.90 25.65 -76.88 -15.99 0.00 -167.37 -65.45 160.56 150.67 

0.95 27.08 -112.65 -23.54 0.00 -243.42 -70.72 216.42 151.65 

1.00 28.50 -152.26 -31.89 0.00 -327.59 -75.99 235.70 152.62 

8.3.5.4 Section 24: Detailed Shears 

This section reports shears for all load cases and enveloped 

(max/min) results when skip loading is active at 1/20th points 

along each span.   

SPAN 1 

X/L X SW SDL XL LL Min LL Max PT Secondary 

  ft k k k k k k k 

0.00 0.00 -24.75 -5.25 0.00 4.15 -56.66 -0.68 -0.69 

0.05 1.43 -22.06 -4.68 0.00 4.15 -50.96 19.17 -0.69 

0.10 2.85 -19.36 -4.11 0.00 4.15 -45.26 39.02 -0.69 

0.15 4.28 -16.67 -3.54 0.00 4.15 -39.56 34.06 -0.69 

0.20 5.70 -13.97 -2.97 0.00 4.15 -33.86 29.09 -0.69 

0.25 7.12 -11.28 -2.40 0.00 4.15 -28.16 24.13 -0.69 

0.30 8.55 -8.58 -1.83 0.00 4.15 -22.46 19.17 -0.69 

0.35 9.98 -5.89 -1.26 0.00 4.15 -16.76 14.21 -0.69 

0.40 11.40 -3.19 -0.69 0.00 4.15 -11.06 9.25 -0.69 

0.45 12.83 -0.50 -0.12 0.00 4.15 -5.36 4.29 -0.69 

0.50 14.25 2.20 0.45 0.00 4.92 0.00 -0.68 -0.69 

0.55 15.68 4.89 1.02 0.00 10.62 0.00 -7.10 -0.69 

0.60 17.10 7.59 1.59 0.00 16.32 0.00 -13.52 -0.69 

0.65 18.53 10.28 2.16 0.00 22.02 0.00 -19.94 -0.69 

0.70 19.95 12.98 2.73 0.00 27.72 0.00 -26.36 -0.69 

0.75 21.38 15.67 3.30 0.00 33.42 0.00 -32.78 -0.69 

0.80 22.80 18.37 3.87 0.00 39.12 0.00 -39.20 -0.69 

0.85 24.23 21.06 4.44 0.00 44.82 0.00 -45.62 -0.69 

0.90 25.65 23.75 5.01 0.00 50.52 0.00 -52.03 -0.69 

0.95 27.08 26.45 5.58 0.00 56.22 0.00 -26.36 -0.69 

1.00 28.50 29.14 6.15 0.00 61.92 0.00 -0.68 -0.69 

8.3.5.5 Section 25: Factored Moments and Reactions 

This section reports factored design moments for Strength 

load combinations. The envelope of factored moments is 

shown in Section 8. 

                 Load Combination: 1.20SW + 1.60LL + 1.20SDL + 1.60XL + 1.00SEC 
 
                 Factored Design Moments (Not Redistributed) 

Span Left        Left            Middle       Middle    Right      Right       
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Max Min Max Min Max Min 

  k-ft k-ft k-ft k-ft k-ft k-ft 

1 -213.43 88.63 530.06 204.43 -434.73 -136.36 

2 -503.88 -58.81 627.93 242.08 -523.01 -87.22 

3 -523.02 -87.22 627.93 242.09 -503.83 -58.90 

4 -434.73 -136.35 530.05 204.43 -213.44 88.62 

 
                 Reactions and Column Moments 

Joint Reaction 
Max 

Reaction 
Min 

Moment 
Lower 

Column Max 

Moment 
Lower 

Column Min 

Moment 
Upper 

Column Max 

Moment 
Upper 

Column Min 

  k k k-ft k-ft k-ft k-ft 

1 127.34 30.04 55.45 -355.55 0.00 0.00 

2 293.00 177.48 333.93 -375.53 0.00 0.00 

3 305.55 189.47 412.80 -412.80 0.00 0.00 

4 292.99 177.47 375.54 -333.93 0.00 0.00 

5 127.34 30.04 355.55 -55.44 0.00 0.00 

 
Factored Design Moments (Redistributed) 

Span Left        
Max 

Left         
Min 

   Middle    
Max 

   Middle    
Min 

Right      
Max 

Right       
Min 

Redist. 
Coef. Left 

Redist. 
Coef Right 

  k-ft k-ft k-ft k-ft k-ft k-ft     

1 -216.34 90.13 543.04 196.91 -457.58 -123.20 0.00 -4.38 

2 -458.36 -65.47 635.81 295.13 -477.58 -78.85 9.94 9.58 

3 -477.58 -78.85 635.81 295.13 -458.25 -65.47 9.59 9.94 

4 -457.47 -123.19 542.94 196.87 -216.35 90.12 -4.35 0.00 

 

8.3.5.6 Section 26: Factored Lateral Moments 

This section reports factored design moments for lateral load 

combinations. The envelope of factored moments is shown in 

Section 9. 

                 Load Combination: 1.20 SW +1.00 LL +1.20 SDL +1.00 XL +1.00 LAT 
 
                 Factored Lateral Moments (Not Redistributed) 

Span Left        
Max 

Left         
Min 

   Middle    
Max 

   Middle    
Min 

Right      
Max 

Right       
Min 

  k-ft k-ft k-ft k-ft k-ft k-ft 

1 +99.26 -89.52 +423.70 +220.16 -307.43 -120.94 

2 -278.60 -0.44 +506.92 +265.77 -374.08 -101.71 

3 -290.08 -17.70 +506.92 +265.77 -362.54 -84.45 

4 -252.34 -65.84 +423.60 +220.06 -144.63 +44.15 

 
Factored Lateral Moments (Redistributed) 

Span Left        
Max 

Left         
Min 

   Middle    
Max 

   Middle    
Min 

Right      
Max 

Right       
Min 

Redist. 
Coef. Left 

Redist. 
Coef Right 

  k-ft k-ft k-ft k-ft k-ft k-ft     

1 100.80 -89.02 434.67 239.48 -277.68 -109.24 0.00 11.02 

2 -275.06 -0.11 517.65 291.89 -337.23 -91.74 1.82 11.07 

3 -322.97 -19.47 515.72 272.48 -328.07 -76.23 -11.07 11.07 

4 -281.80 -73.53 424.18 208.22 -147.23 44.29 -11.02 0.00 
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8.3.5.7 Section 27: Detailed Stresses (PT mode only) 

This section reports top and bottom fiber stresses for 

individual load cases.  When skip loading is active, stresses 

due to live load are enveloped.   Initial and Service 

combination results are also reported with enveloped results 

provided when skip loading is active. 

 
SPAN 1 

X/L X SW   
Top 

SW   
Bot 

SDL 
Top 

SDL 
Bot 

XL   
Top 

XL    
Bot 

LL Top 
Max-T 

LL Top 
Max-C 

LL Bot 
Max-T 

LL Bot 
Max-C 

PT   
Top 

PT   
Bot 

  ft psi psi psi psi psi psi psi psi psi psi psi psi 

0.00 0.00                         

0.05 1.43 126. -241. 27. -51. 0. 0. 329. -61. 116. -629. -421. 359. 

0.10 2.85 60. -114. 13. -25. 0. 0. 176. -47. 91. -336. -329. 182. 

0.15 4.28 2. -5. 1. -1. 0. 0. 41. -34. 65. -78. -212. -41. 

0.20 5.70 -46. 88. -10. 19. 0. 0. -19. -99. 190. 36. -112. -233. 

0.25 7.12 -86. 165. -18. 35. 0. 0. -7. -183. 351. 13. -27. -395. 

0.30 8.55 -118. 226. -25. 48. 0. 0. 6. -255. 489. -11. 41. -527. 

0.35 9.98 -141. 270. -30. 57. 0. 0. 19. -318. 608. -36. 95. -628. 

0.40 11.40 -155. 297. -33. 63. 0. 0. 32. -362. 693. -61. 132. -700. 

0.45 12.83 -161. 309. -34. 66. 0. 0. 45. -388. 743. -86. 153. -741. 

0.50 14.25 -159. 304. -34. 65. 0. 0. 58. -396. 758. -112. 159. -752. 

0.55 15.68 -147. 282. -31. 60. 0. 0. 72. -386. 738. -137. 147. -728. 

0.60 17.10 -127. 244. -27. 52. 0. 0. 85. -358. 684. -162. 114. -665. 

0.65 18.53 -99. 190. -21. 41. 0. 0. 98. -311. 595. -188. 61. -563. 

0.70 19.95 -62. 119. -14. 26. 0. 0. 111. -247. 472. -213. -13. -422. 

0.75 21.38 -17. 32. -4. 8. 0. 0. 124. -164. 314. -238. -107. -242. 

0.80 22.80 38. -72. 7. -14. 0. 0. 138. -63. 121. -263. -222. -23. 

0.85 24.23 100. -192. 21. -40. 0. 0. 222. 56. -107. -425. -357. 235. 

0.90 25.65 172. -328. 36. -68. 0. 0. 374. 146. -280. -715. -512. 532. 

0.95 27.08 252. -481. 53. -101. 0. 0. 543. 158. -302. -1040. -637. 771. 

1.00 28.50                         

 

X/L X Initial 
Top 

Max-T 

Initial 
Top 

Max-C 

Initial 
Bot 

Max-T 

Initial 
Bot 

Max-C 

Env-1 
Top 

Max-T 

Env-1 
Top 

Max-C 

Env-1 
Bot 

Max-T 

Env-1 
Bot 

Max-C 

Env-2 
Top 

Max-T 

Env-2 
Top 

Max-C 

Env-2 
Bot 

Max-T 

Env-2 
Bot 

Max-C 

  ft psi psi psi psi psi psi psi psi psi psi psi psi 

0.00 0.00                         

0.05 1.43 ----- -359. 172. ----- ----- -287. 102. -122. 60. -329. 183. -562. 

0.10 2.85 ----- -318. 94. ----- ----- -270. 70. -58. ----- -303. 133. -293. 

0.15 4.28 ----- -242. ----- -52. ----- -220. ----- -70. ----- -243. 18. -125. 

0.20 5.70 ----- -175. ----- -179. ----- -198. ----- -115. ----- -267. 64. -90. 

0.25 7.12 ----- -118. ----- -289. ----- -187. ----- -191. ----- -315. 156. -182. 

0.30 8.55 ----- -70. ----- -380. ----- -178. ----- -256. ----- -357. 235. -264. 

0.35 9.98 ----- -32. ----- -453. ----- -172. ----- -312. ----- -394. 307. -337. 

0.40 11.40 ----- -4. ----- -507. ----- -165. ----- -357. ----- -419. 354. -400. 

0.45 12.83 15. ----- ----- -543. ----- -159. ----- -392. 3. -430. 376. -453. 

0.50 14.25 24. ----- ----- -561. ----- -152. ----- -417. 25. -429. 374. -495. 

0.55 15.68 21. ----- ----- -555. ----- -148. ----- -427. 39. -418. 353. -523. 

0.60 17.10 3. ----- ----- -521. ----- -148. ----- -418. 44. -399. 315. -531. 

0.65 18.53 ----- -29. ----- -458. ----- -153. ----- -389. 38. -371. 263. -521. 
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0.70 19.95 ----- -77. ----- -367. ----- -163. ----- -342. 22. -335. 194. -491. 

0.75 21.38 ----- -140. ----- -247. ----- -177. ----- -275. ----- -292. 110. -441. 

0.80 22.80 ----- -217. ----- -99. ----- -196. ----- -188. ----- -240. 11. -373. 

0.85 24.23 ----- -310. 78. ----- ----- -219. ----- -124. ----- -180. ----- -421. 

0.90 25.65 ----- -417. 284. ----- ----- -261. 52. -79. 69. -159. ----- -579. 

0.95 27.08 ----- -481. 405. ----- ----- -285. 99. -123. 211. -175. ----- -851. 

1.00 28.50                         

 

8.3.5.8 Section 28: Required Post-tensioning (PT mode only) 

The post-tensioning force required from allowable tensile 

stress input at 1/20th point along each span is calculated and 

listed in this table. 

X/L X PT X PT X PT X PT 

  ft k ft k ft k ft k 

  SPAN 1   SPAN 2   SPAN 3   SPAN 4   

0.00 0.00 --- 0.00 --- 0.00 --- 0.00 --- 

0.05 1.43 65.37 1.75 186.67 1.75 198.09 1.43 203.66 

0.10 2.85 0.00 3.50 67.40 3.50 86.19 2.85 108.17 

0.15 4.28 0.00 5.25 0.00 5.25 0.00 4.28 0.00 

0.20 5.70 0.00 7.00 0.00 7.00 0.00 5.70 0.00 

0.25 7.12 119.02 8.75 112.63 8.75 117.32 7.12 0.00 

0.30 8.55 201.03 10.50 202.98 10.50 211.79 8.55 154.64 

0.35 9.98 245.22 12.25 239.31 12.25 245.26 9.98 219.48 

0.40 11.40 267.33 14.00 251.29 14.00 254.83 11.40 250.67 

0.45 12.82 276.46 15.75 276.57 15.75 278.53 12.82 267.38 

0.50 14.25 275.81 17.50 275.71 17.50 275.71 14.25 275.80 

0.55 15.68 267.37 19.25 278.53 19.25 276.56 15.68 276.46 

0.60 17.10 250.68 21.00 254.83 21.00 251.30 17.10 267.33 

0.65 18.52 219.49 22.75 245.27 22.75 239.35 18.52 245.23 

0.70 19.95 154.63 24.50 211.83 24.50 203.02 19.95 201.02 

0.75 21.38 0.00 26.25 117.42 26.25 112.72 21.38 119.00 

0.80 22.80 0.00 28.00 0.00 28.00 0.00 22.80 0.00 

0.85 24.23 0.00 29.75 0.00 29.75 0.00 24.23 0.00 

0.90 25.65 108.18 31.50 86.15 31.50 67.35 25.65 0.00 

0.95 27.08 203.68 33.25 198.07 33.25 186.63 27.08 65.40 

1.00 28.50 --- 35.00 --- 35.00 --- 28.50 --- 

 

8.3.5.9 Section 29: Detailed Rebar 

The rebar required at 1/20th point along each span is listed in 

this table.  “Analysis” refers to rebar required for Strength 

(ultimate) conditions, including the UBC special load 

combination when applied to the model.  “Minimum” refers 

to reinforcement required for Service and Initial conditions. 

The selected reinforcement is the enveloped amount from the 

Analysis and Minimum conditions.    
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SPAN 1 

X/L X Analysis 
Top 

Analysis  
Bot 

Minimum 
Top 

Minimum 
Bot 

Selected 
Top 

Selected  
Bot 

  ft in2 in2 in2 in2 in2 in2 

0.04 1.16 0.00 0.00 2.23 0.48 2.23 0.48 

0.05 1.42 0.00 0.00 2.23 0.49 2.23 0.49 

0.10 2.85 0.00 0.00 2.23 0.00 2.23 0.00 

0.15 4.27 0.00 0.00 2.23 0.00 2.23 0.00 

0.20 5.70 0.00 0.00 0.00 0.00 0.00 0.00 

0.25 7.13 0.00 0.00 0.00 0.00 0.00 0.00 

0.30 8.55 0.00 0.25 0.00 0.00 0.00 0.25 

0.35 9.97 0.00 0.55 0.00 1.38 0.00 1.38 

0.40 11.40 0.00 0.75 0.00 1.38 0.00 1.38 

0.45 12.82 0.00 0.89 0.00 1.38 0.00 1.38 

0.50 14.25 0.00 0.88 0.00 1.38 0.00 1.38 

0.55 15.68 0.00 0.80 0.00 1.38 0.00 1.38 

0.60 17.10 0.00 0.61 0.00 1.38 0.00 1.38 

0.65 18.52 0.00 0.43 0.00 1.38 0.00 1.38 

0.70 19.95 0.00 0.16 0.00 0.00 0.00 0.16 

0.75 21.37 0.00 0.00 0.00 0.00 0.00 0.00 

0.80 22.80 0.00 0.00 0.00 0.00 0.00 0.00 

0.85 24.23 0.00 0.00 2.23 0.00 2.23 0.00 

0.90 25.65 0.00 0.00 2.23 1.01 2.23 1.01 

0.95 27.07 0.00 0.00 2.23 1.63 2.23 1.63 

0.96 27.34 0.03 0.00 2.23 1.64 2.23 1.64 

8.3.5.10 Section 30: Punching Shear Reinforcement 

 
Reinforcement option: Stud 

Stud diameter: 0.38 

Number of rails per side: 1 

Column - 2 

Layer Cond. a d b1 b2 Vu Mu Stress Allow. Ratio As NStuds Dist. 

    in in in in k k-ft ksi ksi   in2   in 

1 2 17.19 34.38 35.19 46.37 -250.14 -1.15 0.082 0.215 0.38 0.00 0 0.00 

2 2 17.19 34.38 295.23 82.37 -250.14 -1.15 0.025 0.145 0.17 0.00 0 0.00 

 
Dist. = Distance between shear studs between layers 

 
Note: Columns with --- have not been checked for punching shear. 
Note: Columns with *** have exceeded the maximum allowable shear stress. 
 
Legend (30): 

 Layer  : The layer of the reinforcement for each column 
 Cond.  : 1 = Interior  2 = End  3 = Edge  4 = Corner   
 a  : The distance between the layer and face of column or drop cap (d/2) 
 d  : Effective depth  
 b1  : length of section parallel to span line  
 b2  : length of section normal to span line  
 Vu  : Factored shear  
 Mu  : Factored moment  
 Stress                  : Maximum stress 
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 Allow   : Allowable stress 
 Ratio   : Ratio of calculated to allowable stress 
 As  : Required area of reinforcement 

 Nstud                   : Number of shear studs between layers on each rail  

 Dist                      : Distance between stud layers along each rail 

8.3.5.11 Section 32: Detailed Friction and Long-Term Stress Losses (PT 

mode only) 

This report is available when the Tendon Selection method is 

used as the calculation method.  At 1/20th point along each 

span, the initial stress (stress at force transfer), long-term 

losses and final stresses for the tendons are reported.  

X/L X Initial 
Stress 

Longterm 
Loss 

Final 
Stress 

X Initial 
Stress 

Longterm 
Loss 

Final 
Stress 

  ft ksi ksi ksi ft ksi ksi ksi 

  SPAN  1       SPAN  2       

0.00 0.00 64.18 8.76 55.41 0.00 48.21 8.76 39.46 

0.05 1.43 63.75 8.76 54.98 1.75 46.43 8.76 37.66 

0.10 2.85 62.25 8.76 53.50 3.50 45.31 8.76 36.56 

0.15 4.28 61.44 8.76 52.67 5.25 44.35 8.76 35.60 

0.20 5.70 60.74 8.76 51.99 7.00 43.55 8.76 34.80 

0.25 7.13 60.06 8.76 51.31 8.75 42.77 8.76 34.00 

0.30 8.55 59.38 8.76 50.61 10.50 41.96 8.76 33.20 

0.35 9.97 58.70 8.76 49.93 12.25 41.17 8.76 32.42 

0.40 11.40 58.01 8.76 49.24 14.00 40.39 8.76 31.63 

0.45 12.82 57.35 8.76 48.58 15.75 39.60 8.76 30.84 

0.50 14.25 56.66 8.76 47.89 17.50 38.82 8.76 30.07 

0.55 15.68 55.95 8.76 47.18 19.25 38.04 8.76 29.28 

0.60 17.10 55.20 8.76 46.44 21.00 37.27 8.76 28.50 

0.65 18.52 54.46 8.76 45.70 22.75 36.50 8.76 27.73 

0.70 19.95 53.72 8.76 44.95 24.50 35.71 8.76 26.96 

0.75 21.38 52.98 8.76 44.22 26.25 34.96 8.76 26.20 

0.80 22.80 52.23 8.76 43.48 28.00 34.19 8.76 25.44 

0.85 24.23 51.51 8.76 42.74 29.75 33.43 8.76 24.67 

0.90 25.65 50.78 8.76 42.01 31.50 32.68 8.76 23.93 

0.95 27.08 49.90 8.76 41.13 33.25 31.78 8.76 23.03 

1.00 28.50 48.21 8.76 39.46 35.00 30.14 8.76 21.38 

8.3.5.12 Section 32: Unbalanced Moment Reinforcement 

• 32.1 Unbalanced Moment Reinforcement - No 

Redistribution. This table shows unbalanced moments 

for Strength load  combinations when redistribution is 

not applied.   

Load Combination:   STRENGTH_1_Max_LL 
Joint Gamma 

Left 
Gamma 

Right 
Width 
Left 

Width 
Right 

Moment Left Moment 
Right 

As Top As Bot n Bar 
Top 

n Bar 
Bot 

      ft ft k-ft k-ft in2 in2     

1 0.00 0.78 0.00 27.00 0.00 22.49 0.00 0.00 0 0 

2 0.59 0.59 10.00 10.00 -5.94 0.00 0.00 0.00 0 0 

3 0.59 0.59 10.00 10.00 -0.94 0.00 0.00 0.00 0 0 
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• 32.2 Unbalanced Moment Reinforcement – 

Redistributed. This table shows unbalanced moments 

for Strength load combinations when redistribution is 

applied.  

Load Combination:   STRENGTH_2_Max_LL_Pos_Lat 
Joint Gamma 

Left 
Gamma 

Right 
Width 
Left 

Width 
Right 

Moment Left Moment 
Right 

As Top As Bot n Bar 
Top 

n Bar 
Bot 

      ft ft k-ft k-ft in2 in2     

1 0.00 0.78 0.00 27.00 0.00 105.65 0.00 0.00 0 0 

2 0.59 0.59 10.00 10.00 -194.82 0.00 0.00 0.00 0 0 

3 0.59 0.59 10.00 10.00 -186.15 0.00 0.00 0.00 0 0 

8.3.5.13 Section 34: Demand Moment and Moment Capacity 

This data block lists the demand moment and the moment 

capacity for the 1/20th points along each span based on the 

user selection in the Design settings input screen. Columns 7 

and 8 of this table list the ratio of the demand over capacity 

for both positive and negative moments.  The demand 

moment is the worst-case moment for all Strength 

combinations.   

• 34.1 Based on User Entered Values.  The capacity listed 

in this section is calculated with respect to base (user-

defined) reinforcement and PT.  

SPAN 1 

X/L X Demand 
Moment Pos 

Demand 
Moment Neg 

Moment 
Capacity Pos 

Moment 
Capacity Neg 

Demand/Cap
acity Pos 

Demand/Cap
acity Neg 

  ft k-ft k-ft k-ft k-ft     

0.00 0.00 100.15 -215.35 171.36 -585.08 0.58 0.37 

0.04 1.16 100.70 -216.14 184.77 -572.90 0.55 0.38 

0.05 1.42 107.89 -186.00 188.82 -570.62 0.57 0.33 

0.10 2.85 143.78 -32.06 183.12 -519.05 0.79 0.06 

0.15 4.28 174.15 0.00 245.74 -464.68 0.71 0.00 

0.20 5.70 243.33 0.00 296.22 -224.36 0.82 0.00 

0.25 7.12 332.31 0.00 344.59 -185.40 0.96 0.00 

0.30 8.55 406.78 0.00 410.58 -155.31 0.99 0.00 

0.35 9.97 468.90 0.00 559.64 -135.17 0.84 0.00 

0.40 11.40 512.15 0.00 585.06 -117.75 0.88 0.00 

0.45 12.83 536.70 0.00 596.54 -107.29 0.90 0.00 

0.50 14.25 542.52 0.00 602.65 -104.00 0.90 0.00 

0.55 15.68 529.39 0.00 595.42 -108.31 0.89 0.00 

0.60 17.10 497.78 0.00 578.33 -121.87 0.86 0.00 

0.65 18.52 447.32 0.00 547.56 -144.49 0.82 0.00 

0.70 19.95 377.99 0.00 380.25 -171.14 0.99 0.00 

0.75 21.38 290.02 0.00 312.04 -211.49 0.93 0.00 

0.80 22.80 183.33 0.00 252.77 -262.37 0.73 0.00 

0.85 24.22 81.19 -91.48 185.56 -516.83 0.44 0.18 

0.90 25.65 44.10 -247.94 216.28 -602.64 0.20 0.41 

0.95 27.07 2.62 -423.21 221.17 -666.89 0.01 0.63 

0.96 27.34 0.00 -457.14 220.25 -670.85 0.00 0.68 

1.00 28.50 0.00 -457.93 204.08 -686.51 0.00 0.67 
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• 34.2 Based on Designed Values. The capacity listed in 

this section is calculated with respect to base (user-

defined) reinforcement, PT, and program-calculated 

reinforcement.   

8.3.5.14 Section 35: Detailed Deflections  

This data block lists sustained and total deflections at 1/20th 

points for Service combinations.  Examples of how Sustained 

and Total deflection values in Columns 9 and 10 are calculated 

are described in detail in Section 8.3.4.14 of this manual.    

35.1 - Detailed Deflections - Service Combination 1 
 
SPAN 1 

X/L X SW SW+PT SW+PT+SD
L 

SW+PT+SD
L+Creep 

LL XL Sustained Total 

  ft in in in in in in in in 

0.00 0.0 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 

0.05 1.4 0.005 -0.002 -0.001 -0.004 0.012 0.000 0.006 0.014 

0.10 2.8 0.011 -0.006 -0.004 -0.012 0.027 0.000 -0.016 0.031 

0.15 4.2 0.017 -0.011 -0.007 -0.022 0.043 0.000 -0.028 0.047 

0.20 5.7 0.024 -0.016 -0.011 -0.034 0.060 0.000 -0.043 0.062 

0.25 7.1 0.030 -0.022 -0.016 -0.047 0.077 0.000 -0.059 0.076 

0.30 8.5 0.035 -0.027 -0.019 -0.058 0.091 0.000 -0.073 0.088 

0.35 9.9 0.039 -0.031 -0.023 -0.069 -0.020 0.000 -0.087 -0.101 

0.40 11.4 0.042 -0.034 -0.026 -0.077 -0.023 0.000 -0.098 -0.114 

0.45 12.8 0.043 -0.036 -0.027 -0.082 -0.026 0.000 -0.106 -0.124 

0.50 14.2 0.043 -0.037 -0.028 -0.084 -0.029 0.000 -0.110 -0.130 

0.55 15.6 0.041 -0.036 -0.027 -0.082 -0.031 0.000 -0.110 -0.131 

0.60 17.1 0.037 -0.034 -0.026 -0.077 -0.032 0.000 -0.106 -0.128 

0.65 18.5 0.033 -0.030 -0.023 -0.069 -0.032 0.000 -0.098 -0.120 

0.70 19.9 0.027 -0.025 -0.019 -0.058 -0.031 0.000 -0.086 -0.108 

0.75 21.3 0.021 -0.019 -0.015 -0.045 -0.030 0.000 -0.071 -0.092 

0.80 22.8 0.015 -0.014 -0.010 -0.031 -0.027 0.000 -0.055 -0.074 

0.85 24.2 0.009 -0.008 -0.006 -0.018 -0.022 0.000 -0.038 -0.054 

0.90 25.6 0.004 -0.003 -0.003 -0.008 -0.017 0.000 -0.023 -0.034 

0.95 27.0 0.001 -0.001 0.000 -0.001 0.011 0.000 -0.010 0.016 

1.00 28.5 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 

8.3.5.15 Section 36: Detailed Deflections Live Load 

This data block deflections at 1/20th points for live load skip 

patterns when applied to a model.  The Max and Min values 

are reported along with Creep Max and Creep Min. 

deflections.  The creep deflections are those used to 

determined sustained and total long-term deflections.  The 
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Creep Max and Creep Min deflections are calculated as 

follows: 

Example – Span 1 @ X/L 0.50 for SC1: 

Creep Max = LL Max*0.3*(K+1)  

          = 0.120”*0.3*3 = 0.108” 

Creep Min = LL Min*0.3*(K+1) 

         = -0.029”*0.3*3 = -0.026” 

The Creep factor (K) is user-defined in the material 

assignment input and the factor of 0.3 is that defined in the 

Sustained Load combination.  

Note that for Service Total Load combinations 3 and 4, the 

Creep Max and Creep Min values are reported and calculated 

as zero (0). For these combinations, long-term effects due to 

live load are not considered.   

36.1 - Detailed Deflections Live Load - Service Combination 1 
 
SPAN 1 

X/L X LL1 LL2 LL3 LL4 LL5 LL6 LL Max LL Min Creep 
Max 

Creep 
Min 

  ft in in in in in in in in in in 

0.00 0.0 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 

0.05 1.4 0.010 -0.002 0.012 0.012 0.010 -0.002 0.012 -0.002 0.010 -0.002 

0.10 2.8 0.022 -0.004 0.027 0.026 0.022 -0.004 0.027 -0.004 0.024 -0.004 

0.15 4.2 0.036 -0.007 0.043 0.043 0.036 -0.006 0.043 -0.007 0.039 -0.006 

0.20 5.7 0.050 -0.010 0.060 0.060 0.049 -0.009 0.060 -0.010 0.054 -0.009 

0.25 7.1 0.063 -0.013 0.077 0.077 0.062 -0.012 0.077 -0.013 0.069 -0.012 

0.30 8.5 0.074 -0.017 0.091 0.091 0.073 -0.015 0.091 -0.017 0.082 -0.015 

0.35 9.9 0.083 -0.020 0.103 0.103 0.081 -0.018 0.103 -0.020 0.093 -0.018 

0.40 11.4 0.089 -0.023 0.113 0.112 0.087 -0.021 0.113 -0.023 0.101 -0.021 

0.45 12.8 0.092 -0.026 0.118 0.118 0.089 -0.023 0.118 -0.026 0.106 -0.024 

0.50 14.2 0.091 -0.029 0.120 0.120 0.088 -0.026 0.120 -0.029 0.108 -0.026 

0.55 15.6 0.087 -0.031 0.118 0.118 0.084 -0.027 0.118 -0.031 0.106 -0.028 

0.60 17.1 0.080 -0.032 0.112 0.112 0.077 -0.028 0.112 -0.032 0.101 -0.029 

0.65 18.5 0.070 -0.032 0.102 0.102 0.067 -0.029 0.102 -0.032 0.092 -0.029 

0.70 19.9 0.059 -0.031 0.090 0.090 0.055 -0.028 0.090 -0.031 0.081 -0.028 

0.75 21.3 0.046 -0.030 0.075 0.075 0.043 -0.026 0.075 -0.030 0.068 -0.027 

0.80 22.8 0.032 -0.027 0.059 0.059 0.029 -0.024 0.059 -0.027 0.053 -0.024 

0.85 24.2 0.019 -0.022 0.042 0.042 0.017 -0.020 0.042 -0.022 0.038 -0.020 

0.90 25.6 0.009 -0.017 0.025 0.025 0.007 -0.015 0.025 -0.017 0.023 -0.015 

0.95 27.0 0.002 -0.009 0.011 0.011 0.001 -0.008 0.011 -0.009 0.010 -0.008 

1.00 28.5 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000 
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8.3.6 Graphical Report  

The graphical display includes print-plots of critical graphical 

information, such as moments, deflections, stresses, post-tensioning, 

and reinforcement. 

8.3.6.1 PT Force 
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8.3.6.2 PT-Profile 
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8.3.6.3 Deflection 
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8.3.6.4 Load Cases 

LOAD CASE: Super Imposed Dead Load 
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8.3.6.5 Load Combination 

LOAD COMBINATION: SERVICE_1_Max_LL 
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(Tension stress positive) 
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